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DISCLAIMER 1

1. Disclaimer

The information in this document is subject to change without notice and does not represent a
commitment on the part of Native Instruments GmbH. The software described by this document is
subject to a License Agreement and may not be copied to other media. No part of this publication
may be copied, reproduced or otherwise transmitted or recorded, for any purpose, without prior
written permission by Native Instruments GmbH, hereinafter referred to as Native Instruments.

n o

“Native Instruments”, “NI” and associated logos are (registered) trademarks of Native Instruments
GmbH.

All other trademarks are the property of their respective owners and use of them does not imply
any affiliation with or endorsement by them.

Document authored by Nicolas Sidi, Jonas Korwer, Jan Ola Korte, Hannah Lockwood, Mario
KruSelj, Elpiniki Pappa, Nikolas Jeroma, Dinos Vallianatos, Adam Hanley, Jan Morgenstern

Software version: 8.6 (08/2025)
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2. Welcome to Kontakt Player

Imagine any sound — Kontakt Player lets you find it, create it, and transform it. Our instrument
platform combines intelligent tools with countless sound design options, redefining how you
generate ideas and make music.

Kontakt Player hosts the world's largest range of virtual instruments. With thousands of libraries,
it's the gateway to quality sound from Native Instruments, our official partners, and scores of indie
developers.

Leap is an fast and playful way to play and manipulate loops. Spark fresh ideas, add expressive
performance effects, or just jam. Use your sample collection or try something new with our Leap
Expansions.

Get started by learning more about Kontakt Player, how to install and setup the software, and all of
its features, starting with the overview.

We hope you enjoy Kontakt Player!
KONITAKT Player FILE LIBRARY VIEW

o

P Autumn Walk
=

Instruments Combined Tools

hytha

All Banks v

© O Oem

Vibrato A/B Sound Cutoff Glide Play Mode

o WO ARR R BRALRA




WELCOME TO KONTAKT PLAYER

Document conventions

In this document the following formatting is used to highlight useful information:

Italics Indicates paths to locations on your hard disk or other storage devices.
Bold Highlights important names, concepts, and software interface elements.
[Brackets] References keys on the computer keyboard.

> Denotes a single step instruction.

- Denotes the expected result when following instructions.

The following three icons denote special types of information:

':9:' The light bulb icon indicates a useful tip, suggestion, or interesting fact.

@ The information icon highlights essential information in a given context.

& The warning icon alerts you of potential risks and serious issues.
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3. About Kontakt Player

Kontakt Player is the free version of Kontakt, our industry-standard instrument platform for music
creators, giving you access to thousands of sound libraries. Kontakt Player hosts all of NI's Kontakt
libraries as well as licensed third-party products. On the Native Instruments website you can get
hundreds of officially licensed instruments from Native Instruments and other manufacturers.

':9:' Get started by adding Komplete Start to your collection, our free music production
bundle including Kontakt instruments, synths, effects, and hundreds of sounds.

Kontakt Player integrates seamlessly with popular DAWs and hardware controllers, and the
advanced integration with S-Series MK3 keyboards enhances your creative workflow with hands-
on control over your Kontakt instruments. Kontakt Player also features Leap, a sample playground
that lets you play and manipulate loops and one-shots to create exciting ideas and performances.

Kontakt Player focuses on browsing and playing instruments, while the full version of Kontakt gives
access to advanced features like Tools, a suite of MIDI effects for generating chords and phrases
in real time. Furthermore, only the full version supports building your own custom instruments, and
lets you load unlicensed libraries.

@ Kontakt Player lets you use some of the full version's exclusive features in demo
mode, indicated by the DEMO badge on the user interface. You can use these features
for 15 minutes before they will stop working. To learn more about the full version of
Kontakt, refer to the Kontakt user guide.


https://www.native-instruments.com/
http://Komplete Start,   Our free music production bundle includes Kontakt instruments, synths, effects, and hundreds of sounds. https://www.native-instruments.com/en/products/komplete/bundles/komplete-start/get-komplete-start/
https://www.native-instruments.com/ni-tech-manuals/kontakt-manual/en/welcome-to-kontakt
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4. New in Kontakt 8 Player

The following features have been added or improved in Kontakt 8 Player:

Leap: The new Leap framework lets you play and perform loops and one-shot samples. It
comes with new perform effects and a streamlined interface to quickly customize samples. For
more information refer to Leap instrument.

Default view: Kontakt 8 comes with a new Default view. The new side pane lets you connect
Tools to instruments, mix various instruments in your Rack, and quickly load and swap presets
for both Tools and instruments. Classic view is still available using the View menu in the
Header. For more information refer to Side pane.

Piano Uno: Kontakt 8 now ships with an easy-to-use piano instrument. Great for kickstarting
creative ideas, or to just play while installing the Factory Library. For more information refer to
Piano Uno instrument.
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5. Installation and setup

Learn how to download and install Kontakt Player using Native Access and get started making
music.

Installation using Native Access

Native Access is your go-to app for downloading, activating, and updating all your NI music
creation tools including Kontakt Player and its libraries. If you are new to Native Instruments, you
will first have to create your Native ID user account. To learn more about Native Access, visit
our support page.

Download and install Native Access here.

Open the Native Access application.

Create a Native ID, if you do not have one already.

Login to Native Access using your Native ID.

Click Library on the left side of Native Access.

Click Available at the top of Native Access.

Click the Kontakt category to only show products related to Kontakt.
Click Install for Kontakt 8 Player.

© N o gk~ w0 D=

l

The software is installed automatically.

39: If you are new to Kontakt Player, get Komplete Start and add exciting content to
your library. Our free music production bundle includes Kontakt instruments, synths,
effects, and hundreds of sounds. For information about how to add it to your account,
to to Komplete Start.

Using Kontakt Player as a plugin in your DAW

The plugin version of Kontakt Player lets you use it as an instrument inside your DAW. You can run
multiple instances of Kontakt Player alongside other instrument and effect plugins. When used as
a plugin, Kontakt Player relies on your DAW to receive MIDI. Kontakt Player's audio output is directly
sent to your DAW's mixer.

Kontakt Player is available in VST3, Audio Units (AU), and AAX plug-in formats. Once installed,
Kontakt Player will appear in the plugin lists of any compatible DAW you have installed on your
system. If Kontakt Player does not show up, refer to this article in our Knowledge Base for help.

If you want to learn more about how to load and play instrument plugins like Kontakt Player in your
DAW, please refer to the documentation provided by the manufacturer.

@ Kontakt 7 and 8 feature plugin migration that will help you load DAW projects
containing older versions of Kontakt. Learn more in the following Knowledge Base
article: Notes about Auto-Migration of Kontakt Versions in DAW Projects


https://support.native-instruments.com/hc/en-us/articles/360000335597-Registering-and-Installing-a-Native-Instruments-Product-VIDEO-
https://www.native-instruments.com/en/specials/native-access/
https://www.native-instruments.com/en/products/komplete/bundles/komplete-start/get-komplete-start/
https://support.native-instruments.com/hc/en-us/articles/360017789138-My-NI-Software-Does-Not-Appear-in-my-DAW
https://support.native-instruments.com/hc/en-us/articles/12972701353757-Notes-about-Auto-Migration-of-Kontakt-Versions-in-DAW-Projects
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Using Kontakt Player as standalone application

When you open Kontakt Player from your system's application folder, it will launch as standalone
application independently of a DAW or another plugin host. The Kontakt Player standalone
application receives MIDI from one or more ports of a MIDI interface and sends audio signals
directly to your audio interface.

This enables you to use Kontakt Player as a live performance instrument or as a sampling host
on a dedicated computer. If you are creating your own instruments using Kontakt Player, the
standalone application can offer a more focused workflow.

When you open the Kontakt Player standalone application for the first time, you will need to
configure the audio and MIDI settings in the Options dialog to connect Kontakt Player to your audio
interface and MIDI controller.

» To open the Options dialog, click the File menu in the Kontakt Player Header and select
Options. Alternatively, you can press F12 on your computer keyboard.

Audio configuration

In the Audio tab of the Options dialog, you can specify which audio device Kontakt Player should
use for playback and adjust global playback parameters.

The Audio tab provides the following options:

Options

Interface

Driver
Engine
Handling

er confiquration

Funning

Latency

Audia

[0}

Input 0.0 mz g 1007 s Output  10.4 ms Ouerall 211 mz

- Driver: With this drop-down menu, you can select which of your operating system'’s device
driver architectures Kontakt Player should use. Most professional audio devices provide ASIO,
CoreAudio (Mac) or WASAPI (Windows) drivers.

- Device: This menu lists all connected audio interfaces that match the driver architecture
chosen above. Use this to select the audio interface that you would like to use for playback.

- Sample rate: This drop-down menu allows you to set the global playback sample rate at which
Kontakt Player will operate. Common values are 44100 Hz for music and 48000 Hz for film
production. Note that this does not have anything to do with the sampling rate at which your
samples have been recorded — if the playback rate does not match a sample’s recording rate,
Kontakt Player will handle all necessary conversion steps transparently for you.

Latency: The size of the audio playback buffer in samples. Small values will shorten the delay
between pressing a key and hearing the resulting sound (this is called “latency”), but may cause
drop-outs and stuttering when playing a lot of voices at the same time. Conversely, setting this
to a higher value will make playback more reliable at the cost of more latency. Note that this
control is not always available, as sometimes the latency is handled by your hardware drivers.
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'—Q:' Learn more about latency and how to optimize your audio settings and system
configuration for best performance, refer to this article in our Knowledge Base.

MIDI configuration

The MIDI tab of the Options dialog provides a list of all MIDI inputs and outputs that have been
found on your system. These are ports of physical MIDI interfaces connected to your computer,
but also any virtual MIDI ports that may be provided by drivers or other applications to facilitate
inter-application MIDI usage.

Options

Interface

Engine

Handling

takt
KOMPLETE KO
KOMPLETE
Kormplete Kontrol D

MIDI

In order to make Kontakt Player respond to MIDI data from the outside, you have to enable one or
more ports that appear in the inputs list of the MIDI tab. Make sure the Inputs button is highlighted
and identify the port(s) that you intend to use for MIDI input in the list. If the Status field on the
right side of an entry reads Off, click that value and assign one of the MIDI port identifiers (A-D).
This enables the respective port, which will later be identified by the selected letter throughout the
user interface.


https://support.native-instruments.com/hc/en-us/articles/209544629-What-is-Latency
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6. Overview

When you open Kontakt Player, the Library browser will invite you to load your first preset and start
playing. Once you have loaded a preset, the main window lets you tweak instruments, continue
browsing, and configure Kontakt.

@ Learn how to use the Library browser in Browser and presets.

Piano Uno

d Tools Leap Loops One-shots

Piano Uno

oo SRR LR AR

Header: Lets you open the Library browser, show or hide elements in the user interface, and
access options in the File menu. Additionally, the displays and meters keep you informed
about the software status. For more information, refer to Header.

Rack: Shows the instruments and tools you have loaded, each letting you tweak and edit your
sounds in its own dedicated user interface. To learn more about the included Piano Uno and
Leap, refer to Instruments.

Side pane: Lets you combine tools and instruments, control mixer functions including the
volume levels, and show all presets of a loaded instrument in the side pane browser. For more
information, refer to Side pane.

On-screen keyboard: Enables you to play instruments with your mouse, and shows the
instrument's key mapping. You can hide or show the on-screen keyboard using the View menu
in the Header. For more information, refer to On-screen keyboard.

Q You can use the View menu in the Header to display the Info pane, which shows brief
descriptions of user interface elements when you hover the mouse cursor over them.
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Side pane

At the top of the side pane, the Navigator lets you view and manage the contents of the Rack.
Below the Navigator, the side pane browser makes it easy to add or replace a Tool or an instrument
in the Rack, and explore presets without switching views in Kontakt.

The side pane consists of the following areas:

Arpeggiator

s Conflux
+

Instruments Combined Tools Leap Loops One-shots

ConFLWUX

All Banks v

L Search

4l Conflux

Al Symphony
Amber Emotions
Amoebe Passing
An Exploration
Antarctica
Arctodus

At Rubble Station

Atomic Siren

| — 216 Presets

1. Navigator: Shows the Tools and instruments in your Rack, and lets you manage them. For
more information, refer to Navigator.

2. Side pane browser: L ets you add a Tool or an instrument to your Rack and browse its presets.
For more information, refer to Side pane browser.

@ Tools are MIDI effects that are exclusive to the full version of Kontakt. You can use
them in demo mode for 15 minutes. Learn more here in the Kontakt user guide.

Navigator

The Navigator lets you view, manage, and mix the instruments in the Rack, and connect them to
Tools. You can also use it in conjunction with the side pane browser to add or replace a Tool or an
instrument in the Rack.


https://www.native-instruments.com/ni-tech-manuals/kontakt-manual/en/instruments-and-tools

OVERVIEW 11

The Navigator contains the following elements and controls:

Arpeggiator

sMmOO

1. Add Tool: Adds another Tool to the Rack. If you load more than one Tool, the Tools will be
chained in series.

2. Tool slot: Represents a single Tool in the Rack, and its position. Clicking the entry lets you
browse the Tool's presets in the side pane browser, or replace it by loading another Tool.
Right-clicking opens the context menu that lets you clear the slot, save a user preset, and set
the MIDI input.

3. Tool on/off: Switches the Tool on or off. When switched off, its functionality is bypassed and
its MIDI input is sent untouched to its output.

Clear Tool slot: Removes the Tool from the Rack.
5. Clear instrument slot: Removes the respective instrument from the Rack.
6. Instrument controls: Let you adjust mixer controls for each instrument.
Solo (S): Solos the respective instrument, muting the audio from all other instruments.
Mute (M): Mutes the respective instrument's audio.
- Pan: Adjusts the position of the respective instrument in the stereo field.
Volume: Adjusts the volume level of the respective instrument.
7. Add instrument: Adds another instrument to the Rack.

8. Instrument slot: Represents a single instrument in the Rack, and its position. Clicking the
entry lets you browse the instrument's preset in the side pane browser, or replace it by loading
another instrument. Right-clicking opens the context menu that lets you clear the slot, save a
user preset, and set the MIDI input.

If too many Tools or too many instruments are loaded and the Navigator cannot show all of them
at once, scroll bars appear on the right and let you reach the hidden slots. You can also drag the
border between the Navigator and the side pane browser to adjust the size of the Navigator.

Navigator context menu

The context menu in the navigator lets you clear a Tool or instrument slot, save a user preset, and
set the MIDI input.

» To open the context menu, right-click a Tool or an instrument slot.

The Navigator context menu contains the following entries:
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Clear Slot

%Conﬂux SYNOIO)
+

Save Preset...

Set MIDI Input
Instruments Cc One-shots

Clear Slot: Removes the Tool or instrument from the Rack.

Save Preset.... Saves a user preset for the Tool or instrument loaded in the slot. For more
information, refer to Saving a User preset.

Set MIDI Input: Selects the MIDI input port/channel used by the Tool or instrument. This entry
is available only in the following situations:

If no Tool is loaded, the Set MIDI Input entry is available for each instrument in the Rack. If
two or more instruments are loaded, you could for example control them all from the same
MIDI input port/channel, or use a distinct MIDI input port/channel for each instrument.

If one or more Tools are loaded, the Set MIDI Input entry is available only for the topmost
Tool. The remaining Tools (if any) are chained in series behind the first Tool, and the last
Tool sends its MIDI output to all the instruments in the Rack.

Using multiple Tools

You can load multiple Tools into the Rack. In this case, the Tools are chained in series and the MIDI
signal flows from top to bottom through the Tools:

The MIDI signal coming from your keyboard is sent to the first Tool atop the Rack.
+ The MIDI output of each Tool is sent to the input of the next Tool below.

The MIDI output of the last Tool in the chain is then passed to all the instruments loaded in the
Rack.

When using multiple Tools, you can drag the Tool slots vertically in the Navigator (or the Tool
Headers in the Rack) to change their order in the chain, and audition different signal flows (for
example, comparing “Chords before Patterns” with “Patterns before Chords”).

Side pane browser

The side pane browser makes it easy to explore all of the presets for individual products loaded in
the Rack without switching views in Kontakt. You can also use it in conjunction with the Navigator
to add or replace a Tool or an instrument in the Rack.

The side pane browser contains the following elements and controls:
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Instruments Combined Tools Leap Loops One-shots

COnFLWLUX

L Search 4

Il Conflux

Al Symphony
Amber Emotions
At Rubble Station
Atomic Siren
Baliano

Blended Dreams
Brass Tribe
Bright Soul

But Certainly

Calm Now

| —— 86 Presets

Category selector: Selects the category of content displayed in the Browser, from instruments
to Tools and Leap instruments. For more information, refer to Browser categories.

Product selector: Opens the Product selector that you can use to add or replace a Tool or an
instrument in the Rack. For more information, refer to Product selector.

Search field: Filters presets according to text entered in the field. The search engine considers
the preset name, author, Brand / Character / Sound Type tags, product and bank name. The
Results list is filtered according to the terms entered in the Search field. Refer to Using the
search field.

User Content: Filters by user content. When activated, the Browser only shows user presets.
When deactivated, the Browser only shows factory presets. For more information on user
presets, refer to User presets .

Favorites (star icon): Displays only your Favorites in the Results list. You can define any
presets in the Results list as Favorites, creating quick access to a custom collection of your
most beloved presets. Refer to Using favorites.

Results list: Displays the list of presets corresponding to your search criteria. Presets are
listed in alphabetical order and the selected preset is highlighted. Click a preset to audition the
sound without loading the preset. Double-click a preset to load it into the current slot. You can
also use the up/down arrows on your computer keyboard to select the previous/next preset
from the list. You can expand or shrink the list area by clicking and dragging the left border of
the Results List.

Audition controls: Adjusts the volume at which presets are auditioned as you select them
in the Results list. Auditioning presets is active by default and can be muted by clicking the
speaker icon.

Preset count: Shows the number of presets in the Results list.
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Product selector

The Product selector lets you add a Tool or an instrument to your Rack, or replace existing ones.

» To open the Product selector and add a product to the Rack, click the + icon for either TOOLS or
INSTRUMENTS in the Navigator.

» To open the Product selector and replace the currently selected product, click the product logo
bar in the side pane browser.

Instruments Combined Tools Leap Loops One-shots

COoOn~eFELLUX N

AT

O Search

@ A product will be added or replaced once you load one of its presets from the Results
list.

The Product selector consists of the following elements:

Instruments Combined Tools Leap Loops One-shots

Select Product

Eu 1% >‘ co nu; x ONTAlz'r

Alicias E...tr] 3 onflux Kontakt

SCHEMA DARK-
ool \ 2 >

Playbox Schema - Dark Schema - Light

1. Category selector: Selects the category of content displayed in the Browser, from instruments
to Tools and Leap instruments. For more information, refer to Browser categories.

Product tiles: Selecting a tile shows the product's presets in the Results list.

First preset: Loads the first preset of the respective product. This button is only shown when
hovering the mouse cursor over the product tile.
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Header

The Header at the top of the Kontakt window lets you access the File menu, the Library
browser, and the View menu for configuring the user interface. Additionally, it shows performance
information including CPU and hard drive load.

The Header consists of the following menus and elements:

KONITAKT FILE LBRARY VIEW

1. File: Opens the File menu that contains options related to to saving, loading, and creating
new presets and instruments. Additionally, it lets you access the Options dialog with software
preferences. For more information, refer to File Menu and Options dialog.

2. Library: Opens the Library browser, which lets you explore all of your libraries and user
content. For more information, refer to Browser and presets.

3. View: Opens the View menu that contains options related to configuring Kontakt's user
interface. For more information, refer to View Menu.

4. Shop: Links to the Native Instruments web shop where you can find new instruments to add to
your library.

5. System performance information: Reports key metrics about Kontakt's performance as well
as CPU and hard drive load. Additionally, you can use the Engine restart button to initialize the
audio engine. Refer to System performance information.

File menu

The File menu lets you create new Leap presets, load custom instruments from your hard drive,
manage your files, and access the Options dialog.

The File menu contains the following options:

KONTAKT

New Leap preset
Load... con-FLLUX

Load recent

Save as
Save multi as...

Save as default multi
Reset multi

Batch resave

Collect samples / Batch compress

Global purge >

Options... F12

Controller >

New Leap preset: Opens Leap with an empty kit that you can use to combine and play any
of the loop and one-shot samples in your library. For more information, refer to Loading and
saving Leap kits.
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Load.... Opens a file dialog that lets you load compatible files from your hard drive, for example
an instrument (.nki), a multi (.(nkm), or an instrument bank (.nkb). If samples are missing for the
loaded instrument, you can use the Samples Missing dialog to find them.

Load recent: Shows a list of recently used files and lets you open them.

Save as: Opens a list of all instruments in the Rack. Selecting an entry opens a file dialog that
lets you save the respective instrument. In the file dialog, you can define how Kontakt Player
will save sample files that are used by the instrument. For more information, refer to Saving
instruments

Save multi as.... Saves the contents of your Rack as a Multi file (.nkm). The Multi contains all
instrument settings as well as the output routing options. You can define how Kontakt Player
will save sample files for all contained instruments using the file dialog as described in Saving
instruments.

Save as default multi: Saves the contents of your Rack as default template that Kontakt Player
will load at startup or when you select Reset multi.

Reset multi: Restores the default template that is loaded at startup, removing all instruments
from your Rack.

Options.... Opens the Options dialog with global preferences, including the audio and MIDI
settings. For more information, refer to Options dialog.

Batch resave: Enables you to find missing samples for multiple custom instruments at once.
For more information, refer to Batch resave.

Collect samples / Batch compress: Enables you to collect all samples for a number of
instruments and compress the files to save hard drive space. For more information, refer to
Collect samples / Batch compress.

Global purge: Enables you to free the memory of any unused samples. For more information,
refer to Global purge.

Controller: Shows the connected Kontrol keyboard. When a Kontrol keyboard is connected, the
corresponding entry is indicated by a checkmark.

View Menu

The View menu lets you choose which elements of the Kontakt Player interface are shown.
Depending on whether you are using Default view or Classic view, different options are given.

View menu options in Default view
In Default view the View menu contains the following options:

EONITAKT FLE LBRARY VIEW SHoP 20 i
Classic View F10
Instrument Header
Side Pane
Info

Keyboard

Zoom (100%)

Classic View: Switches Kontakt to Classic view.

Instrument Header: Displays the header for each instrument in the Rack, letting you configure
instrument options.

Side pane: Displays the side pane on the left side of the Kontakt Player window. For more
information, refer to Side pane.
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Info: Displays the Info pane, which shows brief descriptions of user interface elements when
you hover the mouse cursor over them. For more information, refer to Info pane.

Keyboard: Displays the virtual on-screen keyboard, which enables you to play instruments
with your mouse, and shows the instrument's key mapping. For more information, refer to
On-screen keyboard.

Zoom: Sets the zoom scaling of the Kontakt window and allows switching between three
performance modes for the user interface: Best quality, Balanced, and Best performance.

View menu options in Classic view
In Classic view the View menu contains the following options:

KONITAKT FILE LIBRARY VIEW

Multi =z Default Vi
Multi MNew (default) etault View

Rack
Side Pane

Master
Info
Outputs
Keyboard
Quick-Load

Zoom (100%)

Default View: Switches Kontakt to Default view.

Side pane: Displays the side pane on the left side of the Kontakt Player window. For more
information, refer to Side Pane (Classic view).

Master: Displays the Master Editor panel, which contains a number of global parameters and
common utility functions. For more information, refer to Master Editor.

Info: Displays the Info pane, which shows brief descriptions of user interface elements when
you hover the mouse cursor over them. For more information, refer to Info pane.

Outputs: Displays the Outputs section at the bottom of the Rack. For more information, refer to
Outputs Section.

Keyboard: Displays the virtual on-screen keyboard, which enables you to play instruments
with your mouse, and shows the instrument's key mapping. For more information, refer to
On-screen keyboard.

. Displays the Quick-Load Catalog, which is a user-defined browser for quick access to your
favorite Kontakt files. For more information, refer to Quick-Load Catalog.

Zoom: Sets the zoom scaling of the Kontakt window and allows switching between three
performance modes for the user interface: Best quality, Balanced, and Best performance.

System performance information

The system performance information on the right side of the Header reports key metrics about
Kontakt's performance as well as CPU and hard drive load. The values are updated in real time and
give you an idea of how Kontakt affects your system's resources.

Voice count (notes icon): The total number of voices that are currently being played by all
instruments loaded in this instance of Kontakt.
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CPU: The CPU load in percent, giving you visual feedback about the available processing
resources when adding more instruments.

Disk: The disk load in percent, giving you visual feedback about the available hard drive
bandwidth when adding more instruments.

Engine restart (! icon): Initializes the audio engine and all loaded instruments, which is useful
when Kontakt instruments get stuck on notes or overload the CPU persistently. Any settings
you made in the instruments are preserved.

On-screen keyboard

Kontakt Player provides a virtual on-screen keyboard that can be used to play instruments with
your mouse when a MIDI keyboard is not available.

| 2

To show the on-screen keyboard, click the View menu in the Header and select Keyboard.
Alternatively, you can press F3 on your computer keyboard.

The on-screen keyboard contains the following features and controls:

40 -
i 2 Bl 0 1 2| 3| 4| H 6 7 8|

Keys: When a key is clicked, the keyboard generates a corresponding note event that will be
received by the currently selected Instrument. The note's velocity is relative to where on the key
you click: clicking towards the top of the key will produce notes with a low velocity, and clicking
towards the bottom of the key will produce notes with a high velocity.

Pitch and mod wheel: Click and drag the Pitch and Modwheel to generate pitch bend and MIDI
CC #1 data respectively.

Transposition: Shift the displayed key range up and down in octaves.
Key range: The keyboard uses colors to indicate the key ranges of the current Instrument.
Playable keys: Keys that produce sound are colored blue.

Keyswitches: Keys that trigger articulations and other changes in the instrument's behavior
are colored red. Keyswitches do not trigger sound by themselves and are played in
combination with regular keys.

Special functions: Some libraries use colors differently to indicate specific use cases, for
example keyboard splits or different instrument types.

Info pane

The Info pane displays a help text when you hover the mouse cursor over a user interface element,
like buttons or other controls.

>

To show the Info pane at the bottom of the Rack, click the View menu in the Header and select
Info Pane. Alternatively, you can press command + | (macQS) or Ctrl + | (Windows) on your
computer keyboard.
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Content related to Kontakt's Classic view is translated in English, German, French, Spanish and
Japanese. Language preferences are set using the Language drop-down menu in the Interface tab
of the Options dialog. When selecting Automatic, Kontakt will follow the language selection of your
operating system. Language settings only take effect after restarting Kontakt Player.
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7. Browser and presets

The Browser provides access to all your Kontakt factory content (Libraries, Instruments, Tools,
Snapshots and Multis), as well as your own user content. Sophisticated browser functionality
allows you to filter sounds by tags, brand, product, bank, text search, user presets and Favorites,
helping you to quickly and intuitively find the right presets for your musical needs.

Player-licensed content will appear automatically in the Browser and you can import non-player
content into the Browser.

» To open the Browser, click the Browser icon in the Main Control Panel.
The Browser contains the following features and controls:

KONITAKT FILE LIBRARY VIEW SHOP :;g

P Search Piano / Keys m Reset

Instruments Combined Tools Leap Loops One-shots

Brand Sound Type Character
Bass Bowed Strings  Brass Drums  Flute  Guitar Mallet Instruments  Organ  Percussion [EEELGNVAGA]
Plucked Strings  Reed Instruments Sound Effects SynthLead SynthMisc  SynthPad  Vocal

Clavinet  Digital Piano  Electric Piano  Grand Piano  Upright Piano

[ 4 > Kontakt - All Banks v
"1\ut‘n\'/ 'S Piano Uno

I Additive Piano

Alicias Electric Keys Conflux Piano Uno

¥ o W cP11

Playbox Schema - Ligh Wl CP11 Harpsi
W CP11 Trem Piano

Q o — Hide 40 Presets ()

New Instruments for you

Library: Opens and closes the Browser.

2. Search field: Filters presets according to text entered in the field. The search engine considers
the preset name, author, Brand / Character / Sound Type tags, product and bank name. The
Results list is filtered according to the terms entered in the Search field. Refer to Using the
search field.

3. Category selector: Selects the category of content displayed in the Browser, from instruments
to Tools and Leap instruments. For more information, refer to Browser categories.

4. Tag filters: Contains Brand, Sound Type, and Character filters, which use NKS tagging to
enhance the browsing experience. Switch between the three filters interchangeably and
explore tags that classify and organize presets based on the manufacturer as well as various
musical attributes and functions. You can hide these filters by clicking the arrow icon on the
right to minimize the filter section. Refer to Using filters.



10.

11.

12.

13.
14.

15.

BROWSER AND PRESETS 21

Product filter: Displays your Kontakt Libraries as tiles. Selecting a tile filters the Results list
with relevant presets. Hovering over a tile reveals an arrow icon (>) which when clicked loads
the first preset of the associated product. Browsing with tag filters and text search adjusts the
Product filter accordingly. Refer to Filtering by product.

Import Content (cogwheel icon): Opens a dialog that allows you to import, remove and rescan
your custom content and non-player libraries. Refer to Managing imported content.

Audition controls: Adjusts the volume at which presets are auditioned as you select them
in the Results list. Auditioning presets is active by default and can be muted by clicking the
speaker icon.

Instrument suggestions: Displays instruments currently not owned but available in the Native
Instruments online shop. These suggestions change based on the text input of the search
fleld and the selected Sound Type tag. Clicking on an instrument opens the respective shop
website in the internet browser.

Show/Hide Presets: Displays and hides the Results list. Click Show Presets to display the
Results list, or click Hide Presets to hide it. The number of presets currently displayed in
the Results list is also indicated. This useful feature allows you to monitor the effect of your
filtering, highlighting the potential need for tag refinement to help narrow down extensive
Results lists.

Info (I): Shows/hides the Info pane, which displays information relating to the properties and
tags of the selected preset. You can also assign tags to user presets in this pane. The Info
pane is only available when the Results list is displayed. Refer to Info pane.

Results list: Displays the list of presets corresponding to your search criteria. Presets are
listed in alphabetical order and the selected preset is highlighted. Click a preset to audition the
sound without loading the preset. Double-click a preset to load it into the current slot. You can
also use the up/down arrows on your computer keyboard to select the previous/next preset
from the list. You can expand or shrink the list area by clicking and dragging the left border of
the Results List.

The Results List will display this icon next to a list entry if it is an instrument.

The Results List will display this icon next to a list entry if it is a preset that combines
multiple instruments, or instruments and tools.

@ Loading a sample from the Loops or One-shots category will open a new Leap kit.
When using Classic view, a new custom instrument will open instead.

Bank filter: Contains all banks and sub-banks (if any) of the selected product. Selecting a bank
or a sub-bank filters the Results list accordingly.

Close (x icon): Closes the Browser when clicked.

Pin (pin icon): Pins the Browser open while you search for presets. By default, Pin is
deactivated and the Browser closes automatically when you load a preset. Clicking the Pin
button activates Browser pinning, allowing you to audition and load presets without closing
the Browser automatically.

Favorites (star icon): Displays only your Favorites in the Results list. You can define any
presets in the Results list as Favorites, creating quick access to a custom collection of your
most beloved presets. Refer to Using favorites.
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16. User Content: Filters by user content. When activated, the Browser only shows user presets.
When deactivated, the Browser only shows factory presets. For more information on user
presets, refer to User presets .

17. Reset: Resets all filters, including the brand, product, bank and sub-bank, as well as the Sound
Type and Character tags. In addition, the User Content and Favorites switches are turned off.
You end up with the full list of factory presets available.

@ Factory refers to content created by a manufacturer. User refers to content that you or
other users have created.

Browser categories

The Library browser in Kontakt features categories that let you quickly access different types of
content, from your instruments to Tools and Leap, as well as all the Loops and One Shots from the
Expansions you have installed.

CPU 0%

KONITAKT FILE LIBRARY VIEW SHoP 29 i

0 Search

Instruments Combined Tools Leap Loops One-shots

Brand Sound Type Character

Instruments

Instruments is where you can browse all the Kontakt instruments you have installed on your
computer. Our vast collection on the Native Instruments website includes pianos, drums and
percussion, orchestral instruments, synthesizers, and more. Once installed through Native Access
they will show up here under Instruments.

':Q:' The included Piano Uno will get you started even if you don't have any other
instruments installed. Learn more in Piano Uno instrument.

Combined

Combined gives you access to presets containing multiple instruments, and the brand new Tool-
enhanced presets. These combine instruments with Tools that transform your playing in inspiring
ways. For example, Kontakt includes the Chords, Phrases, and Patterns Tools. Learn more in
Instruments and Tools.

@ Tools are MIDI effects that are exclusive to the full version of Kontakt. You can use
them in demo mode for 15 minutes. Learn more here in the Kontakt user guide.

':9:' The option to Show Tool-enhanced only lets you browse presets that feature Tools.


https://www.native-instruments.com/ni-tech-manuals/kontakt-manual/en/instruments-and-tools
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Tools

Tools is where you will find our new Tools, Chords and Phrases. The Chords Tool comes with more
than 100 chord sets, and the Phrases Tool offers more than 100 phrase sets, covering a wide range
of different genres and styles. Both Tools give you exciting features to manipulate the chords and
phrases and real time. Learn more in Instruments and Tools.

@ Tools are MIDI effects that are exclusive to the full version of Kontakt. You can use
them in demo mode for 15 minutes. Learn more here in the Kontakt user guide.

Leap

Leap is where you can browse Expansions with kits ready to be loaded in our new Leap sampler.
Use its engines to make each sound your own, and create exciting performances with Macro
knobs and black keys effect. Get inspired by our Expansions, each dedicated to a certain genre,
mood, or style, or use Leap to create your own kits. You can buy more Expansions on the Native
Instruments website. Once installed through Native Access they will show up here under Leap.
Learn more in Leap instrument.

Loops

Loops contains all your audio loops, such as riffs, motifs, drums loops, and more. These loops are
part of the Expansions you have installed on your computer. You can buy more Expansions on the
Native Instruments website. Once installed through Native Access the included audio loops will
show up here under Loops, ready to be combined and played using Leap. Learn more in Loading
samples and kits.

One-shots

One-shots contains all your single sound samples, such as drum hits, keys, synths, guitars, basses,
and more. These samples are part of the Expansions you have installed on your computer. You can
buy more Expansions on the Native Instruments website. Once installed through Native Access the
included samples will show up here under One-shots, ready to be combined and played using Leap.
Learn more in Loading samples and kits.

Using filters

Filters enable you to search for sounds using NKS tags and Library tiles. Tags are used to
characterize and classify presets based on various musical attributes. All Kontakt Library presets
have been tagged in a meaningful way to encourage your sonic exploration and help you find
results quickly.

Three main Filters can be used to help enhance your browsing — Library tiles, Sound Type tags
and Character tags. Library tiles allow you to search and filter for preset sounds within a specific
Library. Selecting a Library tile will display preset results only available to that product, whilst
highlighting all relevant tags. Sound Type and Character filters use NKS tags to search for preset
sounds. Switch between the two Filters interchangeably by clicking the respective name. Type and
Character tags in addition to the Search field can be used to further refine your search results. Hide
the Sound Type and Character filters by clicking the arrow icon to minimize the section. A Reset
button will appear in the search bar when a filter is applied. Click this to reset all filters.


https://www.native-instruments.com/ni-tech-manuals/kontakt-manual/en/instruments-and-tools
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Filtering by sound type

Sound Type tags are structured into two hierarchical levels, allowing you to search for files based
on applied Type and Subtype tags. The Sound Type filter initially displays top-level tags only, whilst
selecting a tag will display the related NKS Subtype tags below. The hierarchical structure means
that Subtype tags are specific to the respective Sound Type tag. This provides quick access to a
range of presets from different Libraries that share similar sonic functions.

£ search (553 ] e s | Soniscares SRS

Instruments Combined Tools Leap Loops

Sound Type

nth B ngs o ) rums D ) o Flute Glitch Guitar Impact L

tion MuliFX O d S [ELILRURRY  single Note  Sound Effects

ynth Lead

Insanity Oboe  Peace Synth  Trumpet  Wind

Selecting multiple tags helps you to further refine your search. In the case of multi-selection,
repeating Subtype tags are merged into a single tag. When selecting multiple tags, the last item
added to the selection is also focused.

To filter by Sound Type tags:

1. Click Sound Type in the Filter section on the left pane of the Browser.

Brand | SoundType \  Ch ~

Chord Distortion Drums Drumsynth Electro Flute Glitch Guitar Impact Kits

Organ

2. Click on a Sound Type tag to select it. You can select multiple Sound Type tags by pressing
[Shift] + clicking. Any related NKS Subtype tags will be displayed below.

Brand | SoundType | Character N

tortion  Dru Drum ar  Impact  Kits

Organ

N

Drumsynth  Electro  Flute Glitch Guitar Impact Kits

Distorted Bass  Fing

Symy Upright  Upright

- The presets in the Results list are filtered by the selected Filter tags. Presets carrying any of the
selected Filter tags are displayed.

':9:' You can also use [command] (macO0S) or [Ctrl] (Windows) + click to select multiple
tags.



BROWSER AND PRESETS 25

Filtering by character

The Character filter provides an additional level that is independent from the Sound Type filter.
These tags are used to further categorize sound characteristics that are common between
different Instruments and Sound Types. This offers an additional flexible level of tagging that
allows you to browse Instruments with similar characteristics to find a range of samples that meet
your identified criteria.

Selecting multiple tags helps you to further refine your search. In the case of multi-selection,
repeating Subtype tags are merged into a single tag. When selecting multiple tags, the last item
added to the selection is also focused.

To filter by Character tags:

1. Click Character in the Filter section on the left pane of the Browser.

Character [\,

2. Click on a Character tag.

Character

- The presets in the Results list are filtered by the selected Filter tags. Only presets carrying all of
the selected Filter tags are shown.

':Q:' You can also use [command](macOS) or [Ctrl](Windows) + click to select multiple
tags.

Filtering by product

The Library tiles are located below the Sound Type and Character Filters and display all your
available Kontakt libraries and custom content. Clicking a Product tile highlights the selected library
and filters the Results list down to its relevant presets. You can further refine your search using the
Sound Type and Character Filters, as well as the Search field.

To filter presets using the Product tiles:

1. Open the Browser.
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2. Select a Library from the Product tiles. The presets of the selected Library are displayed in the
Results list.

£ Search

Sound Type Character
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4. Select from the drop-down menu to refine your search. The presets in the Result list will update
accordingly.

0

Sound Type Characte

Bowed Strings Drums
Mallet Instruments Organ  Percussion  Piano/Keys  Plucked Strings

Soundscapes SynthLead SynthMisc  Synth Pad Vocal

Playbox - Supernatural v

Age Of Morph Flexible Time
Bending Time Groundcontrol

Kontakt Big Machine

3ow Down rnet Punks
vuLn Build Up On Earth
Dirty Hybrids

Doomed
Lo-Fi Glow Modular Icons oome

7 Drums Untrue arz
> s N Dystopia oV
) ' Post Trauma

Pharlight Playbox Retro Machines
Final Cruise Pretty Burnout

T ot —

5. Additionally, you can use Sound Type and Character tags to filter your search.

bl < IRTEE = & # x

Sound Type Character

Arpeggiated y4 Distorted

Granular Layered  Lick

Sample-based

‘ ' Playbox - Supernatural v

Bending Time

Analog Dreams Arkhis

You Home

Melted Vibes Playbox

NES Straylight

Ol — Hide 5 Presets @

= The presets in the Result list will update according to the selected Filter tags.

393 The Browser also enables you to import non-player, legacy and custom content as
Library tiles. For more information, refer to Managing imported content.
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Using the search field

The Search field at the top of the Browser interface allows you to filter presets with text entry. The
search considers preset names, author, Filter titles, and metadata including Character and Product
tags.

To filter presets using the Search field:

1. Activate the Search field by clicking it.
AL Search ¥

2. Enter your search terms.

- The Result list is filtered according to the terms entered in the Search field.

If you are browsing using Filter tags, your search will only display results according to the selected
tags. Your search entry remains in the field even when the Browser is closed.

B To clear the search, click on the cross icon on the right side of the Search field.

Using favorites

Favorites enable you to quickly find your most frequently used and enjoyed presets, and recall
them at any time. By assigning Favorite tags to presets in the Results list you can create a personal
collection of sounds that can be easily accessed from the Browser. Once assigned, Favorites serve
as an additional filter in the Browser. You can continue to use other filters to refine your search,
including the Search field. Favorites can be used for both factory and user presets.

To assign a Favorite tag:
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» Click the star icon that appears when a preset is selected or hovered over.

All Presets

Absolute Ceiling

Admire You
G EGE

Affirmation Choir

- The Favorite tag is assigned. Clicking the star again removes the tag.

All Presets

Absolute Ceiling
Admire You
Aetherial

Affirmation Choir

To view your Favorites in the Result list:

» Click the Favorites icon in the search field.

Sound Type

Guitar SynthPad  Vocal

‘A All Presets
=

Pharlight Playbox

Instrument suggestions

The New Instruments for you panel at the bottom of the Browser offers instrument suggestions
not yet part of the local Kontakt library. These suggestions can be filtered using Sound Type
& Character tags and respond to text input in the search field of the Browser. Clicking on a
suggestion opens the product page of that instrument on the NI website, giving you access to
more information and the ability to directly purchase it. The New Instruments for you panel can be
deactivated in the Interface tab of the Options.

Info pane

The Info Pane displays information relating to the properties and tags of the selected preset. You
can also use the Info Pane to assign tags to user presets.
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The Info Pane provides the following information and controls:

O NG RN

Arcadia

Properties Tags

PRODUCT

Analog Dreams

BANK

Analog Dreams 1.0

FILE EXTENSION

ksn

FILE SIZE
31.4 KB

BRAND

Native Instruments

AUTHOR

Native Instruments

COMMENT

Hide 205 Presets @ 9

Properties/Tags: Switches the view between Properties and Tags. Click the name to display
the respective information. For more information about using the Tags view, refer to Managing
User tags .

Product: Displays the name of the product that includes the preset.
Bank: Displays the name of the bank that includes the preset.

File Extension: Displays the extension of the preset's file format.

File Size: Displays the file size of the preset on disk.

Brand: Displays the name of the manufacturer that created the library.
Author: Displays the name of the author that created the preset.
Comment: Displays the optional comment embedded in the preset.
Info Pane (i button): Opens and closes the Info pane.

Managing imported content

The Browser enables you to import Custom Libraries and User content, adding your imported
content as Library tiles in the Browser. You can batch import multiple libraries in give them custom
names via the alias field.
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Import Content

Custom Libraries User Presets
Add, remove and rescan non-player, legacy and custom content as Library Tiles.
If your added folder path does not appear in the Browser, please use the Batch

re-save function, and press Rescan after the Batch re-save is complete.

Content imported as a custom library is assigned a Bank value based on the
structure of the imported folder, and is read only (i.e. Tags cannot be edited).

Folder Alias

|| Import subfolders as individual libraries

To import content:

—

. Click the Browser icon in the Header to open the Browser.
2. Click the Import Content button at the bottom left of the Browser.
3. Select Custom Libraries or User Presets.

4. Click Add.

5. Locate the content to import and select Open.

- The custom content is imported and displayed as a Library tile in the Browser.
To remove custom content from the Browser:

1. Click the Import Content button, at the bottom left of the Browser.

2. Select Custom Libraries or User Presets.

3. Select the content in the dialog and click Remove.

- The custom content is removed from the Browser.

31
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Managing library artwork

Thumbnail icons allow you to quickly identify your Kontakt Libraries. If the library artwork does not
display, use the following instructions to reset the thumbnails.

macOS

Navigate to the following location on your hard drive: Macintosh HD/Users/Shared.
Locate and delete the folder named NI Resources.

Click Go in the Finder menu bar.

Hold [option](macOS) or [Altl(Windows) and select the Library option that appears in the Go
menu.

Eal

. Navigate to the following location: Library/Application Support/Native Instruments.
. Locate and delete the folder named Kontakt 7.

. Locate and delete the file named pal.db.

5
6
7. Navigate to the Service Center folder in the same user Library folder.
8
9. Empty the system trash.

1

0 Open Native Access and click Refresh.

11 Open Kontakt 7 in stand-alone mode.

- The Library tiles are updated and the thumbnail artwork now displays in the Kontakt Browser.

Windows
1. Navigate to the following location on your hard drive: C:\Users\Public\Documents.
2. Locate and delete the folder named NI Resources.

w

Navigate to the following location on your hard drive:
C:\Users\"Username"\AppData\Local\Native Instruments.

Locate and delete the folder named Kontakt 7.

Navigate to the following: C:\Users\"Username"\Documents\Native Instruments\Service Center.
Locate and delete the file named pal.db.

Open Native Access and click Refresh.

© N o g &

Open Kontakt 7 in stand-alone mode.

- The Library tiles are updated and the thumbnail artwork now displays in the Browser.
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User presets

A preset recalls a previously saved sound including all individual parameter settings. Presets offer
a way of exploring and saving variations of any Kontakt Instruments for easy recall. In addition to
the presets included in Kontakt's extensive Factory Library, you can save, load, and import User
presets. The following sections explain the basic workflows involved in using presets.

Saving a User preset

You can save User presets to recall your favorite sounds and settings at any time, share them with
others, or create backups.

Saving a User preset using the Navigator

When using Kontakt's Default view, you can save User presets for both instruments and Tools
using the Navigator in the side pane.

1. Right-click the slot in the Navigator you want to save a User preset for.

2. Click Save Preset... in the context menu to open the Save dialog.

a Conflux
Clear Slot
+

Save Preset...

Set MIDI Input .
Instruments s One-shots

3. Enter a name for your new User preset and click Save. If you enter the same of an existing User
preset, you will be given the option to replace it by clicking Overwrite.

Fleaze enter a name.

My User preset|

- The User preset is saved and added to the user content in the Browser.

Saving a User preset using the Instrument header

User presets can be saved using the Instrument Header. When a sound parameter has been
adjusted, that Save button (disk icon) becomes active.

@ If you are using Kontakt's Default view, the Instrument Header can be shown or hidden
from the View menu in the Kontakt Header.

1. Click the Snapshot view button (camera icon) in the Instrument Header.
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2. Click the Save button (floppy disk icon) to open the Save dialog.

«r a0 B

Furge =

- @

3. Enter a name for your new User preset and click Save. If you enter the same of an existing User
preset, you will be given the option to replace it by clicking Overwrite.

- The User preset is saved and added to the user content in the Browser.

User content folder

All User presets are automatically stored in the default User Content folder. You can transfer any of
your User presets to another computer by copying the respective files.

The default user content folders are:

Mac OS X: Macintosh HD/Users/<User Name>/Documents/Native Instruments/User
Content/
Windows: C:\Users\<User Name>\My Documents\Native Instruments\User Content\

@ Please make sure that you include your Documents / My Documents folder in your
regular data backups.

Loading a User preset

You can load a User preset from its respective Snapshot menu in the Instrument Header. You can
also access all your User presets from one place in the new Browser.

To load a User preset:
1. Open the Browser.
2. Click the User content button to display all your custom presets.

3. Click a User preset from the Results list to preview the sound.
4. Double-click the preset name to load it.

- The User preset loads in Kontakt.

Deleting a User preset

You can delete any of your User presets.
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To delete a User preset:

1. Select the desired preset in the Browser.

2. Right-click and select show in Finder / Explorer
3. Delete the file from the disk.

- The file is removed from the Browser on next launch of Kontakt.

Managing User tags

You can view and edit User preset tags using the Browser's Info pane. Sound Type and Character
tags can be assigned and unassigned, allowing you to browse your User presets using filtering and
text search. By holding shift and selecting multiple presets, tags can be edited in bulk.

To assign tags to a User preset:

1. Click the User button to display your User presets.

2. Select a User preset from the Results list.
Ignite Test
My User Preset

Nah

3. Click the Info paneicon.

Hide 12 Presets

4. Select the Tags filter.

My User Preset 1 ITEM

Properties Tags [

5. Select the Sound Type and Character tags that relate to your User preset.

Piano Plucks Riser
EEIGIIEELL  Sequenced / Looped  Slow Attack

Special FX  Stabs & Hits Strings  Sub [‘_ Synth

Discard Apply




BROWSER AND PRESETS 36

Click Apply.

Piano Plucks Riser
EENDIEELELEL  Sequenced / Looped  Slow Attack

Special FX Stabs & Hits Strings Synth

Discard Apply [.s‘

- The selected tags are saved to the User preset file.

You can also add your own User Filter tags and assign them to a User preset in the Info Pane of the
Browser.

To add a User Filter tag:

1.

o b~ 0D

Select the User preset you want to assign your own User Filter tag to in the Results list by
clicking on the corresponding entry.

Click the Info Pane button in the bottom right corner of the Results list to open the Info pane.
Click on the + icon under the Filter type you want to add your User Filter tag to.
Type in a name for your User Filter tag.

Press [Enter] or click anywhere in the Info pane to confirm the name and save your User Filter
tag.

- Your new User Filter tag is added and assigned to the User preset.
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8. Instruments and Tools

Kontakt comes with built-in instruments and Factory Tools, ready to be played as soon as you open
the plugin or standalone application.

The built-in instruments let you play Kontakt right away and creatively explore sampling:
Piano Uno offers a quick way of playing a sound.

Leap is a sample playground that loads Expansions or your own samples, enabling you to
create exciting performances.

The Factory Tools are MIDI effects that transform your playing in inspiring ways or provide utility
functions:

Arpeggiator transforms the notes you play into a rhythmic sequence.

Chord Builder adds additional harmonies to MIDI notes.

Chords lets you play chords by pressing a single key.

Humanizer adds randomization to the timing, velocity, and pitch of the notes you play.
Patterns combines the features of a polyphonic step sequencer and an arpeggiator.
Phrases lets you play musical phrases by pressing a single key.

Scale Lock maps the notes you play to a musical scale.

Velocity Curve lets you fine-tune how Kontakt responds to the velocity values you play.

Piano Uno instrument

Piano Uno offers a quick way of playing a sound when you open Kontakt Player, even if you have
not installed any other instruments. Its classic sound and immediacy make it a great session
starter when you just want to lay down an idea.

Piano Uno contains the following controls:

Piano Uno

O O O O

Noises Tone Stereo Reverb

Noises: Adjusts the level of noise produced by the instrument's hammer mechanism.
Tone: Adjusts the timbre of the sound from dark to bright.

Stereo: Adjusts the stereo width of the direct sound produced by the instrument.
Reverb: Adjusts the amount of convolution reverb added to the sound.

Reverb type: Selects the type of reverb by switching between three different impulse responses
for the convolution reverb.

+ Room: A chamber with a short reverb time for a more intimate reverb effect.
Hall: A classic concert hall with a long reverb time.

Space: A supernatural reverb effect with distinct echoes and a very long reverb time.
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Leap instrument

Leap is the standard sampler in Kontakt's Default view. It lets you play exciting combinations of
your loops and one-shot samples as well as curated Expansion kits. Use its engines to make each
sound your own, and create exciting performances with Macro knobs and black key effects.

Loading and saving Leap kits

This section shows you how to load kits and individual samples in Leap and how to save your own
Leap kits.

Loading samples and kits
You can load samples and kits into Leap using various methods:

In the side pane browser or in the Library browser, double-clicking a factory or user kit from the
Leap category will load the kit into Leap.

In the side pane browser or in the Library browser, double-clicking a sample from the Loops or
One-shots category will open a new empty Leap kit and load the sample into its first sample
slot.

Dragging and dropping samples from the side pane browser’'s Loops and One-shots categories,
or from a folder on your desktop:

You can drop the sample on an empty area of the Rack to open a new empty Leap and load
the sample into the first slot.

In a Leap instance in Single mode, you can drop the sample anywhere on the Keyboard
section to load it into the selected slot.

In a Leap instance in Group mode, you can drop the sample on a specific key of the
Keyboard section to load it into that slot. You can also drag and drop multiple samples at
once: The first sample will be loaded into the target slot and the remaining samples into the
following slots.

In a Leap instance with the Edit page open, you can drop the sample on the Waveform to
load it into the selected slot.

In a Leap instance in Group mode, you can [Ctrl]-click the desired key in the Keyboard section,
select Browse from the context menu, and choose a sample to load it into that slot.

@ In any case, loading a sample into a slot in Leap will replace the sample previously in
that slot (if any).

You can also start with an empty Leap kit by double-clicking in the empty space of the Rack, or by
selecting New Leap preset from the File menu in Kontakt's Header. You can then fill the Leap kit
with samples using any of the methods listed above.

Saving your own Kits
You can save the current state of the kit in Leap as a user kit:
1. Inthe Navigator at the top of the side pane, right-click the Leap’s slot to open the context menu.

2. Select Save Preset... from the context menu.
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3. Enter aname in the dialog and click Save to confirm.

- The kit is saved as a .nkl file on your computer and it will appear in your user content within the
Leap category, both in the side pane browser and in the Library browser.

If your kit is a modified version of a factory kit from a Leap Expansion, it will appear in the user
content of that Leap Expansion. If you have instead created the kit from scratch by opening an
empty Leap instance and filling it with samples, your kit will appear in the user content of a
dedicated Leap Expansion named Custom Kit.

Leap overview

Leap contains the following main elements and controls:

Rundu Kit LENP’  Afrobeats

MACROS
Select Preset
Cutoff Choral Bite Phasis Raum Charger Delay Reverb

» K % % 0 E mm < » c2
Start Key

O CO CO CO CO CO CO CO QO O O O O O O X
off C min

Quantize 1

Preset name: Shows the name of Leap preset currently loaded.

2. Expansion name: Shows the name of the Leap Expansion from which the preset is originating.
If you have modified a factory preset and save it as a user preset, this user preset will still
show the name of the original Leap Expansion. If you create a Leap preset from scratch, it will
belong to the dedicated Custom Kit Expansion.

3. Play: Opens the Play page, depicted above. This is the default page that appears when you
load Leap in Kontakt.

4. Edit: Opens the Edit page, where you can configure in detail the sound and the playback
behavior of each sample in the loaded kit.

5. Send FX: Opens the Send FX page, which lets you adjust the parameters of the two available
send effects.
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6. Perform FX: Opens the Perform FX page, which lets you assign the desired Perform effects to
the black keys on your keyboard and adjust their parameters.

7. Central area: This is the biggest part of the interface and it shows the various pages. In the
picture above, the central area shows the Play page, which includes an artwork specific to
each Expansion and the Macros below.

8. Keyboard: Lets you visualize and modify the key mappings used to trigger the samples and
the Perform effects from your MIDI keyboard. You can also switch your keyboard between
Group and Single modes. For more information, refer to Keyboard section.

Macros

The Macros are a set of eight controls displayed on the Play page below the artwork of the Leap
Expansion:

MACROS < ,

Select Preset
Cutoff Choral Bite Phasis Raum Charger Delay Reverb

Macro preset selector: Selects a set of eight Macros. You can click the preset name to open a
menu where you can select another Macro preset, or you can click the little left and right arrows
to quickly switch to the previous or next preset from the list. Each Leap Expansion provides its
own Macro presets. The Macro preset selector will collect the Macro presets available in every
Leap Expansion installed on your computer.

8 Macro controls: Adjust the various effects available in the selected set. The first six Macros
adjust six curated effects made for live performance. The last two Macros adjust your kit's
global send levels to the delay and reverb send effects, respectively.

Q- The eight Macros are also available on the first page of the Performance view on the
Kontrol S-Series keyboards.

@ The last two Macros (Delay and Reverb) control the global send levels for your kit. You
can also configure individual send levels for specific samples in your kit by using the
Delay and Reverb controls in the Output section located in the Sound panel of the Edit

page.

Keyboard section

The Keyboard section is always visible at the bottom of the Leap interface. It represents the key
mappings on your MIDI keyboard, lets you switch Leap between Group mode and Single mode, and
provides important keyboard-related settings.

» K Y G T 3 e m <= » C2
Start Key
AV OO OO 0 OO 0 OO 0 OO 0 OO O 0O ¥ OO

off C min

Quantize 1 2 3 4 5 6 7

In the top left corner of the Keyboard section, you can choose from the two operating modes
available in Leap:
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Group (default mode): In Group mode you can play the entire kit (up to 16 samples) with the
16 white keys (by default from C2 to D4), and use the 11 black keys in between to trigger
the Perform FX. For example, this mode is well suited for drum kits or loop sets. For more
information, refer to Group mode.

Single: The Single mode allows you to play one sample from the kit chromatically on all the
keys (both white and black). For example, this mode can be handy for samples of melodic
instruments. For more information, refer to Single mode.

Group mode

The Group mode is the default Leap operation mode. In Group mode you can play the entire kit (up
to 16 samples) with the white keys and use the black keys to trigger the Perform FX. Each sample
is played monophonically and all 16 samples are by default time-stretched and tuned to play well
together. For example, this mode is well suited for drum kits or sets of rhythmic loops.

In Group mode the Keyboard section contains the following elements and controls:
» % % 0 & mom o< » ez

= Start Key

off C min

Follow Quantize 1 2 3 4 5 6 7 8 9 10 il 12 13

Group/Single Mode switch: Switches between the Group mode and the Single mode.

Follow: Available only when the Edit page is displayed. If Follow is turned on, you can select
each sample by playing its corresponding key on your keyboard. For example, this can be useful
when adjusting the same parameter for multiple samples: you can quickly select the samples in
a row using your keyboard, and for each sample adjust the desired parameter.

Quantize: Quantizes the start time of the triggered samples to the next time division. By clicking
the displayed value you can select another time division to which the incoming notes should be
guantized. Or you can deactivate the input quantization by selecting Off from the menu. This
input quantization applies both to incoming MIDI notes and to your clicks on the sample slots,
but does not affect the black keys (Perform effects) nor the Single mode. For the quantization
to work, the playback must be active in your DAW (if Kontakt is running as a plug-in) or in the
Master Editor (if Kontakt is running as a standalone application).

Black keys (upper row): Each key represents a Perform effect. The effect is turned on as long
as you hold the key depressed (either in this Keyboard section or on your MIDI keyboard). You
can configure the Perform effect assigned to each key on the Perform FX page.

White keys (lower row): Each key represents a sample slot. Each sample can be triggered
by clicking the slot or pressing the corresponding key on your MIDI keyboard. The slots are
numbered from 1 to 16. As a reminder, the first key of each octave is indicated below the keys
(by default €2, €3, and C4). Various icons and actions are available on the slots depending on
their content and playback mode.

Start Key: Adjusts the lower end (or start key) of the key range used by Leap. This allows you
to adapt Leap to the physical key range available on your MIDI keyboard. You can set the Leap
range to start either on the C or on the F key in any octave from 0 to 4.
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Tonality: Specifies a global tonality for both Group mode and Single mode. In Group mode, the
samples for which the Global switch is turned on in the Tuning section of the Engine panel will
be transposed to match this global tonality. You can adjust the tonality using two menus: the
Key menu on the left sets the root note of the scale, and the Mode menu on the right selects its
scale mode between Major and Minor. Click either menu to select the desired value.

Tonality Lock: When the Lock is active, the Tonality values remains untouched when you load
another kit.

Icons and actions on the sample slots
In Group mode the slot icons indicate its contents and states:

Description

Slot containing a looped sample (Loop switch turned on in the Playback section
of the Engine panel on the Edit page).

Slot containing a one-shot sample (Loop switch turned off in the Playback
section of the Engine panel on the Edit page).

Empty slot.

Selected slot (indicated by the circle). This icon is visible only on the Edit page
and it is displayed in addition to the loop/one-shot/empty icon.

Playing slot. The progress bar is displayed in addition to the other icons. When
the sample is triggered, the bar starts from the top and runs clockwise along the
slot border. A full cycle around the slot corresponds to a full play range or loop
range of the sample.

In addition, in Group mode the following slot actions are available:

Clicking the icon of the selected slot switches between the Play page and the Edit page.
Clicking the icon of an unselected slot selects the slot and opens its Edit page.
Clicking a slot outside its icon triggers the sample.

If the Edit page is open and Follow is on, clicking a slot outside its icon triggers the sample and
selects the slot, the slot details showing up in the Edit page above.
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When hovering over a slot with the mouse, a little keyboard icon appears below the slot:
Clicking the keyboard icon selects this slot and directly switches to Single mode so that you
can play that sample chromatically.

2

3

[Ctrl]-clicking (Windows) or [command]-clicking (Mac) a slot outside its icon opens a context
menu with the following editing commands:

Duplicate

Browse k‘

REN NG 4

Duplicate: Copies the sample and all its settings into the next free slot on the right. The
duplicate is automatically selected and its Edit page opens up. If there is no free slot on the
right, nothing happens.

Browse: Opens a Locate Sample dialog that lets you browse your file system and select
another sample. When you click Open in the dialog, the selected sample is loaded into the
slot, replacing its previous sample, if any.

Remove: Removes the sample from the slot, leaving the slot empty.

Single mode

In Single mode you can play the sample from the selected slot chromatically across the entire key
range of your external keyboard.

In Single mode the Keyboard section contains the following elements and controls:

Single

12 Guitar[110] Cm Run... Scaled

0 C min

Octave

Group/Single Mode switch: Switches between the Group mode and the Single mode.
Sample info: Shows the number (1 — 16) of the selected slot and the name of its sample.

Octave: Transposes the key range available in the Keyboard section by octaves (from -2 to +3
octaves). This key range is indicated by a different color on Kontakt's on-screen keyboard and
on the Light Guide of the Kontrol S-Series keyboards.

Black and white keys: Trigger the sample at different pitches. As a reminder, the first key of
each octave is indicated below the white keys (by default C2, C3, and C4).

Scaled: When activated, all the played keys will be quantized to the scale defined by the
Tonality control: If you play a note outside that scale, it will be quantized to the nearest note
within the scale.
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Tonality: Specifies a global tonality for both Group mode and Single mode. In Single mode, this
global tonality serves as a reference when quantizing the pitch of the played notes using the
Scaled switch. You can adjust the Tonality parameter using two menus: the Key menu on the
left sets the root note of the scale, and the Mode menu on the right selects its scale mode
between Major and Minor. Click either menu to select the desired value.

Tonality Lock: When the Lock is active, the Tonality values remains untouched when you load
another Kit.

Edit page
The Edit page lets you adjust the settings of the sample in the selected slot in detail.
» Click Edit at the top right of the instrument to display the Edit page.

Looping Gang 2 LENP'Custom Kit

Recording_2024-09-09_13h09m09s Vo 6
00:01 / 127.84bpm / Cmin ’ ’

THRESHOLD  SNAPTO

Auto [ ] Grid
s

Engine

YPE TEMPO TUNING

( C 12784 ( C min 0.00

Slice Atk  Slice Rel BPM Speed Tonality Tune

Bar

Quantize

1. Sample info: Shows the sample name, length, tempo, and key.

2. Grid settings: Adjust the beat grid, which defines the position of the beats in the sample. The
beat grid can be used, for example, to position the loop markers precisely on the beats. For
more information, refer to Grid settings.

3. Stripe: Shows a minimized version of the sample waveform. The Stripe also indicates the
position of the beat grid of the white start/end markers and green loop markers (if any). The
Stripe provides a frame defining the part of the sample that is displayed in the Waveform
below. You can click the left or right end of the frame and drag it horizontally to shrink
or extend the displayed portion. You can also click inside the frame and drag your mouse
horizontally to move the displayed portion across the timeline, or vertically to zoom in/out in
the sample waveform. A double-click anywhere in the Stripe will reset the frame and show the
entire sample.
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4. Waveform: Shows a detailed version of the sample waveform. The time grid is indicated by
vertical dark gray lines. A pair of white markers labeled S and E define the start and end points
of the playback range, respectively. The portions of the waveform outside the playback range
are grayed out. When the sample is triggered, the playback starts from the S marker. If the
looped playback is off, the playback will stop on the E marker. If the looped playback is on,
a pair of green markers define the loop range (the sample end marker is then ignored). You
can move all these markers to the desired positions by clicking them and dragging the mouse
horizontally.

5. Sample settings: Lets you adjust the settings of the sample in detail. The sample settings
are split into two panels: the settings on the Engine panel affect the playback engine, while
settings on the Sound panel control the sound character of the sample.

6. Voice settings: Adjust the polyphony of the selected sample. The Voice settings affect only
the Single mode. In Single mode, the selected sample can be played back multiple times
simultaneously, for example by pressing multiple keys at the same time on your keyboard.
Each time that the sample is played, it uses one “voice” The Voices selector specifies the
maximum number of voices (from 1 to 16) available at any time for the sample playback, that
is, it defines how many times the sample can be played back simultaneously. If this maximum
number of simultaneous voices has been reached and the sample is triggered one more time,
the oldest sounding voice will be cut to make room for the new one. You can adjust the Voices
value by clicking the value and dragging your mouse vertically, or by clicking the little up and
down arrows next to it. The Mono button lets you directly switch to a maximum of one single
voice only. In Group mode, the Voice settings are grayed out and inactive.

Grid settings

The grid settings let you configure the beat grid, which defines the position of the beats on the
timeline. Once the beat grid has been set, you can move the sample’s start, end, and loop markers
precisely onto the beats. The beat grid is displayed in the Stripe and in the Waveform using vertical
dark gray lines. As you change the grid settings, the beat grid is automatically updated in both
displays.

The grid settings contain the following elements and controls:

THRESHOLD SNAP TO

O Grid

GRID: Selects the mode used to set the beat grid. Selecting Off deactivates the grid completely.
In Fix mode the grid uses a fixed time duration between beats throughout the sample. In Auto
mode Kontakt sets the beats automatically by detecting the transients in the sample. If you
have loaded a REX file, an additional REX mode lets you use the grid information stored in the
REX file.

WIDTH (grid in Fix mode only): Selects the duration between beats, measured in fractions of
the sample duration according to its playback speed. The available values go from 1/1 to 1/64.
For example, selecting 1/8 will create by default 8 beats across the sample.

THRESHOLD (grid in Auto mode only): Adjusts the sensitivity of the transient detection.
Increasing THRESHOLD will result in detecting more beats.

SNAP TO: Selects what the start, end, and loop markers should snap to when you move them
across the sample. Selecting Off deactivates snapping completely. Selecting Grid will let the
markers snap to the beats, which allows rhythmic samples to start and loop perfectly on
the beat. Selecting Zero-X will let the markers snap to the nearest position where the audio
signal crosses the zero value, which reduces possible clicks between samples or at the looping
transition.
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@ When Sync is on in the Tempo section of the Engine panel, the number of beats
appearing in the Waveform will depend not only on the Width value but also on the
Speed value (also in the Tempo section): For example, if Speed is set to x 2 the
sample will play at double speed, effectively playing twice in the time of the original
sample: As a result, the Width value of 1/8 will create 8 beats over two samples, which
makes only four beats across one sample: The Waveform, which always shows one
sample, will display only these four beats.

Engine panel
The Engine panel lets you choose a playback engine and configure the playback details for the
selected sample.

p» Click Engine at the bottom left of the Waveform to display the Engine panel.

The Engine panel contains the following sections:

Engine

TYPE TEMPO TUNING Global

m ¢ C 127.84  x1 C min  0.00

Slice Atk  Slice Rel BPM Speed Tonality Tune

Type section: Selects a playback engine and configures its dedicated parameters. Refer to
Type section for more information.

Tempo section: Adjusts the tempo-related settings of the sample. Refer to Tempo section for
more information.

Tuning section: Adjusts the tonality of the sample. Refer to Tuning section for more
information.

Playback section: Adjusts how the sample should be played. Refer to Playback section for
more information.

In the top right corner, the Sound panel provides two additional switches:

Perform FX ( ® Macro FX (@

Perform FX switch: This switch is on by default. If you turn it off (switch to the left), the sample
will not be processed by the Perform effects. For example, with this switch you can prevent a
pad sound or texture from being processed by a time-synchronized Perform effect that might
only be suitable for the drum samples of your kit.

Macro FX switch: This switch is on by default. If you turn it off (switch to the left), the sample
will not be processed by the global effects controlled using the Macros.

Type section

The first control in the Type section of the Engine panel is the Engine selector, which lets you
select the playback engine to use with the selected sample:
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The remaining parameters in the Type section will vary depending on the selected engine: Classic,
Melody, or Beats.

Classic engine

The Classic engine offers true old school polyphonic synth vibes. With this engine the sample
cannot be synchronized with the tempo. Based on Kontakt's original Sampler engine, the Classic
engine provides the following controls:

@ Neutral

Classic Style

Reverse: Plays the sample in reverse. Note that when this button is activated, the playback will
start at the end marker (E) of the sample, so if there are a few seconds of silence at the end of
the sample, the sound will be delayed.

Style: Selects from three engine modes. The Neutral mode is the default, unaltered engine
mode. The §1200 and MP60 are two “vintage machine” modes. They emulate two classic
samplers of the 80s, degrading the playback quality of the sample and changing how Kontakt
changes the pitch and basic handling of the sample playback engine.

Melody engine

The Melody engine is based on Kontakt's Time Machine Pro engine. This engine allows a high
quality real-time time-stretching of your sample without affecting its pitch. It provides the following
controls:

Ip C

Shift  Env Order

Reverse: Plays the sample in reverse. Note that when this button is activated, the playback will
start at the end marker (E) of the sample, so if there are a few seconds of silence at the end of
the sample, the sound will be delayed.

HQ: Turns the high quality mode on or off. When HQ is on, you can adjust the advanced
parameters described below.
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Formants: When this is on, the formants are preserved when pitch-shifting or time-stretching
the sample.

Shift (Formant Shift): Sets the spectral envelope’s shift factor. The default is set to 100 %, which
works fine for most material. This spectral shift is performed before the overall pitch shifting.

Env Order (Envelope Order): Sets the order of the spectral envelope (formant) estimation. The
default is set to 128, which works fine for most material. If the input audio is really high pitched
the order should be lowered, similarly, if the input audio is low pitched the value should be
raised.

@ The Melody engine uses more CPU resources than the other engines.

Beats engine

The Beats engine is based on Kontakt's Beat Machine engine. This engine allows automatic
slicing of your sample for tempo-synchronized playback, which makes it well-suited for rhythmic
materials like drum loops. It provides the following controls:

m ¢ C

Slice Atk Slice Rel

Reverse: Plays the sample in reverse. Note that when this button is activated, the playback will
start at the end marker (E) of the sample, so if there are a few seconds of silence at the end of
the sample, the sound will be delayed.

Slice Atk (Slice Attack): Since slicing can occur at spots in your sample that can cause clicks
when played back in isolation, slices are being crossfaded into each other instead of just
played back in succession. This control adjusts the attack time of the crossfade envelopes. As
large values can weaken your transients, you should generally adjust this control to the lowest
possible value that just avoids clicking.

Slice Rel (Slice Release): Adjusts the release time of the crossfade that occurs between slices.

Tempo section

When a sample is loaded into Leap, its tempo is automatically detected. This tempo is the
foundation of the tempo synchronization. The Tempo section of the Engine panel lets you adjust
the detected tempo and define how this tempo should be used. The section contains the following
controls:
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BPM: Lets you manually correct the tempo of the sample. Most of the time you will not have to
use it, since the tempo is detected automatically. The BPM control rather serves as a backup if
the tempo detection algorithm does not provide satisfying results. You can adjust the tempo by
clicking the displayed value and dragging your mouse vertically. Holding [Shift] while dragging
allows for finer adjustments. Alternatively you can double-click the value and enter a new value
using your computer keyboard.

Sync (Melody and Beats engines only): When this is on, the sample’s playback speed is
changed to match Kontakt's global tempo (which is the tempo of your DAW if Kontakt is
running as a plug-in).

Speed (Melody and Beats engines only): If Sync is on, the Speed control lets you double or
halve the playback speed of the sample, which can help quickly correct the detected tempo. If
Sync is off, the Speed control lets you freely adjust the playback speed of the sample relative to
its original tempo as set by the BPM control.

@ If the Classic playback engine is selected in the Type section on the left, the sample
cannot be synchronized to the tempo of your DAW, and the Sync and Speed controls
are grayed out and inactive. To make them available, first switch to another playback
engine.

Tuning section

When a sample is loaded into Leap, its tonality is automatically detected. This tonality is the
foundation of the tonality matching between samples. The Tuning section of the Engine panel lets
you adjust the detected tonality. It contains different controls depending on whether Leap is in
Group mode or in Single mode.

In Group mode the Tuning section contains the following controls:

TUNING Global

=2

C min 0.00

Tonality Tune

Tonality: Lets you manually correct the tonality of the sample. Most of the time you will not
have to use it, since the tonality is detected automatically. The Tonality control rather serves as
a backup if the tonality detection algorithm does not provide satisfying results. You can adjust
the Tonality parameter using two menus: the Key menu on the left sets the root note of the
scale, and the Mode menu on the right selects its scale mode between Major, Minor, and No
Mode. Click either menu to select the desired value. If you select None from the left Key menu,
no tonality is assigned to the sample, and no tonality matching can be applied.

Global: When this is on, the sample is transposed to match the global Tonality value defined in
the Keyboard section. The amount of transposition is indicated by a number appearing above
the sample’s own Tonality value.

Tune: Detunes the sample by the displayed value, measured in semitones. To change the value,
click it and drag your mouse vertically, or click the little up/down arrows next to it. By holding
[Shift] as you drag the mouse or click the arrows, you can adjust the value in much finer
increments (cents).
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In Single mode the Tuning section contains the following controls:

TUNING

C3 0.00

Root Tune

Root: Defines the key triggering the original, unpitched sample. All other keys will trigger a
transposed version of the sample corresponding to their pitch relative to the root key.

Tune: Detunes the sample by the displayed value, measured in semitones. To change the value,
click it and drag your mouse vertically, or click the little up/down arrows next to it. By holding
[Shift] as you drag the mouse or click the arrows, you can adjust the value in much finer
increments (cents).

Playback section

The Playback section of the Engine panel specifies the playback behavior of the sample. The
section contains the following controls:

PLAYBACK

Hold

Trigger Style

Loop: Turns the looped playback on or off. When Loop is on, the Waveform shows a pair of
green loop markers that let you define which part in the sample should be played in loop. In
Group mode, the looped state of each sample is indicated by a dedicated icon on its sample
slots in the Keyboard section.

Trigger Style: Defines the playback behavior when you release the key. When Loop is off, you
can select between Hold (the sample stops playing when you release the key) and One-Shot
(the sample plays until its end marker even if you release the key). When Loop is on, you can
select between Hold (the loop stops playing when you release the key) and Latch (the loop
keeps playing until you press the key another time).

Choke (Group mode only): Assigns the sample to a particular choke group. A choke group is
a set of “mutually exclusive” samples: Within a choke group, each newly triggered sample will
cancel an older sample still playing, so that these samples would never play together. Four
choke groups are available in each kit. You can assign the desired samples to a choke group by
selecting the same Choke value for each of them. You can adjust the Choke value by clicking it
and dragging your mouse vertically, or by using the little up and down arrows next to it.

Wrap / Ping Pong selector (Classic engine only): When Loop is on, a Wrap / Ping Pong selector
appears and lets you choose between two looping variants. If you select Wrap (default setting),
as the playback reaches the loop end it will jump back to the loop start and continue from there.
If you select Ping Pong, the loop will play alternately back and forth.

Legato (Melody engine only): When Legato is on, if a previous sample is still playing the
playback will not start from the sample’s start marker, but instead it will follow the play position
of the previous sample. If no other sample is playing, the playback will start as usual from the
sample’s start marker.
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Sound panel

The Sound panel lets you configure the audio processing that will affect the sound of the selected
sample.

» Click Sound at the bottom left of the Waveform to display the Sound panel.

The Sound panel contains the following sections:

@ FILTER

Neutral P Cutoff Reso  Keytrack Attack Release Volume Pan Delay Reverb

Filter section: Adjusts a filter applied to the sample. Refer to Filter section for more
information.

Amp section: Adjusts the envelope of the amplification stage. Refer to Amp section for more
information.

Output section: Adjust the output stage including global volume, pan, and effect levels. Refer to
Output section for more information.

In the top right corner, the Sound panel provides two additional switches:

Perform FX switch: This switch is on by default. If you turn it off (switch to the left), the sample
will not be processed by the Perform effects. For example, with this switch you can prevent a
pad sound or texture from being processed by a time-synchronized Perform effect that might
only be suitable for the drum samples of your kit.

Macro FX switch: This switch is on by default. If you turn it off (switch to the left), the sample
will not be processed by the global effects controlled using the Macros.

Filter section
The Filter section of the Sound panel contains the following controls:

® FILTER

o @

Neutral Cutoff Reso  Keytrack

FILTER On/Off: Turns the filtering of the sample on or off.
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Filter Flavor selector: Selects from the following filter flavors:

Neutral: Clean characteristic that can be used for all kinds of audio signals. This flavor uses
Kontakt's State Variable (SV) filters in their 2-pole variant, which attenuates frequencies
below/above the cutoff at a rate of -12 dB/octave.

Juicy: First choice for synthetic sounds, but can work well on any signal. This flavor uses
Kontakt's Ladder filters in their 4-pole variant, which attenuates frequencies below/above
the cutoff at a rate of -24 dB/octave.

Mild: Works best on full loops or drums. This flavor uses Kontakt's Adaptive Resonance
(AR) filters, which follow the amplitude of the input signal and adjust the resonance
accordingly. At higher input levels, the resonance will reduce, and at lower levels it will
increase, this avoids unpleasant peaks.

Aggressive: More aggressive synthesizer filter design. This flavor uses Kontakt's Daft filters,
which have been adapted from Massive. These filters have a 2-pole response, which
attenuates frequencies below/above the cutoff at a rate of -12 dB/octave.

Frequency Response display: Shows an overview of the frequency response resulting from
your current filter settings.

Filter Type selector: Selects from the following filter types:

LP (Lowpass): Attenuates signals above the cutoff frequency, allowing low frequency
signals to pass through.

HP (Highpass): Attenuates signals below the cutoff frequency, allowing high frequency
signals to pass through.

BP (Bandpass, not available for the Aggressive filter flavor): Attenuates signals below and
above the cutoff frequency.

Cutoff: Adjusts the frequency below or/and above which signals will be attenuated.

Reso (Resonance): With a value greater than 0, this control will boost a small frequency range
around the cutoff frequency.

Keytrack: Modulates the Cutoff frequency value according to the played key.

Gain (Aggressive and Juicy filter flavors only): Controls the amplitude increase after the filter.
This control can be used to compensate for amplitude reduction due to the filter, or to increase
the soft saturation of the effect.

Amp section
The Amp section of the Sound panel contains the following controls:

c

Attack Release

AMP On/Off: Turns the processing of the sample by the Amp stage on or off.

Attack: Adjusts the attack time of the sample, that is, the time it takes the sample to reach its
full volume level after it has been triggered. Turning the knob to the right will result in a slower,
more progressive attack phase.
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Release: Adjusts the release time of the sample, that is, the time it takes the sample to fade out
once you have release the key. Turning the knob to the right will result in a longer fade out.

Output section
The Output section of the Sound panel contains the following controls:

OUTPUT

Volume Pan Delay Reverb

Volume: Adjusts the overall volume level of the sample, from -inf (no sound) to +12 dB
(maximum amplification). The default value is 0 dB (no change in volume).

Pan: Adjusts the position of the sample in the stereo field. With the knob at full left or at full
right, the sample is sent only to the left channel or right channel, respectively. By default it is
sent to both channels equally (knob in the center position).

Delay and Reverb: Adjust the levels of the signal sent from this sample to the delay and reverb
send effects, respectively. For example, this allows you to keep particular samples from being
processed by a send effect when you raise the global send level available in the Macros.

Send FX page
The Send FX page lets you configure the two send effects available in Leap.

p Click Send FX at the top right of the instrument to display the Send FX page.

Send FX
—

The Send FX page contains two sections:

Funkateer Kit LENP 'Disco & Funk Send FX

Send A Delay Send B Reverb

Predelay Size

@ Q). LD

3

Low Cut High Cut Low Shelf High Cut




INSTRUMENTS AND TOOLS 54

In the left half, the Send A section contains the parameters for the Delay effect.

In the right half, the Send B section contains the parameters for the Reverb effect.

Delay
The Delay effect can be switched between three different modes, Replika, Psyche, and Twin.

» To select a mode, click on the corresponding entry in the Delay selector at the top of the Send A
section.

PSY

Send A Delay

Replika

Replika mode provides the following controls:

Time Feedback

m

Low Cut High Cut

Sync (note icon): When Sync is on, the delay is synchronized with the main tempo of Kontakt
(which is the tempo of your DAW if Kontakt is running as a plug-in). In that case the Time
parameter is measured in note values.

Note Division menu (little down arrow): When the Sync button above is on, this selects whether
the Time parameter should include straight, triplets, or dotted note values.

Time: Adjusts the delay time. The time is measured in milliseconds (if Sync is off) or in note
values (if Sync is on).

Feedback: Adjusts the level of the signal that is fed back to the delay's input. Increasing
Feedback adds delay repeats. Levels above 100% create swelling echo repeats up to self-
oscillation.

Low Cut: Cuts low-frequency content in the feedback path of the delay with a non-resonant
filter. Turned fully counter-clockwise, the filter is off.

High Cut: Cuts high-frequency content in the feedback path of the delay with a non-resonant
filter. Turned fully clockwise, the filter is off.
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Stereo: When activated, the modulation between the left and the right channel is offset in time,
resulting in a wide stereo effect. When deactivated, the modulation affects both channels in the
same way.

Gain: Adjusts the effect’s return level.

Ping Pong: Switches the Ping Pong effect on and off. When on, the delay repeats are panned
hard left and right in an alternating pattern.

Psyche
Psyche mode provides the following controls:

Send A Delay

{

Feedback

~

(

LR Offset

Sync (note icon): When Sync is on, the delay is synchronized with the main tempo of Kontakt
(which is the tempo of your DAW if Kontakt is running as a plug-in). In that case the Time
parameter is measured in note values.

Note Division menu (little down arrow): When the Sync button above is on, this selects whether
the Time parameter should include straight, triplets, or dotted note values.

Time: Adjusts the delay time. The time is measured in milliseconds (if Sync is off) or in note
values (if Sync is on).

Feedback: Adjusts the amount of feedback. Turning Feedback to the right increases the
amount of delay repetitions.

Pitch: Adjusts the pitch of the echo repeats in the range of -12 to +12 semitones. Combined
with feedback you can use this to create progressively harmonized echo cascades.

LR Offset: Adjusts the amount of time deviation between the two stereo channels, resulting in
wide stereo echos.

Gain: Adjusts the effect’s return level.
Reverse: Reverses the playback of subsequent delay repeats.



Twin

Twin mode provides the following controls:

Send A Delay

(ﬁ
Time L TimeR

Q). G) "on .G

\ 4

Feedback L Level L Level R Feedback R

{,\
(
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Time L/R: Adjusts the delay time in milliseconds. To synchronize the time to your host or
master editor tempo, click the Time unit display (ms) and chose a note length value from the

drop down menu.

Feedback L/R: Adjusts the amount of feedback. Turning Feed to the right increases the amount

of delay repetitions.

Level L/R: Adjusts the output level of the delay channel.

Gain: Adjusts the effect’s return level.

Reverb

The Reverb effect can be switched between three different modes, Raum, Galois, and Plate.

» To select a mode, click on the corresponding entry in the Reverb selector at the top of the Send

B section.

Send B Reverb

GALOIS

V]
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Raum
Raum mode provides the following controls:

Send B Reverb

Predelay

Low Shelf High Cut

Gain

Sync button (note icon): When Sync is on, the predelay of the reverb is synchronized with the
main tempo of Kontakt (which is the tempo of your DAW if Kontakt is running as a plug-in). In
that case the Pre Delay parameter is measured in note values.

Note Division menu (little down arrow): When the Sync button above is on, this selects whether
the Pre Delay parameter should include straight, triplets, or dotted note values.

Pre Delay: Adjusts the duration of the predelay, which is the time it takes for the reverb effect
to set in. By increasing the predelay, you can add separation between the input signal and the
reverb signal. The predelay is measured in milliseconds (if Sync is off) or in note values (if Sync
ison).

Size: Adjusts the swell and reflection pattern of the reverb effect, creating the impression of
differently sized spaces. Turning the control to the right changes the size from small to large.

Low Cut: Attenuates low-frequency content of the reverb effect and the predelay’s feedback
signal by applying a low-shelf filter in the range of 0 to -24 dB. Turning the control to the left
decreases the attenuation. Turning the control to the right increases the attenuation. Turning
the control fully to the left switches the filter off.

High Cut: Attenuates high-frequency content of the reverb effect and the predelay's feedback
signal by applying a high-cut filter in the range of 90 kHz to 1 kHz. Turning the control to the left
increases the attenuation. Turning the control to the right decreases the attenuation. Turning
the control fully to the right switches the filter off.

Gain: Adjusts the effect’s return level.
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Galois
Galois mode provides the following controls:

High Cut

Time: Adjusts the duration of the reverb effect.

Size: Adjusts the size of the room simulated by the reverb effect. Higher values replicate larger
rooms.

Low Shelf: Attenuates or amplifies the low-frequency content of the reverb signal.
High Cut:: Cuts the high-frequency content of the reverb signal.

Mod: Adjusts the amount of modulation applied to the reverb effect. Turned fully counter-
clockwise, no modulation is applied.

Gain: Adjusts the effect’s return level.

Plate
Plate mode provides the following controls:

V d
/

L |

\ 3

Predelay Decay

=l
v//b

Low Shelf Damping

Predelay: Introduces a short amount of delay before the reverb takes effect.
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Decay: Adjusts the duration of the reverb effect.

Low Shelf: Attenuates or amplifies the low-frequency content of the reverb signal.
Damping: Adjusts the damping of high-frequency content of the reverb signal.
Gain: Adjusts the effect’s return level.

Perform FX page

The Perform FX page lets you configure the Perform effects available on the black keys of your
keyboard when Leap is in Group mode.

@ When Leap is in Single mode, the black keys do not trigger any Perform FX but the
pitched sample instead, like the white keys. In this chapter we assume that Leap is in
Group mode. For more information on the Group and Single modes, refer to Keyboard
section.

p Click Perform FX at the top right of the instrument to display the Perform FX page.

Perform FX

The Perform FX page shows 11 columns corresponding to the 11 black keys used for triggering
Perform FX:

Patience Kit

»

DOUBLE TIME

HALF TIME

Off

Quantize

c

Buzz

P1

Pattern

(@)

Mix

«

5
2

4

v

c
c

Rotate
Wrap
1/8

Length

Reverse

(@)

4

LENP 'Soul Goilcl

6

/]\

Noise

OCTAVE UP

c

Shape

Stutter

(@)

M T

A0 0 0 0 0O O O WO W o

N

OCTAVE DOWN

&5

v

c
c

Grain

Forward

O .0

Mix

L4

=

c

Amount

c

2 Bars

Mix

&5

v

c

Pitch
Grain
Invert

Forward

Mix

A0 0 0O O O

Perform FX

»

DOUBLE TIME

(67

Start Key

B min

The columns are in the same order as the black keys in the Keyboard view below, each column

controlling one particular black key:
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Black keys in a group of two (C# and D#) are assigned to either pair of Perform effects:
Double Time / Half Time or Octave Up / Octave Down. This assignment is fixed and cannot be
changed.

Black keys in a group of three (F#, G#, and A#) can be assigned to any of the following five
Perform effects: Gater, Beat Masher, Beat Slicer, Reverse Grain, Transpose Stretch. You can
change these assignments to your liking.

The rightmost single black key is always assigned to the Double Time Perform effect.

You can activate or deactivate the Perform effect for any single key by clicking the topmost icon in
the column:

p Click the effect icon at the top of the desired column to activate or deactivate the Perform
effect for the corresponding black key.

- When a Perform effect is deactivated, its icon is grayed out at the top of the column and in the
Keyboard view below, and the effect will not be triggered when you press the key.

Double Time and Half Time

The Double Time effect doubles the playback speed of the samples, whereas the Half Time effect
halves it.

» K

Effect icon: Switches the effect on or off for the corresponding key. When the effect is off, its
icon is grayed out and the effect will not be triggered when you press the key.

Octave Up and Octave Down

The Octave Up and Octave Down effects transpose the samples one octave upward and
downward, respectively.

T \2

Effect icon: Switches the effect on or off for the corresponding key. When the effect is off, its
icon is grayed out and the effect will not be triggered when you press the key.

Gater

Gater rhythmically mutes the incoming audio to create the classic gating effect. With the internal
noise source, it can be used as a rhythmic sound generator.

Pressing and holding the black key turns the effect on until you release the key.

The effect contains the following controls:
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Stutter

@

Effect icon: Switches the effect on or off for the corresponding key. When the effect is off, its
icon is grayed out and the effect will not be triggered when you press the key.

Effect menu (down arrow): Selects a Perform effect for that key. You can choose from the
following effects: Gater, Beat Masher, Beat Slicer, Reverse Grain, and Transpose Stretch. If you
select None, no effect will be assigned to the key.

Rate: Adjusts the rate of the gating effect.

Sync (note icon): Synchronizes Rate to Kontakt's main tempo. When Sync is on, Rate can be
set in note values relative to the main tempo of Kontakt (which is the tempo of your DAW if
Kontakt is running as a plug-in). In that case Rate is measured in note values and can be set to
Off,1/4,1/8,1/16, and 1/32.

Noise: Adjusts the amount of hissing noise added to the signal.

Wet: Mutes the input signal so that only the effect signal can be heard. When combined with
the Noise control, the Gater can be used as a rhythmically gated noise source .
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Shape: Adjusts the hold and decay times of the gating effect’s contour.
Turned fully left: 1% hold, 0% decay
Center position: 50% hold, 0% decay
Turned fully right: 0% hold, 100% decay

Stutter: Sets the gating time to a 3/16 note, producing a stuttering effect.

Mix: Blends between the input signal and the effect signal.

Beat Masher

Beat Masher captures a loop from the incoming audio and manipulates it by applying rhythmic
stutter, gating, repeater, and reverse effects in real time.

Pressing the black key starts the effect by recording the input signal into the internal buffer.

The effect contains the following controls:

Reverse

O

Effect icon: Switches the effect on or off for the corresponding key. When the effect is off, its
icon is grayed out and the effect will not be triggered when you press the key.
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Effect menu (down arrow): Selects a Perform effect for that key. You can choose from the
following effects: Gater, Beat Masher, Beat Slicer, Reverse Grain, and Transpose Stretch. If you
select None, no effect will be assigned to the key.

Gate: Grabs and plays slices of audio from the internal buffer. When turned fully to the left, the
effect is bypassed. When turned right towards center position, increasingly longer slices are
played. When set to center position, the full buffer is played. When turned right from the center
position, increasingly longer slices of audio are cut, creating a gating effect.

Rotate: Shifts the audio from the buffer relative to its original position in steps of 1/8 notes.
Wrap: Restarts the effect from the start of each bar independently from the Length setting.
Length: Adjusts the length of the audio from the internal buffer, measured in note values.
Reverse: Reverses the playback direction of the audio from the internal buffer.

Mix: Blends between the input signal and the effect signal.

Beat Slicer

Beat Slicer captures a loop from the incoming audio and manipulates it by rearranging slices into a
variety of rhythmic patterns in real time.

Pressing the black key starts the effect by recording the input signal into the internal buffer.

The effect contains the following controls:
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i
(

Buzz

P1

Pattern

Effect icon: Switches the effect on or off for the corresponding key. When the effect is off, its
icon is grayed out and the effect will not be triggered when you press the key.

Effect menu (down arrow): Selects a Perform effect for that key. You can choose from the
following effects: Gater, Beat Masher, Beat Slicer, Reverse Grain, and Transpose Stretch. If you
select None, no effect will be assigned to the key.

Buzz: Creates a rolling beat effect by repeating beats from the current pattern. Turning the
control to the right increases the rate of repetition.

Pattern: Selects a pattern from the group set using Style. The first pattern in each group plays
back the unaltered audio from the buffer.

Gate: Gates the audio based on a rhythm derived from another pattern, creating infinite
variations through combination of the playback and gating patterns. When activated, the Buzz
control is inactive.

Style: Selects one of five groups of patterns.

2 Bars: Extends the audio used from the buffer to two bars. Otherwise only the first bar of audio
is used.

Mix: Blends between the input signal and the effect signal.
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Reverse Grain

Reverse Grain captures a loop from the incoming audio and applies granular processing to it,
including control over playback direction, pitch, and grain size.

Pressing the black key starts the effect by recording the input signal into the internal buffer.

@ This effect needs a few seconds of audio input to work, if it stays silent, make sure to
play a loop and trigger it again.

The effect contains the following controls:

Invert

c

Forward

@]

Effect icon: Switches the effect on or off for the corresponding key. When the effect is off, its
icon is grayed out and the effect will not be triggered when you press the key.

Effect menu (down arrow): Selects a Perform effect for that key. You can choose from the
following effects: Gater, Beat Masher, Beat Slicer, Reverse Grain, and Transpose Stretch. If you
select None, no effect will be assigned to the key.

Pitch: Adjusts the pitch of the audio from the internal buffer. When turned fully to the right, the
pitch is unaltered. Turning Pitch to the left pitches the audio down.
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Grain: Adjusts the size of the grains used to process audio from the internal buffer. Interesting
effects can be achieved when combined with the Speed control.

Invert: Plays the grains in reversed order.

Speed: Adjusts the playback speed of the grains used to process audio from the internal
buffer. When turned fully to the right, the playback speed is unaltered. Turning Speed to the left
reduces the playback speed.

Forward: Inverts the playback direction to forward.
Mix: Blends between the input signal and the effect signal.

Transpose Stretch

Transpose Stretch captures a loop from the incoming audio and manipulates it by means of
granular pitch-shifting and time-stretching. You can use it to radically transform the sound.

Pressing the black key starts the effect by recording the input signal into the internal buffer.

The effect contains the following controls:

Amount

C

Effect icon: Switches the effect on or off for the corresponding key. When the effect is off, its
icon is grayed out and the effect will not be triggered when you press the key.
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Effect menu (down arrow): Selects a Perform effect for that key. You can choose from the
following effects: Gater, Beat Masher, Beat Slicer, Reverse Grain, and Transpose Stretch. If you
select None, no effect will be assigned to the key.

Amount: Adjusts the amount of time-stretching. Turning Amount to the right slows the audio
from the internal buffer down until it freezes using a single grain.

Size: Adjusts the size of the grains used to process audio from the internal buffer. When turned
fully to the left, large grains of 333 ms length are produced. When turned fully to the right, small
grains of 5 ms length are produced. The Size control only has an effect when Grain is activated.

Grain: Activates grain size adjustment using the Size control. When deactivated, the grain size
is automatically optimized for best pitch-shifting results

Key: Adjusts the pitch of the grains used to process audio from the internal buffer in semitones.
When turned fully to the left, the grains are pitched down by 60 semitones, or 5 octaves. In
center position, the original pitch is maintained. When turned fully to the right, the grains are
pitched up by 12 semitones, or 1 octave.

2 Bars: Extends the audio used from the buffer to two bars. Otherwise only the first bar of audio
is used.

Mix: Blends between the input signal and the effect signal.

Arpeggiator
Arpeggiator transforms the notes you play into a rhythmic sequence.

The Arpeggiator Tool contains the following elements:

Arpeggiator ' Tool

16 1/16 0% 100% 0

Ll Steps Rate Swing Duration

Octave

Note Order 1 X

As Played v Repeat
Table Order

Forward v Scale by Velocity

Disable: Bypasses the Tool.

Latch: Holds all played keys.
Note Order: Sets the playback order of input notes.

Table Order: Sets how velocities are read from the pattern table. In Host Sync, playback aligns
with the song position.

Steps : Sets the number of steps in the rhythmic pattern.
Rate: Sets the rate of the arpeggiator in fractions of a beat related to the host tempo.
Swing : Sets the amount of swing in the groove.

Duration : Sets the duration of the arpeggiated MIDI notes in percent. This will change the
length of the MIDI notes and not the volume envelope.

Octave : Adjusts arpeggio pattern across octaves, cycling from the played octave up or down
based on the set range.

Repeats : Sets how many times each note is repeated in the pattern.

Scale by Velocity : Scales input velocity by grid values, or uses the pattern table when off.
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Chord Builder

Chord Builder adds additional harmonies to MIDI notes in relation to a specified key and scale. Up
to 5 notes can play with each incoming MIDI note.

The Chord Builder Tool contains the following elements:

Chonrd Buiilcler ' Tool

Root +M3 +P5 Off Off Off Off Off
First Second Third Fourth Fifth Sixth REVEG] Eighth

A A A A A
Octave 0 .0 < .0 .0

Velocity £ 100% £ 100% Z 100% 2 100%

+  Preset menu: Selects a preset from a variety of different chord structures.
Disable: Bypasses the Tool.

Voice 1-8: Selects the harmonized interval for each note. If the knob is set to Off, no additional
note will play.

Octave 1-8: Adds or subtracts up to 10 octaves to the interval (the note cannot exceed the
boundaries of MIDI note values, however).

Velocity 1-8: This control sets the velocity of harmonized tones as a percentage of the
incoming velocity. Knobs function between -100% and 100%. If the knob is set to -100% or
below, it switches to fixed velocity mode.

Chords Tool

The Chords Tool allows you to play chords on your Kontakt Instruments by pressing a single key.
The Tool provides a vast collection of chords judiciously grouped into chord sets. Each chord set
includes seven chords. You can browse the available chord sets and select the desired musical
characteristics to find the matching sets. When you load a chord set into the Tool, its seven chords
are directly available on dedicated keys of your MIDI keyboard. You can quickly adjust various
characteristics of the played chords, for example their playback behavior, the keyboard mapping,
the scale, the velocities, pitches, and timings of the individual notes, etc. You can also replace
single chords with ones from other sets, or record your own chords.

@ For more information on saving your custom sets, refer to Saving a User preset.

Chords overview

The Chords Tool contains the following elements:
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Pop Flowers Chords Tool

0 O ©

Octave Humanize Strum

1. Chord Set selector: Shows the name of the loaded set of chords. You can click the name
to open the Chord Set browser and select another set, click the left/right arrows to load the
previous/next set from the current result list, or click the dice to load a random set from the
current result list. Each chord set contains seven chords and a particular scale. By default,
when you load the chord set its chords and scale will replace the current chords and current
scale.

About: Click the Tool label to open the credits.

Chord Circles: Visually represent the seven chords in the set and provides a few chord-related
controls. Refer to Chord Circles for more information.

4. Scale Lock: Keeps the current scale when loading another chord set. This only works when
loading chord sets from the Chord Set selector or the Chord Set browser, not from Kontakt's
side pane nor Library Browser.

5. Scale selector: Shows the current scale. You can select another scale by clicking the selector
and choosing a root note and a scale mode from the menu. The seven available chords will
automatically adapt to match the keys in the selected scale.

Settings: Opens the Settings page page.
Keybed: Shows a little keybed on which the keys of the selected chord are lit using the chord
color.

8. Chord Slot selector: Selects a chord slot from the current set. This is equivalent to clicking the
Chord Circles except that the chord is not triggered. Upon your selection, the keybed on the
right shows the keys used in that chord. Each chord slot has its own color, which is mirrored in
various places to indicate the controls affecting that chord specifically.

9. Tool Playback controls: Adjust the global playback behavior of the Chords Tool. Refer to Tool
Playback controls for more information.

Chord Set browser

The Chord Set browser lets you replace the seven loaded chords at once with a fresh chord set
from the factory library.

The Chord Set browser contains the following elements:
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1. Tag filter: You can click the desired tags from the Genre, Type, and Style columns to select or
deselect them. The Set list on the right is updated accordingly.

2. Set list: Shows the sets matching your selections in the Tag filter. You can click a set in the list
to load it and replace the current set.

3. Chord Set Preview: Displays previews of the seven chords in the selected set. The previews
are inspired by the Chord Circles displayed in the middle of the Tool interface. The preview
with a white frame indicates the chord currently selected. The Chord Set Preview includes an
Export handle in the middle: You can click it and drag it to export the entire set into your DAW.

4. Close (cross symbol): Closes the browser.

Chord Circles

The Chord Circles let you quickly see and compare the shapes of the loaded chords.

Each chord sits on a slot showing 12 concentric circles, which represent the 12 semitones of
the ascending chromatic scale from C to B (C—C#-D-D#-E—-F-F#-G-G#-A-A#-B), where the
smallest circle in the center represents the C and the biggest circle the B. The lit circles indicate the
notes used in the chord.

@ This visualization does not distinguish between different chord positions or voicings:
all the positions, inversions, and doubling of the notes in the chord will be represented
by the same circles. To know the particular pitches used in the chord, take a look at
the keybed in the bottom right corner.

By default, you can trigger the seven slots by pressing the white keys of the middle three octaves
(C1 to C4) on your MIDI keyboard, from left to right: C-D—E-F-G-A-B. You can change this
behavior by adjusting the key range triggering the chords, or by switching from Simple to Advanced
keyboard mode. Both are done in the Settings page.

At any time, the keys of Kontakt's on-screen keyboard and the Light Guide of the Kontrol MK3
keyboards mirror the colors of the chords that they trigger.
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@ To see the Chords’ key mappings on the on-screen keyboard and on your Kontrol MK3
keyboard, make sure that the slot of the Chords Tool is selected at the top of Kontakt's
side pane.

You can export the complete chord set into your DAW by clicking and dragging the Export handle
in the top right corner and drop it onto the desired location.

When you hover over a chord slot with the mouse, additional controls appear below:

Magnifying glass: Opens the Chord browser, which lets you choose another chord for loading
into that slot.

Dice: Loads a random chord from the current result list.
Export handle: Click and drag to export this single chord into your DAW.

Record: Lets you create a chord manually for that slot: Click Record, press the desired keys on
your MIDI keyboard, and click Record again.

Chord browser
The Chord browser lets you replace the selected chord with a fresh one from the factory library.

The Chord browser contains the following elements:
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1. Tag filter: You can click the desired tags from the Genre, Type, and Style columns to select or
deselect them. The Chord list on the right is updated accordingly.

2. Chord list: Shows the chords matching your selections in the Tag filter. In the list, the chords
are named after the chord set they are belonging to, preceded by a number from 1 to 7
indicating their order of appearance in the set. You can click a chord in the list to load it and
replace the selected chord.

3. Chord Preview: Displays a preview of the selected chord. The preview is inspired by the Chord
Circles displayed in the middle of the Tool interface.

4. Close (cross symbol): Closes the browser.

Tool Playback controls

The Tool Playback controls adjust the global playback behavior of the Chords Tool. The values for
these controls are not stored in the sets. Hence, your custom settings stay valid when switching
between sets.

The following controls are available:

0 O O

Humanize Strum

Octave: Transposes all chords to a lower/higher octave.

Humanize: Adds a variable amount of random imprecision when triggering the chord, which
makes it sound more human. Turning the knob to the right increases the likelihood of such
inaccuracies. Clicking the little up arrow above the knob opens the Humanize settings, where
you can adjust how various characteristics of the chord should be humanized.

Strum: Adds a short delay between each note start, as if the chord was played by strumming
the strings on a real instrument. Turning the knob to the right increases the delay between
the notes. Clicking the up or down arrow above the knob will select upward or downward
strumming, respectively. The Chord Circles indicate the strumming by progressively shifting the
note starts clockwise from their original position at the top of the circles.
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Humanize settings

The Humanize settings let you specify different amounts of random inaccuracies for various
characteristics of the triggered chords.

Time

Velocity Min

Velocity Max
Skip

S
0 © O

Octave Humanize Strum

Time: Inaccuracies in the timing of the notes. As you drag the slider to the right, the individual
notes of the chord tend to be triggered out of time.

Velocity Max: Inaccuracies in the maximum velocity of the notes. As you drag the slider to the
right, the individual notes can get louder as their original velocity.

Velocity Min: Inaccuracies in the minimum velocity of the notes. As you drag the slider to the
right, the individual notes can get softer as their original velocity.

Skip: Inaccuracies in the note trigger. As you drag the slider to the right, more notes tend to be
skipped.

@ The influence of the Humanize features cannot be represented in the Chord Circles
since they occur randomly when the notes are triggered.

Settings page

The Settings page provides global options affecting the behavior of the Tool and its response to
your actions on the keyboard.

Pop Flowers Chords Tool

Playable Range

The following controls are available:
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Keyboard Mode: Selects between two modes for triggering the chords from your MIDI
keyboard:

In Simple mode (default mode), within the range of playable keys, each white key triggers
a different chord from the set according to the key degree in the C scale: For example, the
C keys trigger the first chord of the set, the D keys trigger the second chord, etc. The chord
pitch is set to the current root note (as specified in the Scale selector) in the octave of the
pressed key. You can adjust the range of playable keys in the Mapping section.

In Advanced mode, distinct key ranges are used for selecting and triggering chords. A
one-octave range lets you select chords (without triggering them) by pressing the white
keys, using the same logic as in Simple mode: The degree of the pressed key in the C scale
determines which chord will be selected. A second key range lets you trigger the selected
chord at the desired pitch by pressing the corresponding black or white key. You can adjust
both ranges in the Mapping section.

Mapping: Lets you adjust the range(s) used to control your chords. The available parameters
depend on the current keyboard mode:

In Simple mode, the Playable Range defines the keys that will trigger chords. Keys outside
this range will be inactive. You can adjust the lower or upper end of the range by clicking the
corresponding note field and dragging your mouse vertically, or by clicking the little up and
down arrows next to it. Above the fields, the slots mirror the colors of the triggered chords.

Playable Range

In Advanced mode, the Selection Range defines the one-octave range used for selecting the
chords (the range is defined by its base C key), and the Playable Range defines the keys
used for triggering the selected chord. You can adjust either range by clicking the note fields
and dragging your mouse vertically, or by clicking the little up and down arrows next to the
fields.

Chord Selector Playable Range

e Re1l

Show Chord Names: When this option is on, the name of the selected chord shows up above
the Chord Slot selector. In addition, when you hover over the keybed with your mouse, the
name of each note in the chord appears above.
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Humanizer

Humanizer adds slight randomization to the timing, velocity, and pitch of the notes you play.

The Humanizer Tool contains the following elements:

HuMmManizer ' Tool

0ms 0% 0% 12 st
Delay Velocity Pitch Range

Disable: Bypasses the Tool.

Seed: Sets the seed number used to generate pseudo-random values for the randomization
of the parameters. The sequence for each seed number is predictable, which is useful for
automation,

Delay: Randomly delays the note on time of each note with a selectable range of 0 to 100
milliseconds.

Velocity: Randomly adds or subtracts velocity values with a selectable range of -64 to +64.
Pitch: Randomly adds a value to the pitch with a selectable range from range.

Range: Sets the range of pitches for the randomization.

Patterns Tool

The Patterns Tool combines the features of a polyphonic step sequencer and an arpeggiator. Like
an arpeggiator it generates repeated sequences of notes based on the keys that you hold, while
providing the flexibility of a step sequencer regarding the order, duration, layering, and rhythm
of the notes. You can load patterns from the factory library, modify them, or create your own
patterns from scratch, and complement them in real time with inspiring randomization options.
The generated sequences will always include only the keys that you hold and their octaves, which
makes the Patterns Tool harmonically transparent and lets you blend it easily into any harmonic
context.

@ As with any other Tool or instrument loaded in Kontakt, you can save your custom
patterns as User presets: For example, you can do this by right-clicking the Patterns
slot in the Navigator at the top of Kontakt’s side pane, and selecting Save Preset.... For
more information, refer to Saving a User preset.

Patterns overview

The Patterns Tool contains the following elements:
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12

&
O o o o O

Rate Duration Velocity Octave Humanize Move Pattern

1. Pattern selector: Shows the name of the loaded pattern. You can click the name to open
the Pattern browser and select another pattern, click the left/right arrows to load the previous/
next pattern from the current result list, or click the dice to load a random pattern from the
current result list.

2. Parameter Lock: Keeps the current values of the pattern parameters (the row of controls at
the bottom of the Tool) when loading another pattern from the Pattern selector. The lock only
works when loading patterns using the Pattern selector/browser within the Patterns Tool, not
when using the side pane nor the Library Browser of Kontakt.

3. About: Clicking the Tool name opens the credits.

Pattern Editor: Shows the content of the current pattern and provides multiple tools to modify
it: You can add or remove single notes with your mouse, mute specific steps and pitches,
drop additional random notes, adjust the pattern’s length and play range, and specify how the
pattern should be triggered. For more information, refer to Pattern Editor.

5. Move Pattern control: Moves all the notes of the pattern one step in the direction of the
clicked arrow. Notes that end up outside the grid are reinserted on the other end, the total
number of notes staying unchanged. The movements also affect the drops randomly added to
the pattern. For more information on the drops, refer to Pattern Editor.

6. Pattern parameters: Adjust various aspects of the pattern playback, including its tempo, the
timing, velocity, and pitch range of the generated notes, the playback direction, as well as the
groove and human-like inaccuracies. For more information, refer to Pattern parameters.

Which keys are included?

The Patterns Tool collects a set of eight pitches (or keys) that will be used for all the notes in the
patterns. The particular pitches included in the set are based on the keys that you hold. From the
lowest to the highest pitch, the set includes:

The pitches of the held keys.

If there are free slots left, the set takes the pitches of the same keys one octave above, then two
octaves above, and so on until it contains eight different pitches.

For example:
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If you hold C2 and F2 on your keyboard, the eight pitches available in the patterns will be: C2,
F2 (original pitches), C3, F3 (one octave above), C4, F4 (two octaves above), and C5, F5 (three
octaves above).

If you hold instead C2, E2 and G2 on your keyboard, the eight pitches available in the patterns
will be: C2, E2, G2 (original pitches), C3, E3, G3 (one octave above), and C4, E4 (two octaves
above).

@ Once the eight available pitches have been set, the notes in the patterns will still be
filtered by the Key Output Range and also influenced by the Octave and Duration
controls before getting triggered. For more information, refer to Pattern parameters.

Pattern browser
The Pattern browser lets you replace the current pattern with a fresh one from the factory library.

The Pattern browser contains the following elements:

Arp Up Down ™ Patterns Tool

ATTRIBUTES PATTERN

Arp Up Down
Nal

1. Tag filter: You can click the desired tags from the Type, Tempo, and Attributes columns to
select or deselect them. The Pattern list on the right is updated accordingly.

2. Pattern list. Shows the patterns matching your selections in the Tag filter. You can click a
pattern in the list to load it and replace the current pattern.

3. Pattern Preview: Shows a preview of the selected pattern. The preview is inspired by the step
grid content in the Pattern Editor.

4. Close (cross symbol): Closes the browser.

@ The Pattern browser lets you access the factory presets included in the Patterns Tool.
To access your own user patterns, you can use instead the side pane browser or the
Library browser of Kontakt.

Pattern Editor

The Pattern Editor lets you modify the content of the current pattern. You can create, modify, and
delete single notes, adjust the length, the play range, and the trigger behavior of the pattern, mute
or unmute specific steps or keys, and drop additional random notes.

The Pattern Editor contains the following elements:
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Patterns Tool
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Length: Adjusts the number of steps in the pattern, from 1 to 32. You can click the up/down
arrows to select the next/previous value, or click the value and drag your mouse vertically to
adjust it in greater jumps. As you modify the pattern length, the step grid below is updated
accordingly. Changing the pattern length does not delete any notes: If some notes disappear
from the step grid as you shorten the pattern, they will reappear as soon as you lengthen it
again.

Step grid: Shows the pattern’'s notes on a grid. The horizontal axis represents the time flowing
from left to right, each division corresponding to one step of the pattern. The downbeats
have a lighter background for easier reference. The vertical axis represents the eight pitches
available, in ascending order from the bottom to the top. The notes are represented by cells
on the grid: The blue cells represent the standard notes (whether loaded with the pattern or
created by you), and the turquoise cells represent the additional, random drops. The cell length
indicates the note duration and its color intensity indicates the note velocity (pale colors for
lower velocities, intense colors for higher velocities). The current play position is indicated by
a lighter vertical segment traveling from left to right during playback. You can create, modify,
and delete notes with your mouse as described in Mouse actions in the step grid.

Play Range: Indicates the portion of the pattern selected for playback. The Patterns Tool will
play this range in loop, while areas of the step grid outside this range are grayed out and
ignored. You can adjust the Play Range's start or end by clicking and dragging its left or right
border horizontally. You can also move the entire range by clicking anywhere between its
borders and dragging your mouse horizontally. The start step and end step are indicated next
to the corresponding border.

Drops buttons: Control the drops, which are optional, random notes dropped onto your
pattern. Drops appear in turquoise in the step grid. The following buttons are available: In
the middle, the bigger Drops on/off button activates or deactivates the drops. When you
activate the drops for the first time, they are automatically generated. On the left, the Renew
button (showing two cycling arrows) lets you manually generate a new set of drops that will
immediately replace the current drops in the pattern. On the right, if you activate the Auto
Renew button (showing an infinite icon) the drops will be automatically renewed each time the
pattern is looped.

Paint Mode button (paintbrush icon): Activates or deactivates the Paint mode for the mouse
actions in the step grid.

Clear button (recycle bin icon): Removes all the notes from the pattern and resets all the Step
and Pitch switches to their default active state, leaving an empty pattern where you can build a
new sequence from scratch.
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Retrigger: When Retrigger is off (default setting), the pattern starts from the beginning as you
press the first key and goes on looping until you release the last held key. When Retrigger is
on, the pattern restarts from the beginning for every new key that you press.

Latch: When Latch is off (default setting), the pattern is played in loop as long as you hold
some keys. When Latch is on, the pattern goes on looping even if you release all the keys. You
can stop the pattern by clicking the active Latch button.

Step on/off switches: Each little dot below the step grid lets you activate or deactivate the
notes triggered on the step directly above. By default, all the dots are blue, indicating that all
the steps are active. Clicking any dot will turn it off and deactivate the step above it, muting all
the notes that start on that step (the column will turn gray). Deactivating a step only affects
the note triggers: Notes that were triggered at earlier steps will not be affected, even if they
might still produce a sound.

Pitch on/off switches: Each little dot left of the step grid lets you activate or deactivate the
notes at the pitch directly on the right. By default, all the dots are blue, indicating that all the
pitches are active. Clicking any dot will turn it off and deactivate the pitch right of it, muting
all the notes at that pitch (the row will turn gray). Deactivating a pitch only affects the note
triggers: Notes at that pitch that were triggered before you deactivate the pitch will not be
affected, even if they might still produce a sound.

Mouse actions in the step grid

The available mouse actions in the step grid depend on the current editing mode, which is set by
the Paint Mode button (showing a paintbrush icon) above the step grid:

In default mode (Paint Mode button off), you can:

Click in the first step of a note to delete it. If the note is longer than one step, clicking at a
later position in the note will cut off its tail and create a new note on that step.

Click in the first step of a note and drag your mouse horizontally to adjust the note length,
and vertically to adjust the note velocity.

Click an empty division to create a note on that step. You can hold the mouse button
depressed and drag your mouse to the right to adjust the note length and vertically to adjust
the note velocity.

In Paint mode (Paint Mode button on), you can:

Click an empty division to create a note on that step. You can hold the mouse button
depressed and drag your mouse in any direction to quickly create multiple notes at once
(the mouse cursor then shows an additional paintbrush icon).

Click a note to delete it. You can hold the mouse button depressed and drag your mouse
in any direction to quickly delete multiple notes at once (the mouse cursor then shows an
additional trash bin icon).

@ You cannot edit the turquoise notes, which are the additional, random drops.
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Pattern parameters

The row of controls at the bottom of the Patterns Tool lets you adjust various aspects of the
pattern. It contains the following elements:
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1. Sync button (metronome icon): When Sync is on, the pattern's tempo and play position are in
sync with Kontakt's main tempo (which is the tempo of your DAW if Kontakt is running as a
plug-in). When Sync is off, the pattern is played independently from any external clock.

2. Rate: Adjusts the size of the steps in the grid, which directly affects the playback speed: the
shorter the steps, the faster the playback. When Sync is off, the Rate values are measured
in milliseconds and range from 100 ms to 1000 ms. When Sync is on, the Rate values are
measured in note values from 1/32 (1/32nd note) to 1/1 (whole note) relatively to Kontakt's
main tempo. Within this range, the values with a D refer to dotted notes and the values with a
T refer to triplets.

3. Duration: Globally adjusts the lengths of all notes relatively to their original lengths. The
available values range from 50 % (half of the original lengths) to 150 % (1.5 x the original
lengths). For values above 100 %, the notes continue playing onto the next step: If the next
step also contains a note at the same pitch, this note will not be triggered, which can radically
(but still musically) change the playback.

4. Velocity: Globally adjusts the velocities of all notes relatively to their original velocities. The
available values range from 1 % to 200 %. Clicking the little up arrow above the knob opens
the Velocity settings, where you can configure the note velocities more in detail.

5. Octave: Transposes the notes by 1, 2, or 3 octaves downward or upward. Since the transposed
notes will be processed by the Key Output Range afterwards, moving the Octave knob further
away from its middle position will tend to accumulate the notes near the lower or upper limit
of the Key Output Range.

6. Key Output Range: Defines the key range in which notes can be triggered. If a note of the
pattern has a pitch outside this range, its closest octave equivalent inside the range will be
played instead. The keyboard visualization indicates in blue the notes that are effectively
played. You can adjust the Key Output Range in various ways: You can adjust its lower or
upper limit by clicking and dragging its left or right border horizontally, you can move the entire
range by clicking anywhere between its borders and dragging your mouse horizontally, or you
can adjust its lower and upper limits using the two key fields below: In these fields, you can
click the up/down arrows to select the next/previous key value, or click the value and drag your
mouse vertically to adjust it in greater jumps.

7. Playback Direction selector: Selects the direction in which the pattern will be played. From left
to right, the four available settings are Forward (default setting), Backward, Ping-pong (forward
and backward), and Shuffle (the playhead randomly jumps through the pattern).

8. Swing: Adjusts the swing amount. The swing adds a variable delay to every second note (or
every second and third notes if Sync is on and Rate is set to a triplet value), which produces
the shuffle effect commonly used in jazz music, for example.
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9. Humanize: Adds some random imprecision when triggering the notes, which makes the
pattern sound more human. Turning the knob to the right increases the likelihood of the
inaccuracies. Clicking the little up arrow above the knob opens the Humanize settings, where
you can adjust how various characteristics of the notes should be humanized.

@ The Move Pattern control at the far right is not a pattern parameter. Instead, if shifts
all the notes in the pattern. For more information on this control, refer to Patterns
overview.

Velocity settings
The velocity settings let you adjust additional velocity details.

Min
Max

Gravity
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ration Velocity Octave

Min: Adjusts the minimum velocity of the notes.
Max: Adjusts the maximum velocity of the notes.

Gravity: Adjusts an extra velocity accent applied to the notes on the downbeats (the columns
with a lighter background in the step grid). Higher Gravity values will additionally decrease the
velocities of the remaining, non-accented notes.

Humanize settings

The Humanize settings let you specify different amounts of random inaccuracies for various
characteristics of the triggered notes.

Duration
Velocity
Note Skip

Move Pattern

Duration: Adjusts the amount of inaccuracies in the length of the notes. As you drag the slider
to the right, the individual notes in the pattern tend to last longer or shorter as their original
length.

Velocity: Adjusts the amount of inaccuracies in the velocity of the notes. As you drag the slider
to the right, the individual notes can get louder or softer as their original velocity.

Note Skip: Adjusts the amount of inaccuracies in the note trigger. As you drag the slider to the
right, more notes tend not be skipped.
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Phrases Tool

The Phrases Tool allows you to play musical phrases on your Kontakt Instruments by pressing a
single key. The Tool provides you with a vast collection of phrases judiciously grouped into phrase
sets. Each phrase set includes seven phrases. You can browse the available phrase sets and select
the desired musical characteristics to find the matching sets. When you load a phrase set into the
Tool, its seven phrases are directly available on dedicated keys of your MIDI keyboard. You can
quickly adjust various characteristics of the played phrases, for example their playback behavior,
the keyboard mapping, the scale, the velocities, pitches, and timings of the individual notes, etc.
You can also replace single phrases with ones from other sets to create your own custom sets.

@ For more information on saving your custom sets, refer to Saving a User preset.

Phrases overview

The Phrases Tool contains the following elements:
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1. Phrase Set selector: Shows the name of the loaded set of phrases. You can click the name
to open the Phrase Set browser and select another set, click the left/right arrows to load the
previous/next set from the current result list, or click the dice to load a random set from the
current result list. Each phrase set contains seven phrases and a particular scale. By default,
when you load the phrase set its phrases and scale will replace the current phrases and
current scale.

2. About: Click the Tool name to open the credits.

3. Scale Lock: Keeps the current scale when loading another phrase set. This only works when
loading phrase sets using the Phrase Set selector or the Phrase Set browser, not from
Kontakt's side pane nor Library Browser.

4. Scale selector: Shows the current scale. You can select another scale by clicking the selector
and choosing a root note and a scale mode from the menu. The seven available phrases will
automatically adapt to match the keys in the selected scale.

5. Settings: Opens the Settings page.
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Global: Defines the scope of your adjustments on certain parameters. When Global is on
(switch to the right), the concerned parameters have no color and your edits apply globally to
all the phrases in the set. When Global is off (switch to the left), these parameters mirror the
color of the selected phrase and your edits apply only to that phrase.

Edit (pen icon): Switches to the Phrase Edit mode. The Phrase Edit mode lets you adjust the
phrase characteristics in detail: playback, timings, pitches, and velocities.

Quick Edit controls: Shortcuts for two controls from the Phrase Edit mode:

Rotate: Delays the entire phrase by an adjustable amount. The circular score of the Phrase
Wheel shows the delay by rotating all the notes.

Invert: Switches the pitches between the notes used in the phrase. For example, the first
inversion will transpose the lowest pitch to the 2nd-lowest pitch, the 2nd-lowest to the
3rd-lowest, ... , the 2nd-highest pitch to the highest, and the highest pitch to the lowest.
When turning the knob to the right from its default position at full left (no inversion),
you will successively activate every inversion possible. The more pitches are used in the
phrase, the more inversions will be available.

Phrase selector: Shows the name of the phrase loaded in the selected slot. Clicking the name
or the magnifying glass opens the Phrase browser, which lets you select and load another
phrase into that slot. You can also click the dice to load a random phrase from the current
result list.

Phrase Slot selector: Selects a slot from the set and provides additional controls affecting the
phrase selection. Refer to Phrase Slot selector for more information.

Phrase Wheel: Visually represents the note sequence in the selected phrase. Refer to Phrase
Wheel for more information.

Tool Playback controls: Adjust the global playback behavior of the Phrases Tool. Refer to Tool
Playback controls for more information.

Randomize: Set random values to most time, pitch, and velocity parameters of the phrase(s).
These include the Rotate and Invert knobs in the Quick Edit controls on the right. The
remaining parameters are available in the Phrase Edit mode.

Phrase Set browser

The Phrase Set browser lets you replace the seven loaded phrases at once with a fresh phrase set
from the factory library.

The Phrase Set browser contains the following elements:

Catching Up With You Phrases Tool
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1. Tag filter: You can click the desired tags from the Genre, Type, and Style columns to select or
deselect them. The Set list on the right is updated accordingly.

2. Set list: Shows the sets matching your selections in the Tag filter. You can click a set in the list
to load it and replace the current set.

3. Phrase Set Preview: Displays previews of the seven phrases in the selected set. The previews
are inspired by the Phrase Wheel displayed in the middle of the Tool interface. The preview
with a white frame indicates the phrase currently selected. The Phrase Set Preview includes an
Export handle in the middle: You can click it and drag it to export the entire set into your DAW.

4. Close (cross symbol): Closes the browser.

Phrase Wheel

The phrase is shown as a sequence of notes (or pattern) on a circular score:

Each note appears as a curved segment with the following properties:
Its color intensity indicates the note velocity.
Its distance to the center indicates the note pitch.
Its angular position indicates the note timings (note start and end).

The playback starts at the top and progresses clockwise up to one full circle, corresponding to one
bar. The white hand represents the playhead: As it reaches a segment, that note is triggered and
plays until the playhead reaches the segment end.

By default, a phrase plays from the beginning to the end of the sequence (one full circle). By
clicking anywhere on the wheel and dragging your mouse vertically, you can adjust the end point of
the phrase: In the sequence, the notes starting after the end point are grayed out and will not play.
However, earlier notes that are still sounding will continue to play until their end.

The Phrase Wheel provides two additional controls:

Reset (top left of the Phrase Wheel): Cancels any changes that you have made to the phrase(s)
and returns to the factory version. The Reset button appears only if you have modified the
phrase.

Export handle (bottom right of the Phrase Wheel): Click and drag to export the phrase into your
DAW.
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Phrase browser
The Phrase browser lets you replace the selected phrase with a fresh one from the factory library.

The Phrase browser contains the following elements:

Catching Up With You Phrases Tool

PHRASE

7 Catching Up With You

& 7 Catching Up With You Q
4th
0 111 ©

Dynamics Octave Tempo Swing

Follow

1. Tag filter: You can click the desired tags from the Genre, Type, and Style columns to select or
deselect them. The Phrase list on the right is updated accordingly.

2. Phrase list. Shows the phrases matching your selections in the Tag filter. You can click a
phrase in the list to load it and replace the selected phrase.

3. Phrase Preview: Displays a preview of the selected phrase. The preview is inspired by the
Phrase Wheel displayed in the middle of the Tool interface.

4. Close (cross symbol): Closes the browser.

Phrase Slot selector

The Phrase Slot selector contains the following elements:

1. Play: Toggles the playback of the selected phrase on or off. When Play is on, selecting another
slot automatically triggers its phrase.

2. Phrase slots: Selects a phrase from the current set. The selected slot is highlighted, its phrase
is displayed in the Phrase Wheel, and you can edit its settings. Each phrase slot has its own
color, which is mirrored in various places of the Tool to indicate the controls affecting that
phrase specifically. When the phrase is playing, a vertical progress bar runs on the slot to
indicate the play position in the phrase.

3. Follow: If this is on, you can select phrases by pressing their key on your MIDI keyboard. If this
is off, the keys trigger the phrases without selecting them.
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4. Latch: Selects between two playback behaviors when triggering phrases via MIDI:
If Latch is off, the triggered phrase will play as long as you hold the key depressed and stop
when you release the key.
If Latch is on, the phrase will go on playing until the end even if you have released the key.

5. Lock (below the selected slot): Keeps the current phrase in that slot when you load another
phrase set. You can lock several slots in your set. You can use the lock to keep interesting
phrases as you browse the available phrase sets, progressively composing your own set of
phrases.

Tool Playback controls

The Tool Playback controls adjust the global playback behavior of the Phrases Tool. The values for
these controls are not stored in the sets. Hence, your custom settings stay valid when switching
between sets.

The following controls are available:

0 1:1 QO

Dynamics Octave Tempo Swing

Dynamics: Adjusts the overall velocity of the phrases.

Dynamics Source menu (little up arrow above the Dynamics knob): Selects the source used to
control the dynamics. You can select Velocity to use the velocity at which you press the keys,
Modwheel (CC1) to use the modulation wheel on your MIDI keyboard, or Velocity + Modwheel
to use both simultaneously.

Octave: Transposes the playback by octaves up to three octaves downward or upward.

Tempo: Sets the playback tempo to the double value (2x), the same value (1:1), or half the
value (1/2) of Kontakt's main tempo. If Kontakt is running as a plug-in in your DAW, its main
tempo is defined in your DAW. If Kontakt is running as a standalone application, its main tempo
is defined in the Master Editor.

Swing: Adjusts the swing amount. The swing adds a variable delay to the notes in the second
half of a chosen time division (usually the quarter note), which creates the shuffle effect
commonly used in jazz music, for example.

Step Size menu: Selects the time division used for the Swing. The default value (4th)
corresponds to the quarter note. The available values range from 1/1 (whole note) to 16th
(sixteenth note).

Phrase Edit mode

By activating the pen icon, you switch the Phrases Tool to Phrase Edit mode. In Phrase Edit mode
you can modify the current phrase or the entire set more in detail. For this purpose, additional
sections of parameters show up on either side of the Phrase Wheel:
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Acid Cats Phrases Tool & C Phrygian

Global

Reverse Velocity

Loop O

Play Until Loop End

4th (9] cid Cats
0 111 O e

Dynamics Octave Tempo Swing

Follow

On the left, the Phrase Playback section lets you configure the playback behavior of the
phrase(s).

On the right, the Edit section lets you adjust the timings, pitches, and velocities of the notes in
the phrase(s).

Phrase Playback section

In the Phrase Playback section you can configure the playback behavior of the selected phrase or
of the entire set.

The Phrase Playback section contains the following controls:

Reverse

Loop O

Play Until Loop End

Reverse switch: Turns the reverse playback on or off.

Reverse Range menu: Selects the part of the phrase(s) that should play in the reverse direction,
the remaining part playing forward. This control affects the playback only if the Reverse switch
is on. The available entries are Whole (the whole phrase plays reverse), First Half (first half
reverse, second half forward), Second Half (first half forward, second half reverse), and Both
Halves (first half reverse, then second half reverse).

Loop switch: Turns the looped playback on or off.

Repetitions slider: Specifies how many times the phrase(s) should be looped. This control
affects the playback only if the Loop switch is on. With the slider at full left (inf, default value),
the playback is looped forever. The remaining values range from 1 to 99.
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Play Until menu: Selects where the loop should end and jump back to the beginning. This
control affects the playback only if the Loop switch is on and if the phrase’s play range is
shorter than a full cycle (see Phrase Wheel). Two entries are available from the menu:

Pattern End: The whole sequence (full circle) is looped, including any grayed out notes and
the resulting silent part. For example, this setting is useful to preserve the loop length and
keep the Tool in sync with other instruments in your DAW.

Loop End: Only the audible phrase is looped. If the phrase is shorter than a full circle, the
loop will be shorter as well.

Edit section

In the Edit section you can change the timings, pitches, and velocities of the notes in the selected
phrase or in the entire set.

Global

Velocity

Tilt

In the top row, the Edit section contains three elements, from left to right:

® Global

Randomize button: Sets random values to all the continuous parameters from the Edit section.
This button mirrors the bigger Randomize button available outside the Phrase Edit mode. If the
Global switch on its right is on, the Randomize button shows all the phrase colors to remind
you that it will affect all of them. If the Global switch is off, the Randomize button shows only
the color of the selected phrase to indicate that it will affect only this phrase.

Global switch: Specifies whether your edits will apply to the seven loaded phrases (button on)
or only to the selected phrase (button off). This button mirrors the Global switch available
outside the Phrase Edit mode.

Close button (cross icon): Closes the Phrase Edit mode.

@ For more information on the Randomize button and the Global switch outside the
Phrase Edit mode, refer to Phrases overview.

Below, the Edit section contains three panels, which you can display by clicking the Time, Pitch, or
Velocity tab at the top:

Velocity

The Time panel contains the following controls:
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Rotate Note Length  Quantize Bend

Rotate: Delays the entire phrase by an adjustable amount. All the notes rotate on the Phrase
Wheel as you adjust the knob. This parameter is also available in the Quick Edit controls,
available when the Phrase Edit mode is off.

Note Length: Shortens or extends the length of all notes by moving their end points.

Quantize: Adjusts the quantization applied to the notes. At full left (default setting), no
quantization is applied. The more you turn the knob to the right, the closer the notes get from
the time divisions selected in the Quantize Step menu.

Quantize Step menu: Selects the time division to which the notes can be quantized. The
available values range from 1/1 (one whole note, corresponding to one full circle) to 16th (one
sixteenth note).

Bend: Bends the time line toward the beginning or the end of the sequence. From the default
center position (no bending), turning Bend to the left will speed up the beginning of the
sequence and slow down its end, whereas turning it to the right will slow down the beginning
of the sequence and speed up its end. In any case, the total duration of the sequence stays
untouched.

The Pitch panel contains the following controls:

Invert Transpose

Invert. Switches the pitches between the notes used in the phrase. For example, the first
inversion will transpose the lowest pitch to the 2nd-lowest pitch, the 2nd-lowest to the 3rd-
lowest, ... , the 2nd-highest pitch to the highest, and the highest pitch to the lowest. When
turning the knob to the right from its default position at full left (no inversion), you will
successively activate every inversion possible. The more pitches are used in the phrase, the
more inversions will be available. This parameter is also available in the Quick Edit controls,
available when the Phrase Edit mode is off.

Transpose: Transposes all the notes in semitones. The available values range from -12 to 12
semitones.

The Velocity panel contains the following controls:

Velocity
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Tilt: Puts the velocities on a time slope centered on the current mean of all velocities. From
the default center position, turning Tilt to the left uses a raising slope (early notes get softer
and late notes get louder), while turning Tilt to the right uses a decreasing slope (early notes
get louder and late notes get softer). The slope becomes steeper as you move the knob further
away. For example, this tool is useful to create crescendos.

Flip: Modifies the gap between high and low velocities. From the default center position, turning
Flip to the left accentuates the velocity differences between notes by amplifying the higher
velocities and attenuating the lower velocities. The other way around, turning Flip to the right
attenuates the higher velocities and amplifies the lower velocities: At first this reduces the
velocity differences between notes, but turning the knob further to the right leads up to a
complete velocity inversion, the soft notes being played loud and the loud notes softly.

Min: Adjusts the lowest velocity available. Increasing the Min value shrinks the range of
available velocities upward. The possible values go from 0 (default value, knob at full left, no
lower velocity limit) to 100 (all the notes are set to the maximum velocity).

Max: Adjusts the highest velocity available. Decreasing the Max value shrinks the range of
available velocities downward. The possible values range from 100 (default value, knob at full
right, no upper velocity limit) to 0 (knob at full left, all the notes are set to the minimum velocity).

Settings page

The Settings page provides global options affecting the behavior of the Tool and its response to
your actions on the keyboard.

Acid Cats Phrases’ Tool & C Phrygian {}

Playable Range

The following controls are available:

Keyboard Mode: Selects between two modes for triggering the phrases from your MIDI
keyboard:

In Simple mode (default mode), within the range of playable keys, each white key triggers a
different phrase from the set according to the key degree in the C scale: For example, the C
keys trigger the first phrase of the set, the D keys trigger the second phrase, etc. The phrase
pitch is set to the current root note (as specified in the Scale selector) in the octave of the
pressed key. You can adjust the range of playable keys in the Mapping section.

In Advanced mode, distinct key ranges are used for selecting and triggering phrases. A
one-octave range lets you select phrases (without triggering them) by pressing the white
keys, using the same logic as in Simple mode: The degree of the pressed key in the C scale
determines which phrase will be selected. A second key range lets you trigger the selected
phrase at the desired pitch by pressing the corresponding black or white key. You can adjust
both ranges in the Mapping section.
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Mapping: Lets you adjust the range(s) used to control your phrases. The available parameters
depend on the selected Keyboard Mode on the left:

In Simple mode, the Playable Range defines the keys that will trigger phrases. Keys outside
this range will be inactive. You can adjust the lower or upper end of the range by clicking the
corresponding note field and dragging your mouse vertically, or by clicking the little up and
down arrows next to it. Above the fields, the slots mirror the colors of the triggered phrases.

Playable Range

In Advanced mode, the Selection Range defines the one-octave range used for selecting the
phrases (the range is defined by its base C key), and the Playable Range defines the range
of keys that will trigger the selected phrase. You can adjust both ranges by clicking the note
flelds and dragging your mouse vertically, or by clicking the little up and down arrows next
to the fields.

Phrase Selector Playable Range

C1 - C4

Retrigger: Specifies the transition between successive phrases. If you trigger a new phrase
while the previous phrase is still playing, the following behaviors are available:

Off. The new phrase seamlessly takes over from the playback position of the previous
phrase.

On: The new phrase starts from the beginning.

Legato: The new phrase takes over from the playback position of the previous phrase only if
you are still pressing the previous key.

Scale Lock

Scale Lock maps the notes you play to a musical scale.

The Scale Lock Tool contains the following elements:

Lower Note v Scale L.ock Tool

Major Dorian Phrygian Lydian Mixolydian Locrian
Minor Harmonic Minor Melodic Minor Pentatonic Major Pentatonic Minor Pentatonic Blues
Major-Minor Whole-Tone Diminished Octatonic Lydian b7 Locrian #9

Messiaen llI Messiaen IV Messiaen V Messiaen VI Messiaen VI

Disable: Bypasses the Tool.
Key: Selects the root key of the scale.
Scale: Selects a scale to which all notes will be constrained to.

Incoming Note menu: Selects the behavior of incoming MIDI notes which do not fall within the
selected scale.



INSTRUMENTS AND TOOLS 92

Velocity Curve

Velocity Curve lets you fine-tune how Kontakt responds to the velocity values you play.

The Velocity Curve Tool contains the following elements:

Quadratic \V/elocity Curve Tool

127 0%
Max Shape

Disable: Bypasses the Tool.

Curve Types: Selects the type of basic velocity curve you want to use with your MIDI device.
Min/Max: Adjusts the minimum and maximum values for the velocities in the velocity curve.
Shape: Adjusts the convex or concave curve amounts of the velocity curve.

Panel: Displays the selected curve type along with its in and out velocity values.
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9. Classic view

The Classic view in Kontakt Player is designed to discover the depth and power of its engine over
time. It can be configured in a variety of ways to best suit your needs and preferred workflows. You
can load instruments and combine them in multis with flexible MIDI and audio routing.

Classic view contains the following main areas and elements:

@ KONTAKT PLAYER

Q

Kontakt Factory Sel

Libraries File: Dotabose
Manage Librarie: A-Z
New (default)

KONTAKT
FACTORY SELECTION

Instrument:

qin - Flying Swords
st r

Instrument:

KONTAKT PUAY SERIES

SOUL SESSIONS

Instrument:

oriciow W

Instrument:

Analog Dream:

KONTAKT PLAY SERES.

ANALOG
TTDREAMS

Buteh Vig Drun

KONTAKT PLAYSERIS

BUTCH VIG D

NULAR ICON&—~

Instrument.

AT

ONTAK ts are adjusted in relation to the

Header: Lets you open the Library browser, show or hide elements in the user interface, and
access options in the File menu. Additionally, the displays and meters keep you informed
about the software status. For more information, refer to Header.

Side Pane: Provides functions for managing your collection of Kontakt-relevant files. In the
screenshot, it's currently switched to the Libraries tab, which contains easy access to your
Kontakt libraries. For more information, refer to Side Pane (Classic view).

Master Editor: Contains global controls that affect the behavior of all Instruments in your
Multi, as well as some common utility functions. For more information, refer to Master Editor.

Rack: Displays all Instruments in the current Multi. The Rack area is where one or more
Instruments are loaded into the Multi. For more information, refer to Instrument Rack.

Instrument Header Contains the Instrument’s name and various parameters, such as MIDI
input channel, output level, panning position, and tuning. For more information, refer to
Instrument header.

Outputs Section: Displays a channel strip for each configured Output Channel, plus four Aux
Channels. For more information, refer to Outputs Section.
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7. On-screen keyboard: Displays a virtual on-screen keyboard that you can use to play
instruments with your mouse, and visualize key ranges. For more information, refer to On-
screen keyboard.

8. Info Pane: Displays details of the selected Instrument file below the Side Pane, and a brief
explanation of the control at the mouse position below the Rack. For more information, refer
to Info pane.

Instrument Rack

The Rack is where you will spend most of the time when working with Kontakt. The Rack operates
in Multi Instrument mode, which allows you to view and edit your Multi and the Performance views
of the Instruments in it. In the full version of Kontakt, a second mode allows you to edit the inner
workings of a single Instrument; Instrument Edit mode.

In Multi Instrument mode, any Instrument in the Multi will be shown as a horizontal Instrument
Header, which contains the Instrument name and related settings. Your Multi can contain up to 64
Instruments, which will be spread across 4 pages of up to 16 Instruments each.

New (default)

Instrurnents

KONTAKT PLAY SERIES

S0UL SESSIONS

Lo

LO-FI GLOW ™ *
)

arKOGON

Instrurnents

Rack header

At the top of the Rack section is the Rack header, which is always visible as long as the Rack is in
Multi Instrument mode. Use the header to switch between the four Multi pages, show or hide Aux
send controls, and resize all Instrument Headers.

The Rack header contains the following features and controls:
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MNew (default)

1. Multi Name: A text field contains the name of your currently loaded Multi; if you have just
started Kontakt Player, this will read New (default), as this is the default Multi file that will be
loaded on startup. To change the name, click the text field and enter a new one.

2. Multi Browse (<> icons): The left and right arrow buttons will replace your Multi with the
previous or next one from the same directory, if there are any.

3. Pages: Four page buttons allow you to switch between the four Instrument pages. Each Multi
can contain up to 64 Instruments, arranged across four pages of 16 Instruments each. You can
use these pages to keep your Instruments in separate categories when your Multi is very large,
or you can just switch to the next page when the 16 available Instrument slots of your current
one are occupied.

4. Multi Workspace Buttons: These three buttons alter the workspace in some way, displaying or
hiding certain controls, or minimizing all Instruments at once.

KSP: Toggles the visibility of a global Script Editor pane, where you can create, edit and
manage Multi Scripts that operate on a higher level than normal Instrument Scripts.

Aux: Toggles the display of Aux send controls that enable you to adjust the signal level
at which each Instrument is routed to the Aux Channels. For more information, refer to
Working with Aux Channels.

Minimize/Maximize all Instrument Headers: Toggles all Instrument Headers in your multi
between their minimized and maximized size. At their normal size, Instrument Headers
contain more information, but also occupy more screen space. Use this feature to see an
overview of all Instruments on a page or to save screen space when you're not planning
to adjust any Instrument parameters. For more information, refer to Instrument header
(minimized)

@ Another option is to assign all Instruments on a page to channels of the same MIDI
port; if you have four ports at your disposal, this method lets you easily keep track of
your MIDI assignments in large Multis. However, assigning several Instruments to the
same MIDI channel is a quick way of creating layered sounds.

Instrument header

Whenever you open a new Instrument, it will appear in the Rack as an Instrument Header. Each
Instrument Header can be optionally reduced in size. At regular size, as shown below, the header
displays parameters that describe how the Instrument will work in the context of the current Multi.
It also provides some controls to adjust parameters like the Instrument’s output volume, panning
position, and solo/mute status.

The Instrument Header contains the following settings and controls:
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10.
11.

12.

13.

14.

15.

Instrument Options (cog icon): Opens the Instrument Options dialog, where you can access
features that affect the whole instrument such as voice stealing, MIDI transposition, and key/
velocity range.

Quick-Load Menu: Opens a dropdown menu that gives access to your Quick-Load Browser.

Instrument Name: Displays the Instrument's name. Edit the name by clicking on it and
entering a new one. The name displayed here will be identical to the file name (without the .nki
extension) when you load and save the Instrument.

Instrument Icon: Kontakt Instrument creators can choose from a range of icons that indicate
the general category of their creation. Some libraries will also use custom icons. Clicking this
icon will toggle the Instrument’s Performance View on or off, if available.

MIDI Channel: Indicates the currently assigned MIDI input channel that the Instrument will
respond to. Clicking it will open a drop-down menu that allows you to select a new MIDI
channel for this Instrument. The Omni setting will make it respond to MIDI data on any
channel; below it, the available ports of your MIDI interface will appear as sub-menus, each
one containing the 16 channels of the respective ports. Note that the maximum number of
distinct MIDI channels that you can use is 64 in the stand-alone version of Kontakt Player, and
16 when using Kontakt Player as a plug-in.

Output Channel: Displays the currently selected Output Channel that will receive the output
signal from this Instrument. Clicking on the channel name will open a drop-down menu with
all currently defined Output Channels, where you can assign the Instrument to a different
channel.

Memory: Indicates how much system memory is currently being used by the Sample data of
this Instrument.

Max Voices: Defines the maximum number of voices that the Instrument may use at any time.
Change this value by clicking on it, then dragging the mouse up or down. If you notice that the
number of currently used voices rises to the Max Voices value during play and you hear that
voices are being cut off, try increasing this value.

Purge: This button opens a drop-down menu that lets you execute the functions related
to Kontakt's purge mechanism on a per-instrument basis. The purge facility is explained in
section Purge menu.

Voices: This number indicates how many voices are currently being used by the Instrument.

Previous / Next buttons: The left/right arrow buttons exchange the Instrument with the
previous or next one from the same directory, respectively.

Snapshot View: Provides access to Snapshot features including loading, saving and deleting
Snapshots. For more information, refer to Snapshots.

Info View: Provides access to the Instrument's Audio and MIDI configuration, as well as Voices
and Memory consumption.

Solo button: When activated, all other Instruments in the Multi are muted, and the output
signal can be heard in isolation. How Kontakt Player will handle multiple Solo selections is
determined by the Solo Mode setting, refer to Handling.

Mute button: When activated, the current Instrument is muted, thus temporarily removing its
output signal from the Output Channel.
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Pan: Adjusts the panorama position of the Instrument’s output signal.

Volume: Adjusts the output volume of this Instrument. Select whether the default value of
Volume sliders will be -6 dB or 0 dB in the Options dialog.

PV: Toggles the Performance View panel on and off, if PV is available in the instrument. For
more information, refer to Performance view.

Aux: Shows and hides the row of Aux send sliders below this Instrument Header.

Minimize View: Minimizes the Instrument Header. This allows you to adjust the display sizes
of headers individually.

Remove Instrument: Removes the respective Instrument from the Multi.

Level Meters: LED-style bar graph meters indicate the current output levels across all
channels of this Instrument.

Tune: Adjusts the pitch of the Instrument. Turning the knob left or right will increase or
decrease the pitch, respectively. The control covers a range of +/- 3 octaves and moves in
semitone increments. Hold [Shift] while adjusting the control for fine tuning.

Purge menu

The purge mechanism in Kontakt Player keeps track of which Samples in an Instrument have been
actually triggered since the Instrument was loaded, and gives you the option of removing all other
Samples from the Instrument. This way, you can reduce the number of Samples that are being
kept in memory to the subset that you have actually used in your arrangement.

Using the purge facility, you can play your part once — this will allow Kontakt to gather which
Samples are actually being used — and then eliminate all unused Samples from the memory. The
Instrument will work as it did before, but notes or velocity ranges that didn't occur during the
analyzing phase won't play anymore. If you change your mind later, you can reload all Samples with
one mouse click.

@ Using purge functions like this can cause problems with instruments that randomly

trigger samples, or use round robin options. Check the library specification before you
use these options.

A purge menu is available for each Instrument; this allows you to use the purge feature on
Instruments whose parts are already finished, while keeping others that are still in active use
loaded in their entirety.

reset markers

update sample pool

purge all samples P
reload all samples

The Purge Menu

Instrument header (minimized)

If you want to save screen space, you can switch all (or a selection of individual) Instrument
Headers to a minimized view, which contains only the most important parameters and controls.



CLASSIC VIEW 98

In this mode, the Instrument Header includes only the Instrument Options button, the Instrument
Name field, Solo and Mute buttons, Output Volume, Pan sliders, Level Meters, and buttons for
removing this Instrument from your Multi and switching the header back to its normal size. For
more information on the related controls, refer to Instrument header.

To minimize all Instrument Headers:

p» Click the Minimize All Instrument Headers button, on the right side of Rack header.

LL“,J",‘ New (default) o-16 | 17-32
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To minimize individual Instrument Headers:

p» Click the Minimize Instrument Header button, on the right side of the Instrument Header.
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Performance view

Using Kontakt's internal scripting language, an Instrument can provide a custom control panel
called a Performance View. This feature provides Instrument-specific settings in a user-friendly
way that doesn't require access to Instrument Edit mode.

All Instruments included in the Kontakt library provide Performance Views, with various styles,
controls, and features. Some Instruments include performance controls, sound editing parameters,
marcos, and settings relating to Kontakt Player's operation and playback.

In Performance View, an Instrument's custom panel will appear below the Instrument Header in the
Rack.
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Loading and saving instruments

In order to add an Instrument to your Rack either in Kontakt format (.nki) or in one of the supported
third-party formats, first locate the Instrument file within the Browser. To load the instrument you
can use the following options:

Drag it into a blank space of the Rack to add it to the Multi.

Drag it onto an Instrument that is already in the Rack to replace that Instrument with the new
one.

Select the Load command from the Files menu; a file selection dialog will appear that lets you
locate and select any Instrument, Multi, or Instrument Bank file on your system.

If you have activated the Browser: Double click loads instrument option in the Options dialog,
you can also load Instruments by double-clicking them in the Browser.

After the Instrument has been loaded successfully, it will appear in the Rack. If required, Output and
MIDI channel assignments can be changed in the Instrument's Header. Once these are correctly
set, the Instrument can be played via your MIDI keyboard or the virtual on-screen keyboard. For
more information, refer to Instrument header.

Loading a Kontakt instrument

Once installed, you can start using your Kontakt Player Instruments. First open an instance of
Kontakt Player:

1. Open Kontakt Player as a plug-in in your host software (DAW), or as stand-alone application.
2. Locate the Kontakt Player Instrument in the Browser, on the left side of the user interface.
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3. Click Instruments to open the product's content.
4. Double-click the .nki file to load the instrument.

fangqin

'YANGQIN

Instrurnents

Yanggin - Autumn Wind.nki
Yanggin - Enjoying Teatime.nki
Yanggin - Flying Swords.nki
Yanggin - Hokori.nki

Yanggin - | Wilden Sky.nki

Yanggin - Jiang Nan.nki

- The instrument is loaded into the Kontakt Player rack.

Non-activated and non-licensed libraries

When loading an instrument from a non-activated or non-licensed library, the instrument will go
into a 15- minute demo mode.

Non-activated library

A non-activated Library is one which has not yet been installed or activated via Native Access.
When an instrument from a non-activated library is loaded in Kontakt Player, the following NOT
ACTIVATED error message will appear:

Straylight: Straylight - NOT ACTIVATED

If you owi i "Straylight" library,
click below to launch N oceed with the activation.

If this message appears, click the Activate Library button to open Native Access, and activate the
library.

@ Kontakt automatically detects if an installed library has been moved; the library box
will display options to either manually locate the library or remove the library box from
the Libraries tab.

Non-licensed library

When an instrument from a non-licensed library is loaded in Kontakt Player, the following FULL
Kontakt REQUIRED error message will appear:
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Shruti Box - FULL KONTAKT REQUIRED

"Shruti Box" is a non-Player Instrument. If you own a full Kontakt serial number,
click below to launch Native Access and proceed with the upgrade.

This error message indicates that you are attempting to load an unlicensed Kontakt library in
Kontakt Player. These non-licensed libraries can be used in the full version of Kontakt only. If you
own a full Kontakt serial number, click the Upgrade button below the error message to open Native
Access and upgrade. For more information on licensed Libraries, refer to Third-party Sample
Libraries.

Saving instruments

The entry Save as in the Header's File menu allows you to save any Instrument in your Rack as
an .nki file for later reuse. When you select this entry, a sub-menu will open that contains a list of
all Instruments in your current Multi. Selecting one of them opens a Save dialog that allows you to
choose a location and change the name of the Instrument. Note that the file name, without the .nki
extension, will be used as the Instrument name that is displayed in the Instrument Header.

Below the file selector, the dialog lets you choose how Kontakt should handle the Samples that
are being referenced by the Instrument. When you have added these Samples to your Instrument
during your current session, they're still in their original location, and the Zones in your Instrument
reference them via their full paths; the various options in the save dialog allow you to fine-tune this
behavior before your Instrument is written to disk.

The file dialog offers the following options for saving samples along with the instrument:

r 3
Save Instrument

save As: | New (default)|

Tags:

Where: I3 Instruments v

© Patch Only Absolute sample paths
Patch + Samples Sample sub-dir:
Monolith

A 4

+  Patch Only: Keeps samples in their original locations and only saves file references in the
instrument file. This achieves small file sizes, however moving references samples on the hard
drive will result in missing samples. For more information, refer to Samples Missing dialog.

If you activate Absolute Sample Paths for the Patch Only option, the Sample files will be
referenced by the Instrument with their absolute paths. In this case Kontakt will find he files
even if you move the Instrument file to a different location. When deacticated, the samples
must stay in the same path relative to the instrument in order to be found.


https://www.native-instruments.com/en/products/komplete/samplers/kontakt-6-player/third-party-sample-libraries/
https://www.native-instruments.com/en/products/komplete/samplers/kontakt-6-player/third-party-sample-libraries/
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Patch + Samples: Saves the .nki file and copy the contained Samples to a new location,
changing the file references within the Instrument to the copies in the process. If you leave
the Sample Sub-Folder option below set to its Use Default value, Kontakt will save the Sample
files to a Samples folder inside the destination location of your Instrument file; this folder will
be created if it doesn't exist yet. That way, the Samples will be kept close to the Instrument,
which helps you keeping track of them when doing backups or moving directories. You can
also specify a different Sample location, though; for example, you might want to use a common
Samples folder that resides in the directory of your project.

Monolith will combine the Instrument and its referenced Samples into a single, large file. This
is the safest option to choose in terms of keeping Sample references intact, as the Samples
cannot accidentally get separated from the Instrument later. This is also a good way to create
Instruments that should be distributed to other users of Kontakt.

Should you choose to save the referenced Samples along with your Instrument data by selecting
either Patch + Samples or Monolith, you further have the choice to save them in a Below the
file selector, the dialog lets you choose how Kontakt should handle the compressed format by
checking the box below the sub-folder field. In this case, Kontakt will write the Samples using a
proprietary, lossless audio codec that typically yields compression rates between 30% and 50%.
This will not only improve access performance when streaming the Instrument from disk, but will
also reduce its memory footprint, as Kontakt will decompress the Samples on-the-fly from memory
with very little CPU overhead. The downside of using compressed Samples, however, is that you
cannot use external wave editors to access them directly anymore.

When you are using Kontakt as a plug-in inside your host program and save your session, all Multi
and Instrument data will be included in this session file. Sample references will be saved in an
absolute fashion, so you may get a Samples Missing dialog when you open the session after you
have moved your Samples. In the Loading tab of the Options dialog, you can specify a base path
for your Non-Player content, and also choose if you want to store referenced paths relative to the
base path. When a host project is saved with this option selected, Non-Player content will be able
to resolve without the Missing Content dialog, if the libraries are located on the computer's path
as defined in the base path field. This makes it easy to share session files with Kontakt instances
across platforms. For more information, refer to Loading.

@ It's important to keep track of the ways the Sample and Instrument files on your hard
disk relate to each other; this protects you from unpleasant surprises when you move
files around, delete them, or recover Kontakt data from a backup.

Saving instruments when editing
When you edit an instrument, the following options are available in the File menu:

Save edited instrument - "New (default)" as...

Save as default instrument
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Save edited instrument "instrument name" as.... Opens the file dialog for saving the currently
edited instrument.

Save as default instrument: This command is only viewable when you are editing an
instrument. It saves the selected Instrument as your default one so whenever you create a
new Instrument, either via the New Instrument command of the Files menu, or by dragging
Samples from the Side pane into the Rack, Kontakt will use this Instrument as a template.

Batch resave

Kontakt Instruments that include references to external Sample files can cause problems if either
the Instrument or the Sample files are being moved to a different location. In such cases, you
will be presented with a Samples Missing dialog that asks you in which places Kontakt should
look for the missing files. While it's not a big problem to let Kontakt locate the Samples of one or
two Instruments via this dialog, and then re-save them afterwards in order to make the changes
permanent, the described effect will be worsened by an order of magnitude if it occurs with a
whole library. This can happen if you move the library folder or its contained sub-folders around,
and makes it very tiresome to access the library, as every attempt of loading an Instrument will be
answered with a Samples Missing dialog.

To fix the problem manually, you would have to load each Instrument, locate the missing Sample
files via the Samples Missing dialog, and re-save the Instrument to its original location within
the library folder. For large libraries, this is unfeasible. The Batch Re-save function automates
this process; when you select it, a selection dialog will appear, asking you to choose a folder.
After clicking Choose, all Instrument, Multi, and Bank files in this folder and its sub-folders will
automatically be scanned for unresolved Sample references; if any are found, the Samples Missing
dialog will appear once, allowing you to specify which places should be searched to resolve the
references. Once Kontakt has successfully located the Samples, the affected Instrument, Multi or
Bank files will be re-saved with corrected references, so afterwards, you'll have a consistent library
again.

@ As the Batch Re-save process will overwrite the Instrument, Multi, and Bank files
within your selected folder, it's recommended to make a backup of this folder before
you execute the command.

Collect samples / Batch compress

Collect samples/Batch compress: If you are working with a library of NKls that are referencing
samples in multiple locations, or you wish to compress (or even de-compress) the samples of a
library, this function allows you to compile samples, instruments, banks and multis into a single
location.

When you select this option, a dialog box will appear. Here you must select a source folder (where
your nki, nkb and nkm files are currently located) and a destination to which you wish to have these
files compiled and copied to.
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*Original®

Cancel Conuert

There are two different strategies for creating folders:

- Mirror source folder structure in the destination location: This mode keeps the folder
structure of the source folder when generating the destination folder structure, so there are
no explicit "Instruments" and "Collected Samples" subfolders in the destination folder when
using this mode. When batch-compressing a source/library folder and there is an Instrument in
the library folder that references a sample outside the source/library folder (and its subfolders),
a "Collected Samples" subfolder will be generated for saving the samples in the destination
folder.

- Collect Samples and create new destination folder structure: In this mode the folder
substructure of the target folder will be different from the source folder’s structure: Instrument
files will be saved in an "Instruments" subfolder, while all samples are saved in "Collected
Samples". This prevents having to resave the same sample more than once (if it was
referenced by more than one Instrument in the source folder for instance).

':9:' Whichever strategy you choose, samples and Instruments in the source folder will
neither be deleted nor updated. Impulse Response samples and wallpapers of the
source Instruments will be re-saved as well, but without compression.

You can choose between two options for the destination sample format:

+ For converting uncompressed samples to lossless compressed .ncw-files select Lossless
compressed NCW.

-+ For converting compressed .ncw-files back to an uncompressed format select Uncompressed
WAV / AIF.

@ Note that Batch Compress does not work for copy-protected libraries.
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Samples Missing dialog

Kontakt uses different ways to reference the Samples that are being used by an Instrument. When
Instruments are being saved in a monolith, the Sample data gets embedded in the file itself, and
thus can't be accidentally separated. In a lot of cases, though, you will encounter Instruments
that reference external Sample files on your system via their respective paths and file names. It's
obvious that while this method creates small Instrument files and avoids unnecessary duplication
of Sample data, it's not as bullet-proof as combining Instrument and Sample data into a monolith;
whenever you move referenced Sample files to a different location, Kontakt won't be able to
find them anymore in the location that's being specified within the respective Instrument files.
Depending on whether Kontakt used a relative path for referencing Samples, this can even happen
when you move Instrument files while keeping their referenced Samples in their original locations.

Whenever you attempt to load an Instrument whose Samples cannot be found in their expected
location, Kontakt will open a Content Missing dialog. This window offers various options that help
Kontakt locate the missing files on your system. Once it has found them, you can then re-save the
Instrument with the corrected references in order to make the changes permanent.

The Content Missing dialog contains the following options and features:

d not be Found:

1 Tune_1 G
1 Tune_1 G
1 Tune_1 G
1 Tune_1 G
1 Tune_1 G

Tune_10G

Abort Loading

File Display: In its upper half, the Content Missing dialog displays a list of all Sample files
that were referenced within the Instrument file, but couldn’t be found in the expected locations;
these locations are shown in the right column. Whenever you're not sure which action might
have caused the Content Missing dialog to appear, study the locations displayed in the
assumed at column carefully; you might recognize a folder that you've moved to a different
location at some point in the past.
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Resolve Automatically: In the lower half of the dialog, Kontakt provides a number of
commands that will either search for the missing files automatically (left side), or allow you
to specify the new location manually (right side). If you're not sure where the missing Samples
could be located, choose one of the automatic options on the left side:

Search Filesystem: This will search for the missing Samples on all file systems of your hard
disks. Depending on the size and speed of your hard disks, the scanning process might take
a considerable amount of time, but if the Sample files have not been renamed or deleted,
they will eventually be found.

Search Spotlight: Spotlight in macos'’s indexed “search” function built into the 0OS. (Unless
disabled) it's always running in the background updating file locations which means that if
you use the search spotlight feature it resolves missing sample conflicts immediately

Check for Duplicates: By default, all these options search for the missing Samples by their
file names only; in some cases, two or more different Samples on your hard disk might share
a common name. This can cause Kontakt to load the wrong Sample; if you notice this in
your Instrument, don't save it. Instead, remove it from your Multi, load it again, and repeat
the search process after you've activated the Check for Duplicates option at the bottom of
the Samples Missing dialog. This will make Kontakt examine any files with matching names
more thoroughly, which will sort out duplicates, but take more time than searching without this
option.

Resolve Manually: If you already know where the missing Samples are located on your system,
there is no need for an automatic search. Instead, choose one of the options on the right side,
which allow you to locate files manually:

Browse for Folder: \WWhen you click this button, a folder selection dialog will appear. After
you've located and chosen a folder, Kontakt will look for the missing Samples inside this
folder and all of its sub-folders.

Browse for Files: This option will ask you to locate each missing file manually, one at a time,
via a file selection dialog. During this process, the name of the currently searched file will be
displayed in the title bar of the selection dialog window.

If the resolve all possible option is activated, Kontakt will look for all missing Samples in
each location that you specify via the Browse for Folder or Browse for Files option. If it's
deactivated, you will be asked to provide a location for each missing file separately.

Once you have selected the appropriate search action, Kontakt will start the file scanning process.
During this scan, the missing Sample list will shrink whenever a Sample has been successfully
located. Once all Samples have been found, the dialog will disappear and the Instrument will be
loaded into your Rack. You should now make sure that it works correctly and then re-save it to its
original location with the Save as... command in the Files menu.

393 If you have moved a whole library, and the Samples Missing dialog appears each
time you attempt to load an Instrument from this library, you don't need to click
through the Samples Missing dialog and re-save the Instrument each time; the Batch
Re-Save command in the Files menu allows you to locate the referenced Samples
of all Instruments below a folder at once and re-save all of them automatically. This
command is explained in section Handling of this manual.

If there are still missing Samples after the scanning process, the Content Missing dialog will
reappear, which allows you to try another search option. If each attempt to locate the missing
Samples fails, they either don't exist on your system anymore, or have been renamed. In such
cases, you can choose to either abort loading the Instrument by clicking the right button at the
bottom of the dialog, or load the Instrument without the missing Samples with the left button.
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Allow alternate file types: This option allows you to ignore the audio file extension and resolve
missing samples with alternative file types with the same name. For example, if you had an
instrument which referenced uncompressed WAV files, but at some point you compressed the
files to NCW format, you can reference the NCW files in place of the WAV files.

Keep search mode and selected folders for the current session: If you are opening multiple
Instruments that could require searching for Samples in the same location, checking this option
will tell Kontakt to repeat the search mode for any newly opened Instrument while you are still
running the same session. Closing and reopening Kontakt will reset this option.

Snapshots

Snapshots save the state of Kontakt instruments for easy recall. Using Snapshots, you can create
your own preset sounds, save them in the .nksn file format and use them in other projects, across
computers or even share them with other users.

>

o 6 Tune
0 0 Mo 128 )

To access Snapshot view in the Instrument Header, click the camera icon. You can switch back
to Info View by clicking the i icon.

Tremolo Modwhe Sound Preset

A

Sounding Motes T 10 |

Snapshots Overview

Snapshots contain the following key features:

~ Yanggqin - Flying Swords

Furge
@ + User Preset <] :
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Load Snapshot: Opens the Snapshot menu where you can load a Snapshot from the Factory
and/or User library. For more information, refer to Loading a Snapshot.

Snapshot Name: Displays the name of the currently selected Snapshot.

Snapshot Previous/Next (<> icons): Enables you to quickly browse and load Snapshots.
Pressing an arrow icon will load the previous or next Snapshot in the selected category. If no
Snapshot is active, the first Snapshot on the list will be loaded. For more information, refer to
Loading a Snapshot.

Save Snapshot (floppy disk icon): Enables you to save changes made to a sound. When
a User Snapshot is saved, the setting and parameter controls are stored within it and can
be accessed at any time via the User library. For more information, refer to Saving a User
Snapshot.

Snapshot View (camera icon): Provides access to the Snapshot features described above;
saving, loading, browsing, and deleting. When Snapshot View is selected, configuration
settings and features relating to the Info View are replaced in the display.
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Loading a Snapshot

Snapshots are loaded from the drop-down menu in the top header of the instrument. You can also
use the Browse arrows to load the previous or next preset. Some Instruments contain a collection
of Factory Snapshots, while other Instruments only facilitate User Snapshots.

Loading a Factory Snapshot

Factory Snapshots are only available for Kontakt Player Libraries, so this section only applies if
you own Komplete 9 or a Kontakt Player library released after Komplete 9. Some of the Komplete
Libraries seem minimalistic at first glance, but the true sound design potential can be tapped by
tweaking the parameters available on the Instrument's user interface. Our sound designers aim to
create inspiring Snapshots that showcase the range of sounds available from just one instrument.

To load a Factory Snapshot:

1. Click the Snapshot View (camera icon) to open Snapshot view.

2. Click the arrow icon next to the Snapshot name field to open the Snapshot menu.

+ Cloud Supply

@ v%ﬁa‘ly User Preset 01

3. Select the Factory category to load a Factory preset (if available), or select the User category to
load one of your own snapshots.

+ Cloud Supply

~ fw Lizer Preset 01
Factory #
User L4

4. Select an instrument category (if available).

Cloud Supply - INIT
User F FX
Keys

Keysplits
Lead
Mallet
Organ
Pad
Pluck

o AU R, ., S R G R
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5. Click a Snapshot to load it.

Cloud Supply - INIT
FX Gretel

Keys Insobordinate

Keysplits Ranger
Lead Spheres
Mallet Spooked
Organ StarGate
Pad

Pluck

- The loaded Snapshot is displayed in the instrument header.

Loading a User Snapshot

To load a Snapshot from the menu:

1. Click the Snapshot View (camera icon) to open Snapshot view.

2. Click the arrow icon next to the Snapshot name field to open the Snapshot menu.
3. Select the User category (if available).

4. Click a Snapshot to load it.

- The loaded Snapshot is displayed in the instrument header.

@ Note that the User category will not appear until you have first saved a Snapshot.

Loading the previous or next Snapshot
To load the previous or next Snapshot in the list:

1. Click the Snapshot View (camera icon) to open Snapshot view.

2. Click the arrow icons (<>) in the Snapshot header to browse through the Snapshots list.

G o

Furge =

- The previous or next Snapshot will load immediately each time an arrow icon is clicked.

Loading a Snapshot from the file system

Kontakt Player supports two ways of loading Snapshot files (.nksn) from your file system. This
enables you to use your favorite Snapshots without altering the installation on the studio computer.
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@ A Snapshot is not automatically saved to the default location when you open it, so it
will not be available in the Snapshot menu.

Using drag and drop

To load a Snapshot from any disk:

1. Open Kontakt Player .

2. Locate an .nksn file in your file system.

3. Drag the file from its current location onto an empty area of the Rack.

If you drag a Snapshot onto an active Instrument in the Rack, it will be replaced by the
Instrument loaded from the Snapshot.

- Kontakt Player will load a new instance of the corresponding Instrument with the selected
Snapshot.

® KONTAKT PLAYER

ELECTION

Instruments

B Sprinkle Tens[gn,nksn

Using double-click

1. Open Kontakt Player.

2. Locate an .nksn file in your file system.

3. Double-click the Snapshot file in the Finder (Mac OS X) or File Explorer (Windows).

‘e0e@ Analog Dreams 2.0
< 2 BPmio = %y A O Q
Favorites Name ~  Kind
£ All My Files > Bass Folder

[Z) Macintosh HD 2( Folder

""" | Alert Riser.nksn Kontakt Snapshot

[ Desktop “i&| Bubble Boi.nksn Kontakt Snapshot

© Downloads
L | Cybernetic Meadow.nksn Kontakt Snapshot

7 Applications “&i| Dark.nksn Kontakt Snapshot

@ Documents ‘&l Grumblecore.nksn Kontakt Snapshot

- Anew Instrument instance is inserted in Kontakt Player and the Snapshot is loaded.

Saving a User Snapshot

Snapshots can be saved at any time while you are working on them. By loading a Factory Snapshot
and adjusting some of its parameters, you can then save a User Snapshot. The Kontakt Factory
Library does not come with Snapshots, so in order to demonstrate the full feature set, first save a
Snapshot.
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':9:' You can transfer any of your Snapshots to another computer by copying the
respective Snapshot files.

Saving a User Snapshot
To save a Snapshot:

1. Click the Snapshot View button (camera icon) to open Snapshot view.

+ Yanggqin - Flying Swords é hes
€ Output: st 1 - o 0 M 28 e - 0.00
@ 3 MIDI Ch: [A] 2 3 .36 ME ok
Tremolo Modwhes | Sound Preset
A VINTAGE
Sounding MNotes Tremalo YANGQIN

— Tune
o 0.00
™
Tremolo Modwhes Sound Preset
A < » VINTAGE
Sounding Notes Tremalo YANGQIN

rter @ narme for your snapshot

My User Preset O

4. Click Save to finish the process and close the dialog box.

- Your Snapshot .nksn file is saved to the User Snapshot Library. It appears in the User Snapshot
list.

User Content folder
All User Snapshots are automatically stored in the default User Content folder:

Mac OS Macintosh  HD/Users/<User  Name>/Documents/Native  Instruments/User
X: Content/Kontakt Factory Library/Electric Grand/Triple Peaks.nksn

Windows: C:\Users\<User Name>\My Documents\Native Instruments\User Content\Kontakt
Factory Library\Yangqin\.nksn

@ Make sure you include your Documents/My Documents folder in your regular data
backups.
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Deleting a User Snapshot

User Snapshots can be deleted using the bin icon in the Instrument header. Snapshots are saved
on a per-Instrument basis, so in order to delete a Snapshot in Kontakt, you first have to load it.

To delete a User Snapshot:

1. Click the Snapshot view (camera icon) to open Snapshot view.

~ Yangqin - Flying Sword 6 Tune
£ put: 1 12 0.00
@ @ M0l Ch: [A] 2
Tremolo Modwt Sound Preset
A VINTAGH
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3. Confirm deletion of the Snapshot by selecting Yes in the dialog box.

Sounding Motes

- The User Snapshot .nksn file is deleted from the folder on your hard disk as well as removed
from the Snapshot Menu.

@ You can only delete User Snapshots. All Factory Snapshots are read-only.

Global purge

Global purge keeps track of which samples in an instance have been actually triggered in a
session, and gives you the option of removing all other samples from the Instrument. This way,
you can reduce the number of samples that are being kept in memory to the subset that you have
actually used in your arrangement. Place your mouse over this entry in the Files menu to open a
submenu with options for sample purging and loading.

The Global purge sub-menu contains four entries:

Global purge Reset markers

ptional Update sample pool

Purge all samples

Controller
Reload all samples

- Reset markers: Whenever Kontakt plays a sample in any of your Instruments, it will flag the
respective sample as being used. Using this function, you can delete all of these flags, thereby
resetting all data that Kontakt has gathered about sample usage so far. After you have finished
your work on a part, you should select this function once and then play your part; this way, only
the notes that have actually made it into the final part will be flagged as used. Afterwards, you
can proceed by choosing the Update sample pool function described below.
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Update sample pool: This function removes all samples that are not currently flagged as being
used from memory, and reloads any currently purged samples that have been triggered since
the last purge operation. In other words, it brings the sample pool in sync with the sample
usage flags it has gathered since the last purge operation.

Purge all samples: Unloads all samples from RAM. This allows you to reverse the usual purge
process: you can play your arrangement in a “silent run’, and then load only the Samples that
are actually being used via the Update sample pool command afterwards.

Reload all samples: Reloads all Samples, reverting any previous purge actions.

39: You can also purge samples per Instrument using the Purge menu in the Instrument
Header. See Purge menu for more information.

Classic view reference

The following chapter describe all the different sections and modules that you can find in Kontakt's
Classic View.

Master Editor

The Master Editor panel contains a number of global controls that affect the behavior of all
Instruments in your Multi, as well as some common utility functions. To display the Master Editor
panel, select the Master option in the Workspace menu.

The Master Editor panel contains the following features:

! Valume Valume Valume

0.00 dB 20, 33% 33%

1. Master Vol: Adjusts the volume of all Output and Aux Channels. The default setting is 0.0 dB,
which leaves the output levels unaffected.

2. Master Tune: Adjusts the master reference tuning from its default value of A4 = 440 Hz.
This is especially useful in situations where Kontakt Player will be combined with the sound
of orchestras, historical ensembles, or folk music, which frequently use different reference
tunings.
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3. Master Tempo: Displays the current global tempo in beats per minute, as well as sync options
and song position controls.

Ext: In stand-alone mode, the Ext button allows you to sync Kontakt Player to an external
MIDI clock.If running as a plug-in in your host program, Kontakt Player will use and follow
your song tempo by default. Deactivate the Ext to specify the tempo manually.

Tap: The Tap button offers a more intuitive way to adjust the Master Editor tempo. Tap
the button rhythmically in quarter note values and Kontakt Player will measure the time
between taps, adjusting the tempo value accordingly. As a plug-in, the Tap button is active
only when the Extern Sync. parameter is turned off.

Play/Re-wind: The play and re-wind buttons adjust Kontakt Player's internal song position.
This is necessary for instruments that require song position information, like a drum
machine.

Tempo: Located below the BPM label, this value affects the playback speed of sliced loops
and all time-related controls that can be synchronized to the tempo. In stand-alone mode,
adjust the Master Tempo by clicking the value and entering a new one, or by tapping a new
tempo using the Tap button.

4. Metronome: Provides a simple metronome that can be switched on and off at any time
by clicking the metronome icon. The value readout allows you to adjust the volume of the
metronome click.

5. Reference Tone: Provides a reference tone that allows you to tune other instruments in
accordance to Kontakt Player’s current reference tuning.

On/Off: Activate the reference tone by clicking the tuning fork icon.

Pitch: Change the pitch of the reference tone by clicking and dragging on the note readout
to the right of the tuning fork.

Volume: Adjust the volume of the reference tone by clicking and dragging the Vol readout,
or double-clicking the field and entering a value.

Side Pane (Classic view)

The Side pane in the Classic view allows you to quickly organize and navigate through any number
of files that can be used in Kontakt Player. It display a convenient overview of various aspects of
the currently selected Instrument. The Side pane be used to navigate through your file system to
locate and load Kontakt Player Instruments, and also manage and browse the contents of your
Libraries. It allows you to assign host and MIDI automation sources to Instrument parameters and
to drag and drop items from the Side panel into the Rack.

To display the Side pane:

p Click the Minimize icon from the Control panel to expand the Rack.

= The Side pane will appear on the left side of the Rack.
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The Side pane

Libraries Tab
The Libraries Tab provides direct access to all Kontakt libraries installed on your computer.

&% [Manage Libraries  A-Z Instr Mau

Arkhis
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Inztrurnents

Refresh: Reloads the list of libraries.

2. Manage Libraries: Opens the Library tab in the Options dialog. There you can hide or show
libraries, open Native Access to install new libraries, and manage existing installations. For
more information, refer to Libraries.

3. A-Z: Sorts the libraries alphabetically. When deactivated, the Library tab reverts to the previous
custom sorting.

4. Search field: Allows you to enter a search string in order to find particular libraries within the
Library tab.
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5. Instr Nav (Instrument Navigation): Shows or hides the Instrument Navigator pane at the
bottom of the Browser.

6. Instruments: Displays all Instruments included in the library.

Function Menu: Opens a drop-down menu with additional library options. For more
information, refer to Function Menu.

Loading and Saving Instruments and Multis

To load an Instrument or a Multi, click the Instruments or Multis button and navigate through
the library structure like in the lower pane of the Files tab.

When using Kontakt Player libraries, you can save your own Instruments and Multis to the
original library or to any custom location. When saving your own variations to the original
location of your library, these Instruments and Multis will also appear in the Libraries tab.

Function Menu

The Function menu provides access to important resources like the library readme file and
manuals, and maintenance tasks such as locating a library and hiding a library box. The Function
menu is located at the bottom right of the Library box. Click the arrow to open the drop-down
menu.

The Function menu contains the following options:

‘fangdgin

Instrurnents

Open containing folder
Hide library

ns
KONTAKT PLAY SERIES

SOUL SESSIONS Readme.pdf

Instrurnents License Agreement 4

Online Documentation.webloc

The Function menu

Open containing folder: Opens the location of the library on your hard disk, in your operating
system's file browser.

Hide library: Removes the library from the Library tab. Note that this does not delete or uninstall
the library. If you want the library to appear in the Libraries tab again, you can do this via the
Libraries tab in the Options dialog. For more information, refer to Libraries.

Readme.txt: If the library folder contains a readme text file, it will be displayed here. Clicking this
option will open the file.

License Agreement: Contains a list of the licenses for the selected library.

Online Documentation: Clicking this option will open the user manual.

Library Activation

Libraries are activated through Native Access, but it is possible to quickly open Native Access to
activate a specific library from the Kontakt Player Side pane.

1. Afterinstalling a library, open Kontakt Player.
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Locate the library in the Libraries tab of the Side pane.
Click on the Activate button on the respective library and a log-in screen will open.
Native Access will open and prompt you to enter a serial number for the library.

o b @D

Enter a serial number and click Activate.

- Your library will now be activated and ready to play.

Files Tab

This section of the Side pane allows you to navigate your file system in a tree-based way, which
will be immediately familiar if you're accustomed to your operating system’s file browsers and
selectors. It consists of two main panes and an audition toolbar at the bottom of the section. There
is an optional third pane, the Instrument Navigator, which you can toggle via the InstrNav button
just below the tabs. This pane is also available on the Libraries tab, refer to Libraries Tab.

Click the horizontal splitter bars that separate the panes and drag them up or down in order to
change the height of the respective panes.

Libraries Monitor Rutomation

- Instr Hau

=
B
B
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The Files tab of the Side pane provides a file system navigator
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Upper (Container) Pane

The upper pane shows all container objects on your computer in a tree structure. The term
"container" encompasses all items that contain other objects, such as volumes (like hard disks,
CD-ROMs or network places), folders and monolithic sampler files that serve as "virtual folders"
(more on this later). A + icon next to an object indicates that there are further objects contained
within, which are not currently being shown. Display those by clicking the + icon. Conversely,
clicking the - icon next to an object hides all its contents from the tree view.

(1 |

+

' T FFFEFEEREN
1
k!

The upper pane of the File Browser displays a navigable tree structure of your file system.

Middle (Objects) Pane

Whenever a container object that you have selected in the upper pane contains items which can be
used in Kontakt Player, these will show up in the middle pane. In contrast to the multi-dimensional
tree structure of the upper pane, this list is always flat and does not span multiple folders. In
addition to relevant files, folders (if any) will also show up in this list and can be navigated to via
double-clicking. The first item of the list will usually be the parent directory, indicated with an arrow
icon. This means you don't need to use the upper pane to navigate through folders, although it's
usually faster and more convenient.

Marne

The middle pane of the File Browser, displaying a number of Samples, their file sizes, native tempos, and modification dates.

Information on the displayed items is spread across four columns; in addition to the file name,
size and modification date, there's also a tempo column that indicates the native tempo of sliced
loops. You can change the width of these columns by clicking and dragging the separator bars
between their labels. Clicking on a column label will change the sort order of the list according to
the respective value and clicking on the same label again will reverse the ordering direction.
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Once you have found one or more items that you want to use in Kontakt Player, there are several
ways to load them:

Double-click a Multi file (.(nkm) or drag it from the Side pane into the Rack to load it; Kontakt will
ask you whether you want to replace your current Multi or merge the one you've selected with
the existing Multi.

Double-click an Instrument file (.nki) or drag it from the Side pane onto a free space in the Rack
to add it to your current Multi. Kontakt will assign a MIDI channel according to the MIDI channel
assignment for loaded patches setting in the Options dialog. This also works with multiple
Instruments.

Drag an Instrument onto an existing Instrument Header in your Rack to make it replace the
respective Instrument. Kontakt will keep the MIDI channel setting of the previous Instrument.

Instrument Navigator Pane

The Instrument Navigator shows a list of all Instruments in the Rack, which is updated at all times.
It is divided into 4 pages of up to 16 Instruments each, and displays the Instrument names along
with M (mute) and S (solo) indicators. It provides a good way to keep the bigger overview when
you're editing an Instrument, when the Rack does not convey any information about Instruments
other than the currently edited one.

The Instrument Navigator list will keep in sync with the page and Instrument selection in the Rack
and vice versa. To switch to one of the four Instrument pages, you can either use the page buttons
in the Rack header (if it's in Multi Instrument mode), or click the page numbers at the top of the
Instrument Navigator list. Similarly, you can select an Instrument by clicking on either its header
in the Rack, or its entry in the Instrument Navigator pane. If an Instrument that you select is
not currently visible in the Instrument Navigator list, it will automatically scroll to its list position.
Double-clicking an Instrument in the Instrument Navigator list will open it for editing in the Rack.

» To display the Instrument Navigator pane, click on the InstrNav button at the top of the Side
pane.

Instrument Navigator

The Instrument Navigator pane, displaying a number of loaded Instruments in the Multi.

':Q:' The Instrument Navigator is not strictly specific to the Files tab, but rather a utility
window that's available in various tabs in the Side pane. It's explained here for sake of
consistency, and referenced briefly in sections about other places where it's available.

Audition Strip

The Audition Strip allows you to listen to audio files prior to loading them. This feature works with
audio files and sliced loops that you select in the lower section of the Side pane. Note that when
auditioning sliced loops, they will not be played in their native tempo (which is being displayed in
the Side pane list), but in the current tempo of your host or, if you're running Kontakt in stand-alone
mode, the tempo that's set in the Master Editor.
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The Audition Strip contains the following controls:

I » FAUTO

The Audition Strip allows you to play any Sample that you select in the Side pane.

Volume slider: This slider adjusts the sample playback level.

Play button: This button plays the selected sample once or, if a sample is currently being
auditioned, stops the playback.

Auto button: When activated, Kontakt will automatically play a sample once when you click it.

Refresh Button

Just below the Side pane tabs, you will find a series of function buttons and drop-down menus
that are specific to the currently visible tab. On the Files tab, this row starts on the left side with a
Refresh button, depicted by a circled arrow.

Whenever the File Browser has not yet picked up changes that recently occurred in your file
system, such as newly installed or removed sample libraries, you can force an update of the file
display by clicking this button.

The View Menu

The View menu in the Files tab contains options and functions that alter the way in which
information will be shown in the File Browser panes.
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Libraries Autarnation
%] Wiew [ +  Instr Mau

- & Show network drives

Show removable drives

Quick-jump 1 [empty]
Quick-jump 2 [empty]
Quick-jump 3 [empty]
Quick-jump 4 [empty]
Quick-jump 5 [empty]
Quick-jump 6 [empty]
Quick-jump 7 [empty]

Quick-jump 8 [empty]

Quick-jump 9 [empty]
Quick-jump 10 [empty]

Lock current quick-jump

The view menu of the File Browser contains options that determine which items will be shown.

The first two items in this menu, labeled Show network drives, and Show removable drives,
are toggle options; selecting them will switch them on, indicated with a small diamond next to
their label. With these, you can adjust whether the File Browser should include mounted network
volumes, and removable drives.

Below the options, you'll find multiple slots labeled Quick-jump and numbered 1 to 10. Quick-
jumps are location memories that you can use to conveniently access a number of frequently-
visited places in your file system without the need to navigate there using the container pane each
time. The handling is simple: any location you navigate to in the File Browser gets immediately
saved to the currently selected Quick-jump entry. Once you switch to another Quick-jump location,
the previously selected one will keep its value. Switching back to it will bring you to the saved
location, but watch out — if you navigate any further now, the Quick-jump memory will be changed
accordingly. If you don't want this, activate the Lock current quick-jump option at the bottom of
the View menu to freeze the saved location. Instead of using the pull-down menu each time, you
can also use [Ctrl] + [F1] through [Ctrl] + [F10] (Windows) or [Alt]-[F1] through [Alt]-[F10] (Mac) to
access the respective Quick-jump locations via your keyboard.

Monitor Tab

When editing a complex Instrument with various Groups and Zones, it' is easy to get lost in
KONNTAKT's editing facilities. The Monitor tab counteracts this by providing a useful overview
of various aspects of your currently edited Instrument. Similar in nature to the Instrument
Navigator pane, it shows a continually updated and searchable list of all Groups and Zones in
your Instrument. It allows you to quickly include and exclude Groups for editing, and provides a
context sensitive parameter view that shows the values of the parameter you touched last across
all Groups.
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Libraries Maonitor Autornation

Groups Fararneter Engine

Engine Fernory:

Monitor tab, displaying all Parameters of the Gongs Instrument

At the top, you'll notice a tool bar with five buttons, the first four of which will switch the Monitor
view into the respective display mode:

Groups

This view provides a list of all Groups in your Instrument. It will only work in Instrument Edit mode.
The leftmost column indicates whether a Group is marked for editing — it corresponds to the
checkboxes next to the Group names in the Group Editor — and can be clicked on to toggle the edit
status of the respective Group.

':9:' The Group selection only affects commands that can be found in the "Edit" menu of
the Group Editor, and is thus different from the editing checkbox, which is being used
for changing parameters across multiple Groups.

At the right side of the list, the Group indexes are displayed as a quick reference for KSP script
editing, as well as the number of Zones included. Groups can be selected by clicking on their
names; multiple selections work in the same way as they do in the File Browser, i.e. [Shift]-clicking
below or above a selected Group will select a range, a [Ctrl]+click ([Cmd]+click on Mac OS X) will
add Groups to the active selection; [Alt]+click will select all currently visible Groups for editing.

You can rename Groups by double-clicking on their name and entering a new one.

Right-clicking on a Group will open a context menu with various Group-related actions; this is
identical to the Edit menu of the Group Editor.
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Alicias Keys Groups Index fones
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The Group context menu

You can toggle a Quick-Search function by clicking on the button with the magnifying glass symbol
to the right side of the list header. This will show a text input box above the list; while it is visible,
the list will only show Groups whose names contain whatever you enter into this box.

You can hide (and, in consequence, deactivate) the Quick-Search feature by clicking the "X" button
on the right side of the search bar.

Zones

This view displays a list of all Zones that are contained in your Instrument across all Groups.
Otherwise, it works exactly like the Groups view, and includes the Quick-Search feature as well.

Each row displays from left to right: The Zone, its Index, its ID, and finally the Group the Zone
belongs to.

Double-clicking a Zone will open it in the Wave Editor.

Parameter

When you switch to this view and touch any knob, the Monitor pane will show the values of the
respective parameter across all Groups in your currently edited Instrument, or, if you're not in
Instrument Edit mode, across all Instruments in your Multi. This makes for a convenient way to
compare settings across Groups. You can also change parameter values directly within the list by
clicking on their value and moving the mouse vertically, just like you would do on the respective
knob.
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Fararneter Engine

Large Go

Larg

Monitor tab, displaying the values of EQ frequency parameters across multiple Groups.

Of course, parameters will only appear next to Groups that actually contain the edited parameter
as well. For instance, if you're adjusting the Grain parameter of the Source Module — which is
unique to the Time Machine mode — all Groups that are not currently in Time Machine mode, and
therefore don't know this parameter, will be indicated with NA in the Value column.

Engine

This sub-tab displays an overview of various system resources, such as detailed memory and CPU
usage statistics. The information provided on this page is mainly intended for power users; when
you have a problem and get in contact with the Native Instruments support, they might ask you for
specific values from this page.

Libraries IMonitor
Groups 3 Pararmeter Engine

Engire Mermo

CPLU Loar

The Engine page provides an overview of the current status of Kontakt's audio engine.

The Restart Engine button allows you to force a reinitialization of Kontakt's audio engine in case of
CPU overruns.
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If you're using Kontakt as a plug-in, there will be another button below labeled Offline (Bounce)
Mode. This is intended for hosts that don't correctly advertise this mode to their plug-ins when
bouncing or freezing tracks. You can check if your host behaves correctly in this regard by
observing the state of the button when bouncing or freezing; if it turns orange, Kontakt receives the
bounce signal from the sequencer. If it doesn't and you experience crackles or drop-outs, you can
activate this button manually before bouncing or freezing.

CPU Profiling Mode: Switch to CPU Profiling mode in order to identify which parts of your
Instruments are currently consuming the largest share of processing power. Percentages are
shown in the instrument name as well as in the Source module in Edit mode and in the top parts of
all effects in the effect chains.

':9:' Use the bottom part of the effect icons to switch to different effect slots for editing
while in CPU Profiling mode.

Instrument name: observe the Rack to identify most consuming Instruments first, then switch
to Edit mode.

Source module: switch to a different HQI setting if CPU usage is too high. If you are using Time
Machine Pro, consider downgrading to the lighter Time Machine engines.

Group Inserts: Move memory-intensive effects without attached modulators to the Instrument
or Bus Inserts instead. Remember group effects are calculated per voice!

Instrument Inserts / Bus Inserts / Sends: Move memory-intensive effects to the Outputs
section, inserts into the regular output channel, sends into the Aux channels.

Just like the File Browser, the Monitor pane optionally provides an Instrument Navigator list.
This can be shown and hidden with the rightmost button of the Monitor toolbar. For an in-depth
explanation of what this pane does, refer to Instrument Navigator Pane.

Automation Tab

When you need to control a parameter of an Instrument from outside Kontakt Player, for example,
using a sequencer’s automation system or MIDI controller data generated by an external fader box,
you can easily pick and assign the appropriate automation source from the Automation tab of the
Side pane.
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Libraries iles Maonitar Automnation

To MIDI lea
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Parameter Instrument Group

The MIDI Automation page displays a list of assignable MIDI controllers at the top, and details of the selected assignment at
its bottom.

At the top of the Automation tab, two buttons allow you to switch between the list of automation
sources that are provided by your host and MIDI controllers. Assigning a source to a parameter
works the same way in both lists, so the described concepts and process for working with MIDI
automation can be applied to the host automation workflow.

Assign automation by selecting a source from the list and dragging it onto a knob whose
parameter you want to automate. If you want to assign a fader of a keyboard or a MIDI
controller, but you are unsure which controller number is correct, just move the fader when the
MIDI automation list is visible and Kontakt Player will flash a red dot next to the respective list
entry when it receives any MIDI controller data. This allows you to quickly spot and assign the
appropriate controller.

Another way to assign a source to a parameter is via the Learn button. Press it once to enter Learn
Single mode. After moving a modulation source on your MIDI controller, such as a knob or slider,
click on a parameter of the instrument to assign it. Learn Single mode will deactivate automatically
and the control will become usable immediately.

To do multiple MIDI assignments successively, press the Learn button twice to enter Learn
Multiple mode. This allows repeating the above steps of turning a control and clicking on a
parameter indefinitely. Click the Learn Multiple button to exit this mode and start using the
controls.
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Q" Multiple parameters can be assigned to the same automation source. This allows

you to control multiple aspects of your Instrument with a single controller, such as
increasing the brightness of an Instrument in combination with the loudness. Also
note that modulation wheels usually send MIDI Controller #1, while volume controls
send #7.

You can edit assignments and their parameters by selecting them in the list. If the selected item
is assigned to one or more parameters, these will show up in the list below. At the bottom of the
pane, you can adjust some parameters of the assignment that is selected in the lower list:

From % / To %: Adjusts the range of the assigned parameter. By default, automation controllers
are mapped in a way that makes them cover the whole available range of the parameter. By
changing these values, you can alter the scaling of the assignment so that the automation
values are mapped to a limited range of the assigned parameter. This allows you to automate
the section of the parameter’s range with finer resolution.

Soft Takeover: Avoids sudden parameter jumps that can happen if received automation data
is different from the current value of the assigned parameter. If you activate this button, the
assigned parameter will not be changed until an automation value is received that matches the
parameter’s current value. A typical example would be the assignment of an external fader to a
filter's cutoff parameter; if the filter cutoff is currently set to 50% and you slowly move the fader
upwards, Kontakt will softly pick it up as soon as it reaches its mid-point.

Remove: Deletes the automation assignment selected in the lower list.

Assigning MIDI Controllers via the Learn button
To assign MIDI controllers to controls via the Learn button:

1.

Make sure at least one instrument is loaded and set to the MIDI port and channel of your
hardware controller.

2. Click the Automation tab in the Side pane.
3. Select the MIDI Automation sub-tab.
4. Click the Learn button once to assign a single MIDI control. Click it twice to assign many MIDI

controls. The button will show either Learn Single or Learn Multiple.

5. Move the control on your MIDI device that you want to assign.

6. Click the control in the GUI of the instrument that you want to assign.

7. When assigning multiple controls using Learn Multiple, repeat step 5 and 6 until all controls

-

have been assigned. Afterwards click the Learn button again to stop assigning controls and
start using them.

The MIDI Controller is assigned to the parameter.

Assigning MIDI Controllers in the Side Pane
If you are unable to assign MIDI controllers as described in MIDI Learn, there is an alternative way:

1.

Make sure at least one instrument is loaded and set to the MIDI port and channel of your
hardware controller.

2. Click the Automation tab in the Side pane.
3. Select the MIDI Automation sub-tab.

4. Turn a knob or move a slider on your hardware controller.
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5. In the Side pane, you should see a flash next to the CC# that is used by your external controller;
in addition, the MIDI symbol in the Instrument header should flash.

6. If this does not work, open the Options dialog.
7. Select the MIDI tab.

8. Select Inputs. Check if your MIDI hardware is selected as input for the same port you have
assigned the instrument in question to.

9. If the MIDI input is setup correctly, drag and drop the MIDI CC# you wish to use onto the
parameter you wish to control.

- The MIDI Controller is assigned to the parameter.

Mol CC assigned to
CCo not .

CCH not ¢

MIDI controller reception in Kontakt Player

Removing MIDI Controller Assignments
To remove an assignment made to a specific controller:

1. Click the Automation tab in the Side pane.
2. Select the MIDI Automation sub-tab.

3. Find the MIDI control whose assignment you wish to remove, either by searching, or by moving
the control and seeing which number in the list is highlighted with the lightning bolt symbol.

4. Select the control in the list and click the Remove button.

- The MIDI controller assignment is removed.

Quick-Load Catalog

The Quick-Load catalog is an organizational tool that helps you manage your Instruments, Banks,
and Multis. It is similar to the File Browser in that it provides access to a hierarchical directory
structure. However, the Quick-Load catalog allows you to freely define it's structure without
consideration for file paths, library relationships, or formats. This acts as a type of "virtual file
system", that exists in parallel to the actual file system on your hard disks. Use the Quick-Load
catalog to freely organize and index your files, without copying or moving them to different
locations.

The Quick-Load Browser appears below the Rack when you right-click inside the empty Rack space
below the Instrument Headers. Resize this pane by clicking and dragging the bar that separates it
from the Rack. When the Quick-Load Browser is visible, it will hide the on-screen keyboard.

Quick-Load & Fulti Eank Instrurnent

B Leads
I Liquinth

The Quick-Load Browser, displaying an exemplary directory structure.
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Lock: Protects the Quick-Load file structure from being altered when dragging files and folders.

Catalog Type: Switches between the catalogs of Multis, Banks, and Instruments, respectively.
The contents of these catalogs are in no way related to each other, so independent directory
structures can be created for each of the three catalog types.

Close (x icon): Closes the Quick-Load Browser. Right-click inside the empty region of the Rack
to hide the Browser again. When the Quick-Load Browser is visible, the on-screen keyboard is
hidden.

Directory Area: Displays multiple layers of a directory tree in a horizontal arrangement of
columns. When a subdirectory in one column is selected, it's contents are displayed in the
column to the right, with each additional column opening another sub-layer of the directory tree.

Building a Catalog

In order to organize any larger number of objects, you should begin by devising a directory
structure that's consistent with your approach to locating Instruments, Banks and Multis. The
criteria you choose for this is entirely up to you; for instance, you could categorize your objects
by their instrument types, music genres or libraries. You could also combine these and sort your
collection by a coarse type category on the root level, then by the respective libraries on the levels
below that. Of course, it's also possible to mix categories on the same level — since no actual files
will be touched when managing your collection via the Quick-Load Browser, you can easily put the
same object into more than one directory.

"Q: In case you'd like to keep your favorite Instruments in direct access at all times, you
can put these — in parallel to your normal categorization in the Quick-Load Browser —
into a “favorites” directory. As contents are always sorted alphabetically, though, this
directory will most likely appear amidst all others. To circumvent this, just prepend its
name with a special character, such as an asterisk (*); that way, it will always appear
at the top of the list.

To create a new directory:

1. Right-click into the empty list inside the leftmost columm

2. Choose the command Add New Folder from the context menu.

3. A new directory entry will appear. Give it a meaningful name

4. Repeat these steps for every directory that you want to create on the root level.
To create subdirectories that extend the directory structure with deeper levels:

1. Select one of the new entries and create more subdirectories within the column next to it as
described. That way, you can build a hierarchical directory structure step by step. Of course,
you can also extend a Quick-Load catalog that has already been populated with content at any
time.

2. To rename a directory entry, double-click it or, alternatively, right-click and choose Rename
Folder from the context menu.

To fill your directories with content:

1. Drag one or more files from the Browser into the column of the directory in which you'd like to
put them. It doesn't matter if these originate from the Files or Libraries tabs; you can even drag
Kontakt-relevant files directly from your operating system’s file navigator into the Quick-Load
Browser.
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2. While you're dragging your objects (with mouse button held down), you can still navigate
through the Quick-Load catalog in order to locate a specific directory. Just move your mouse
pointer across the directory entries that you'd like to switch to; the columns to the right of the
current one will adapt their contents accordingly.

L
Y + Cory

In order to remove a directory, a subdirectory, or an object from a directory of the catalog:

» Right-click its entry and select the Delete from Quick Load command from the context menu.
Of course, no actual files will be deleted in this process.

Loading Objects from the Catalog

During your work with Kontakt, the Quick-Load catalog is just a mouse click away at all times,
and you can use it at any time to quickly locate and load Instruments, Banks or entire Multis.
For this, you can use the Quick-Load Browser itself or, alternatively, one of the Quick-Load menus
that replicate the structure of your catalogs as hierarchical drop-down menus. We'll describe both
methods in this section.

To open the Quick-Load Browser, right-click the empty space inside the Rack. First, use the type
switches at the top to select the kind of objects that you'd like to access. Following the instructions
in the previous section, you can now navigate the respective catalog, going from left to right, until
you've found an entry that you'd like to load. If the object is an Instrument or a Bank, you can add
it to your Multi either by double-clicking on it, by dragging it into the empty space inside the Rack,
or by right-clicking on its entry and choosing Load from the context menu. Alternatively, you can
replace an existing object in your Multi by dragging its replacement onto the respective header
in the Rack or choosing its position from the submenu Load Into Slot, which you can find in the
context menu. Loading a Multi works in the same way, but in that case, you can only choose
between replacing or combining your current Multi with the new one.

An alternate method of accessing your catalogs is offered by way of the Quick-Load menus, which
you can find in different spots of the user interface, depending on whether you'd like to add a new
object to your Multi or replace an existing one. In the former case, click the button labeled Files in
the Header and open the submenu New Instrument from List or New Instrument Bank from List.
It contains the entire structure of the respective catalog as a list of menu entries and submenus,
which you can traverse in the usual way.

Bleep.nki

Eloop.nki
1 Up.nki

Replacing an Instrument using the Quick-Load menu
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same menus appear when you click the small down arrows inside the name fields of the

Instrument, Bank, and Rack headers. In that case, the respective Instrument, Bank, or the entire
Multi will be replaced with the object that you select from the menu.

Outputs Section

Kontakt Player's Outputs section provides a routing and mixing environment in the style of a
traditional mixing console. The output signals from all Instruments in the Rack are sent to this

sect

ion, then routed to the physical outputs of an audio interface or host software. Use the

Outputs section to create, delete, rename, and configure Output Channels, which act as mono,
stereo, or multichannel signal routing destinations for your Instruments. Rename and configure

Aux

Tod

Channels, adjust the Output and Aux volumes, and monitor your output levels.

isplay the Outputs section:

p Select the Outputs option in the Workspace menu.

- The Outputs panel will appear in the lower half of the Rack space.

The

Outputs section contains the following controls:

Outputs  + ‘resets / Bateh Configuration =

st.

1 X 2 aux 3 aux 4

The Outputs section, displaying a stereo Output Channel strip and the four Aux Channel strips, left to right.

Add Channels (+ icon): Opens a dialog to create and configure new output channels. For more
information, refer to Working with Output Channels.

Delete Channel (- icon): Removes the currently selected channel from the Outputs section. To
select a channel, click its border.

Presets/Batch Configuration: Opens a dropdown menu containing options for saving,
resetting, or reconfiguring the Outputs section.

Show Inserts: Toggles the Insert slots display. If deactivated, the Insert slots are hidden and
the height of the panel is reduced in order to save screen space.

Channel Insert Slots: Contains slots for signal processing modules, which can be inserted
onto a channel to process its signal. The Insert slots are only visible if the Outputs panel is at
full size. For more information, refer to Working with Signal Processors.

Channel Strips: Displays the controls for the Output Channel strips, followed by four Aux
Channel strips. For more information, refer to Channel Strips.
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Channel Strips
Output Channels and Aux Channels contain the following identical controls:

aux 2 aux 3 aux 4

Channel Name: This name will be used throughout Kontakt Player whenever it refers to this
channel. Change the name by clicking the text field and entering a new name.

Channel Insert Slots: These slots host signal processing modules, which can be inserted onto
a channel to process its signal. The Insert slots are only visible if the Outputs panel is at full
size. For more information, refer to Working with Signal Processors.

Channel Fader and Level Meter: The vertical fader adjusts the output gain of its respective
channel. The corresponding bar meter provides visual feedback on the signal level.

Channel Configuration: This button opens a dialog window with options to configure the
channel's name, the number of audio channels it carries, and its physical output assignment.

Working with Output Channels

In Kontakt Player, the output signal of each Instrument in the Multi can be routed to any Output
Channel that is defined in the Outputs section. Each of these Output Channels can be configured
to carry between 1 and 16 audio channels. When a note is played, the respective Instrument’s
output signal arrives at the assigned Output Channel, then passes through any channel Inserts, the
volume fader, and is finally sent to the the physical output defined in the channel’'s Configuration
dialog. The bar-graph display next to the channel fader indicates the signal level at the output.

@ The Master Volume control, located in the Master Editor, will affect the levels of
all Output and Aux Channels in the Outputs section. For more information, refer to
Master Editor.

Output Configuration

The Output configuration must contain at least one channel. New Output Channels are configured
for stereo signals by default, and can be changed in the channel's configuration dialog. New
Instruments will always be assigned to the leftmost channel in the Outputs section by default.

The Channel Configuration dialog contains the following elements:
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Channel narme:

chi

The Channel Configuration dialog

+ Channel name: Displays the name of the channel. Rename a channel by clicking on the text
fleld and entering a name.

Audiochannels: Adjusts the number of audio channels this channel will carry, up to a maximum
of 16. To change the number, click the field and drag your mouse up or down, or double-click
the value field and enter a number (1-16).

Output Map: Displays all audio channels of this Output Channel along with their assigned
physical destinations, both output jacks on your audio interface or virtual connections to your
host. To change a physical output assignment, click its name and choose a new output from
the drop-down menu.

Previous/Next (arrow icons): Moves to the settings of the previous or next channel of the
Outputs section, allowing you to quickly adjust the output configuration for all channels at once.

Working with Aux Channels

The four Aux Channels in Kontakt Player offer identical controls to the Output Channels, but receive
their signal from other places. While each Instrument routes its output signal to only one Output
Channel, you can additionally send this signal to one or multiple Aux Channels, at adjustable levels.
This allows you to easily create sub-mixes.

Aside from this difference, Aux Channels work in exactly the same way as Output Channels; each
has its own channel strip in the Outputs section, can contain up to four insert signal processors,
and can be routed to specific physical outputs. In addition, the levels of all Aux Channels can be
adjusted globally with the Master Volume control located in the Master Editor.

Working with Signal Processors

Kontakt Player provides a range of signal processors that can be added as inserts and sends in
the Outputs section. Inserts are provided within the Output Channel strips, while the Aux Channels
can be used to send effects across Instruments. Each Channel has four slots, which can be loaded
with different signal processors for varying uses.

To add a signal processor to a slot:
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1. Click the menu button (arrow icon) on a slot to open the Effects menu.

Outputs

X Empty

Filters
EQs
Dynamics
Amps

Delay
Reverb

»

»

»

»
Stomps »
»

»
Modulation »
»

Utilities

Outputs |+

st. 1

Empty

Filters
EQs
Dynamics
Amps

Compressor
Feedback Compressor

Delay
Reverb

Solid Bus Comp
Supercharger GT R
Modulation Transient Master

Utilities

»
»
»
»
Stomps » Limiter
»
»
»
»

Transparent Limiter

6 Input ’ Saturate Compress Attack ’ Character
00 a8\ 1 4 - 10
HMild Fat =

Stereo Link

Q% Foran overview of the signal processors, refer to the Kontakt User Manual.

Outputs in Host Mode

When using Kontakt Player in stand-alone mode, physical outputs are also assigned within the
Channel Configuration dialog. The drop-down menu contains all outputs that are provided by the
audio interface selected in the Audio tab of the Options dialog. When using Kontakt Player as
a plug-in in audio hosts, there are more details to consider as each host handles plug-ins with
multiple outputs differently.

The maximum number of (mono) audio channels that can be assigned in host mode is limited to
64 for the VST/VST3 version of Kontakt Player, and 16 for the AU and AAX versions.


https://www.native-instruments.com/en/products/komplete/samplers/kontakt-6/downloads/
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Changes to output configuration cannot be made during operation. In consequence, when making
changes in the Outputs section, a dialog will appear asking to save and reload the song. First, go
to the Presets/Batch Configuration menu and select the appropriate option from the Save current
output section state as default for sub-menu.

@ When working with Kontakt Player as a plug-in, it is recommended to make all output
configuration changes as default for that specific plug-in type.



MIDI LEARN 136

10. MIDI Learn

Kontakt Player features a MIDI Learn function for all sliders and knobs. This allows you to assign
parameters to a MIDI device and access them via MIDI, as well as the interface.

@ New instruments created with NativeUl currently only support assigning parameters
to a MIDI device using the Learn button in the Automation tab. Refer to Assigning
MIDI Controllers via the Learn button.

Assigning MIDI controllers

To assign any of Kontakt Player's sliders or knobs to a MIDI controller:
1. Right-click the knob or slider you want to assign.

2. Select Learn MIDI CC# Automation.

3. Turn the knob or move the slider on the MIDI device.

- The control detects the movement instantly and the parameter is assigned to the MIDI
controller.

Multiple MIDI controllers (CC#s) can be added to the same Kontakt Player knob. You can also
assign multiple knobs or sliders to the same MIDI controller.

@ If you cannot assign MIDI controllers using this method, refer to the Automation Tab
for an alternative assignment method.

Removing MIDI controller assignments

To remove a MIDI controller assignment:
1. Right-click the knob or slider from which you will remove MIDI assignments.
2. Select Remove MIDI Automation: CC#.

= The MIDI controller assignment is removed.
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11. Options dialog

The Options dialog lets you configure Kontakt's global preferences, such as user interface settings,
audio and MIDI options, as well as file management. Preferences are divided into categories which
you can access using the tabs on the left side.

» To open the Options dialog, click Options... from the File menu in the Header, or press F12 on
your computer keyboard.

Options

Intarface

GEHERA
Engine EHERAE

Handling Reset window size

Loading Inbo pane language

Libraries
LIERARY BROWSER
Dizplay when launching e Fadc W instanees

Enable "Hew Instrurnents for you" panel

Interface

The Interface tab contains options that change the look and behavior of Kontakt Player's user
interface.
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Options

Interface

. GEHERAL
Engine
Handling wind

Loading Info pane language

Libraries

LIERAREY SER

Dizploy when launching new Rar el instances
Uzage Data

[ [[0]] Enable "Hew Instrurnents for you" panel

Audin

+ Reset window size: If Kontakt Player's interface becomes too large and you can no longer
access the resizing handle to the bottom right of the window, you can use this button to reset
Kontakt Player's window size.

- Info Pane Language: Select a language from the drop-down list. If you select Automatic,
Kontakt will use your operating system’s language settings, unless it is unsupported, in which
case Kontakt will use English.

- Display when launching new Rack View instances: When this setting is enabled, creating a
new Rack View instance will launch with the Library Browser as first screen.

+  Enable "New Instruments for you" panel: Hide the "New Instruments for you" panel by
unsetting this box.

Engine
The Engine tab contains options relating to the behavior of Kontakt Player's engine.
Interface

Engine

ling

{10}

ive Instrument s/ Ko

# The armount of rmazirum playable Clet stantially i thiz
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Default Volume for new instrument and volume reset: This value will be used as a default
output volume for new and imported Instruments. Also, it's the value to which the output
volume slider will snap when you [Ctrl}/[Cmd] + click it.

CPU overload protection: High voice counts can make the audio engine overload your CPU
during operation; in such cases, the engine can choke and be rendered unusable until you
restart it manually via the Restart Engine button in the Engine sub-tab of the Monitor tab in
the Side pane. This scenario can be avoided with the overload protection mechanism, which
allows Kontakt to kill voices when the CPU load gets critical. The Relaxed, Medium, and Strict
settings affect how cautious Kontakt will be about this. Relaxed will not start killing voices until
the CPU is very close to overloading, and thus will give you the highest voice count while still
providing some protection against overloading; if the CPU load is still too high, try one of the
stricter settings.

Multiprocessor support: Kontakt can make use of multiple CPUs or multi-core processors. To
switch multi-processor support on and off, and to set the number of processors/cores you
want to use for Kontakt, select the corresponding entry from the Multiprocessor support menu.

Send MIDI to outside world: This drop-down menu allows you to choose which classes of MIDI
events will be sent to Kontakt Player's MIDI output port. Click a menu entry to toggle between
on (indicated with a small diamond next to the entry) and off state. The available event classes
are:

GUI keyboard: MIDI events that are generated when you click on Kontakt Player’s virtual
on-screen keyboard.

script generated CC's: MIDI controller events that originate from running Scripts.

script generated notes: Note-on and note-off events that originate from running Scripts.
incoming CC’s: This will mirror incoming MIDI controller events at the MIDI output.
incoming notes: Mirrors incoming MIDI note events at the MIDI output.

Offline Interpolation Quality: This option allows you to specify an interpolation quality setting
for offline bouncing and freezing that's different from the one specified in the Source Modules
of your Instruments. For instance, you might want to keep your Source Modules set to standard
in order to save CPU resources during arrangement, but switch to perfect for bounces to get
the best possible quality during mixdown. The default setting is like realtime, which will use
each Source Module's HQI setting during offline operation.

Handling

The Handling tab contains options that relate to the way Kontakt Player handles external
keyboards, MIDI, and Undo commands.
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Options

Interface

Engine nputer keyboard for MO ployback .

Handling Cornputer keyboard velocity 100

Lioa -:Iing Sola rmode

etz Files/ Libraries b W files bekore Folders B

Flernory

Dekault root key for new zones C2
Developer

IOl channel assignment For loaded potches
Usoge Data

Ennable unda rmay slaw down GUl response when using very large patehes on slow machines)

(/[

Audio External waue editor:

Use computer keyboard for MIDI playback: Allows you to use your computer keyboard to
trigger MIDI notes for the currently selected Instrument. When activated, the QWERTZ/QWERTY
row of letters will play the middle octave.

Keyboard Velocity: Adjusts the velocity of notes that are triggered via your computer keyboard.

Solo Mode: Determines what Kontakt will do when you attempt to activate the Solo button on
more than one Instrument. In Place will only allow one solo Instrument at any time, so any
other one will be muted; Latch will let you switch more than one Instrument into solo mode.

Files/Libraries browser: Show files before folders: Determines the order in which files and
folders will be listed in the lower section of the Side pane.

Default root-key for new zones: Specifies the root key for new Zones, if they are created from
Samples with no embedded pitch information. The Zones will be generated with the root key
specified here.

MIDI channel assignment for loaded patches: Opens a drop-down menu that allows you to
switch between two different modes that determine the way in which Kontakt Player will assign
MIDI channels to newly added Instruments:

Assign 1st Free assigns the first available MIDI channel.

Assign to Omni is the default and will always assign loaded Instruments to Omni, thus
making them respond to all input ports.

Keep Channels from K1.x Patches is an additional toggle option that allows you to specify
whether Kontakt should use the MIDI channel embedded in Kontakt 1 patches. Later
versions do not save MIDI assignments in Instrument files, only in Multi files.

Enable undo: Enables the ability to undo actions, when the checkbox is selected. However, this
can be quite resource intensive, especially with larger instruments, so by default this setting is
unselected.

External wave editor: This feature is not available in Kontakt Player. This setting allows you to
specify your own preferred sample editor. When you click the Ext. Editor button in the Wave
Editor, Kontakt will start the specified editor with the current sample, and automatically pick up
the changes when you save the Sample within that editor.
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Loading

The Loading tab contains options related to loading samples and Kontakt files.

Options

Interface

Endins Merge new rmulti with the existing one
gine

Handling Az nfirrnation when ng or replacing rmodified instroments

Loading Files, Libraries, Ouick-Load: Double-clicking a file replaces currently selected instrument slot

CEeics Load sarnples in background

Conuert 2rd p |:|r1'|__| -_-'.|:|r|'||:||.=-- 2E* files) to WAY when sa |_|ir||;|
per
Urnwind auternation 10s for additionally looded instrurments
sage Oato

ol Hon-Player content baze path:
Audia fUsers/Docurments/Hative InstrurnentsKontakt 77

Store paths referenced in host projects relative to non-Player content base path

Merge new Multi with the existing one: Enables a new Multi to be merged with the current
Multi when loaded. If unselected, the current Multi will be discarded when a new Multi is loaded.
Kontakt will not make a check and the current Multi will be replaced instantly.

Ask for confirmation when closing or replacing modified instruments: Enables a confirmation
dialog that pops up when closing or replacing a modified instrument. This is turned off by
default.

Files, Libraries, Quick-Load: Double-clicking a file replaces currently selected instrument
slot: When enabled, loading any file or library by double clicking will replace the currently loaded
file or instrument in the selected instrument slot. When disabled, files or instruments loaded
this way will automatically create a new instrument slot.

Load samples in background: Enables Kontakt to load instruments created in Kontakt 4.1
or later in the background. This feature is useful for instruments that use a large amount of
samples and take a long time to load. With background loading active, Kontakt will display the
instrument'’s interface and become playable as soon as possible. Certain keys may not sound
immediately if the samples have yet to be loaded into memory.

Convert 3rd party samples to WAV when saving: Enables Kontakt to save REX Samples used
by third-party Instruments in WAV format. When unselected they will be saved in their native
format.

Unwind automation IDs for additionally loaded patches: Enables Kontakt to re-assign
automation IDs of newly loaded Instruments if there is already an Instrument in your Multi
that uses the same IDs. As an example, if would like to add an Instrument twice to your Multi,
which uses automation IDs 0 through 9; if this option is activated, Kontakt will change the
assigned IDs of the second Instrument to 10-19 on load, provided that these IDs have not been
used by other Instruments in your Multi yet.

Non-Player content base path: Allows you to specify a base path for your Non-Player content.
The option to store referenced paths relative to the base path is provided in the checkbox
below. An option to use the path on Save is available and deactivated by default.
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Store paths referenced in host projects relative to Non-Player content base path: Determines
if referenced paths are stored relative to the base path, or as subpaths. When selected, this
option minimizes the occurrence of missing content when using Kontakt as a plug-in in a host
DAW. When a host project is saved, Non-Player content will be able to resolve without the
Missing Content dialog, if the libraries are located on the computer's path as defined in the base
path field.

Libraries

The Libraries dialog allows you to define which of your libraries appear in the Libraries tab of the
Side pane. For more information, refer to Side Pane (Classic view).

Libraries

d libraries are visible in the Libraries brows

]

ate a purchazed library

Hide Library: Uncheck the entry in the list to hide a library from the Libraries tab of the Side
pane without uninstalling it from your computer,

Show Library: Check an entry in the list to show a library in the Libraries tab of the Side pane.

':Q:' You can also open NATIVE ACCESS from the Libraries tab by clicking on the Launch
Native Access button. For more information, visit Native Access.

Memory

On the Memory tab, you can optimize Kontakt Player's memory usage settings for your specific
computer configuration.

Interface
Engine

Handling

Audio

HIDI

Inztrument preload buffer size:



https://www.native-instruments.com/en/specials/native-access/
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Override Instrument’s preload size: If activated, Kontakt will ignore the preload buffer size
that's embedded in Instrument files since Kontakt 2, and use the specified buffer size instead.
We recommend leaving the preload buffer size on default value. Memory improvements might
be possible by moving the slider to the lowest setting possible without experiencing playback
errors.

Kontakt Memory Server options (macOS only)

@ Using KMS is only recommended when working with very large numbers of samples
which require more physical memory than one Kontakt instance can access. Do not
enable Kontakt Memory Server if it is not absolutely necessary.

In order to use KMS on your computer, Mac OS X needs to be installed, and at least 4 GB of
physical RAM must be available. Using KMS also requires administrator privileges, so make sure
you are logged in as an administrator. Kontakt will detect the Mac OS X version and the amount
of RAM present on your computer automatically. Subsequently, it will display an option to enable
advanced memory access.

Uze rernory seruer

Audio
HIDI

Inztrument preload buffer size:

Ouerride instrurnent’s preload size EQ.00 KE

The Memory tab on OS X

After activating KMS you need to restart Kontakt for the changes to take effect.

Kontakt will automatically set the size of accessible RAM to a value suitable for most cases. You
can find the amount of determined accessible RAM in the KMS Options dialog.

Kontakt Memory Server is a separate application running in background. Kontakt no longer loads
samples itself as long as the KMS option is activated. All running Kontakt instances share the
Kontakt Memory Server and can access the samples loaded. The Kontakt Memory Server will boot
automatically as soon as you start a Kontakt instance.

The KMS utility appears in the Mac OS X system bar, so you can monitor the amount of RAM used
by the server process. CPU and RAM requirements of KMS utility itself are negligible. Note that
there is no option to shut down the KMS utility in Manual mode.
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Memory Server modes

Engine
Uz rnernory seruer

Handling

Auta

Manual

HMIDI E - d i ufility in the m neny bar.

The Memory tab with Memory Server mode options

+ Automatic: In Automatic mode the KMS will keep all samples currently used by Kontakt
instances stored. If an Instrument is removed from Kontakt's rack, samples that are no
longer needed will be also removed from the Memory Server's sample pool. The KMS will
automatically shut down when all Kontakt instances are closed.

+  Manual: In Manual mode the Kontakt Memory Server does not remove samples from the
server when an instrument is removed from Kontakt's rack or when all Kontakt instances are
closed. All samples stay in the memory as long as it is running. This can be helpful, e.g.
when re-opening a project in your host sequencer which is using Kontakt as plug-in and when
working with extensive templates of numerous instruments. Loading times are significantly
shorter, since the samples are already stored in RAM and do not need to be loaded again.

Managing the Kontakt Memory Server

The Kontakt Memory Server is managed via the KMS utility, which allows you to manually purge
unused samples if you want to free memory. If you are running out of memory when loading
additional Instruments, the server will automatically start to purge samples that are not referenced
by any loaded Instrument.

= 81%[%> T

-

=1 0.00M
Purge Unused Memory

About...
Quit

The KMS Utility in the Mac OS X system menu bar

Developer

The Developer Tab includes a toggle for enabling development features. This allows you to use the
Kontakt Lua API to modify files on your system via Lua scripts. For more information refer to the
Lua API reference manual.


https://www.native-instruments.com/apireference/
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Options

Interface

) DEYELOFER FEATURES
Engine

Ey enabling deu r features, KOMTAKT will be able to rmodify and te files on you
Handling
Loading Enable developer features

Librarie=

Mernory

Uzage Data
([}

Audia

Usage data

Kontakt Player collects data regarding your usage of the software in order to better inform future
updates. Sending this data to Native Instruments will help make future versions of Kontakt better,
but the choice of whether or not you want to share this information with Native Instruments is
yours.

Interface
Engine

Handling

Mo, I don't want to contribute

]

- Yes, enable usage data tracking: Selects the option to track and send usage data.
- No, | don't want to contribute: Selects the option to turn off data tracking.

@ Refer to our Privacy Policy for more information on Usage Data Tracking.

Audio

The contents of the Audio Tab are documented here: Audio configuration.


https://www.native-instruments.com/en/company/legal-information/privacy-policy/
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MIDI

The contents of the MIDI tab are documented here: MIDI configuration



12. File formats

The following file formats are supported by Kontakt Player:

Kontakt file formats

NKI
NKM
NKB
NKP
NKR
NCW
NKX
NKC

NKS
N

NKL

Kontakt Instrument

Kontakt Multi

Kontakt Instrument Bank

Kontakt Preset

Kontakt Resource File

Kontakt Lossless Compression Audio File
Kontakt Monolith

Kontakt Cache File

Kontakt Snapshot File

Kontakt Leap Kit

Audio file formats

Software format File extension
ACID

Acidized Wave .wav
AIFF

mono / stereo .aiff / .aif
multichannel .aiff / .aif
APPLE LOOPS

Apple Loop aiff / .aif
Battery

Battery 1 kit
Battery 2 kt2
Battery 3 Kits kt3
Battery 3 Cells .cl3
Kontakt

lossless compressed .ncw
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Software format
RECYCLE

REX1

REX 2

WAV
mono / stereo

multichannel

File extension

.rex

x2

wav

wav
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13. Keyboard shortcuts

On OS X computers, use the [Cmd] (Command) key instead of the [Ctrl] (Control) key.

Global
Shortcut Function
[Ctrl] + [O] Open Instrument
[Ctrl] + [9] Save
[Shift] + [Ctrl] + [S] Save As
[Ctrl] + [C] Copy
[Ctrl] + [V] Paste
[Ctrl] + [X] Cut
[Ctrl] + [A] Select All
[Alt] + [F4] (Windows) / Quit
[Cmd] + [Q] (Mac)
Delete / Backspace Delete
{E%\A(\;\Q;dows) /[Ctrl] + Info Pane
[F10] Minimze view
[F12] Options

Side pane (Classic view)

Shortcut Function

Alphanumeric Keys Jump to file by name
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